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A Proposed Solution for Word-Recognition Deficit in the Computer Environment 

by 
Hyacinth Williams 

December 1997 

Most college students with reading disabilities have difficulty with word recognition. 
The purpose of this study was to use an investigator-made cue word list to increase low 
word recognition skills among college students while creating slides for a university 
curriculum using a simple presentation tool. The investigator randomly divided fourteen 
subjects into two groups. One group received the treatment and the other did not. 
SUbjects received fifty minutes to complete a five-slide presentation. The investigator 
used four different data collection processes for data collection. Beyond this, the 
investigator presented the results using rank correlation. 

Results from this study indicated that the subjects benefited from the proposed solution. 
Subjects in the testing group performed better on word recognition tasks, completed tasks 
within allotted time and with more accuracy than those in the control group. 

This study may provide useful information to students suffering word recognition 
problems and aid educators, courseware developers, and software engineers who assist 
them. It contributes statistical findings in the area of computer education. The results 
may give education and technical professionals information for addressing word 
recognition problems of students with reading difficulties. 
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Chapter I 

Introduction 

Statement of the Problem 

Most college students with reading disabilities have difficulty with word recognition. 

Bjaalid, Hoien and Lundberg (1995) identified word recognition deficit as the area of 

difficulty for those students. This observation has been proved true by many researchers 

who have come up with the same conclusion. Crawford and Snart (1994) stated that 

these students display significant underachievement in word recognition. Willows (1995) 

pointed out that as they go through their academic careers, word recognition continues as 

a source of difficulty. McCormick and Becker (1996) indicated that one set of 

predominant problems students encounter entails factors related to word recognition. 

Researchers' accumulated evidence demonstrates that word recognition plays a primary 

role as the locus of difficulty for students with reading deficits (Bjaalid, Hoien, & 

Lundberg, 1995). Therefore concluding, a major difficulty of students with reading 

deficits involves recognition of words (Bruck, 1993). 



Background of the Study 

Word recognition is necessary for reading comprehension (Lin, Podell and Rein, 1991). 

With accurate word recognition, students can concentrate on comprehension (Stanovich, 

1991b). "Poor word recognition diverts resources from the processes that are necessary 

for comprehension." (Bruck, 1993, p. 259). According to Fielding and Pearson (1994), 

reading comprehension depends heavily on recognizing words. Therefore, good word 

recognition skill accounts for a large part of reading ability (Stanovich, 1991b). 
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Individuals with reading difficulties display word recognition problems (Bateman, 1991). 

According to Stanovich (1991b), researchers linked word recognition skills to reading 

ability. He stated that the researchers debated on what mechanisms are responsible for 

word recognition skill of good readers. The debate evolved into the top-down versus 

bottom-up debate in reading theory. Stanovich (199Ia) indicated that evidence pointed to 

skill at bottom-up processes of spelling-to-sound decoding and direct visual recognition 

as a possible effective mechanism. The reader needs to recognize letters; associate the 

sounds of the letters with the visual appearance of the letters; isolate sounds and blend 

them into words; read irregular words; and focus on accurate pronunciation of printed 

words (French, Ellsworth, & Amoruso, 1995). According to French, Ellsworth, & 

Amoruso (1995) word recognition skills associated with the bottom-up theory develops 

into automatic word recognition. This mechanism supports the notion that when word 

recognition becomes automatic, the reader can concentrate on reading comprehension. 



Goal Statement 

This study explores whether a simple-sample comparison procedure on word recognition 

can promote word recognition skills in college students with reading disabilities; such as, 

low word recognition skills. A correlation factor was used to test the efficacy of the test 

method. (Canavos & Miller, 1995). 

Purpose of the Study 

The purpose of this study is to investigate a simple-sample comparison procedure using 

college students with reading disabilities. The researcher conducted the present study 

with computers to determine if the proposed solution allows subjects to overcome their 

deficiency in word recognition in a computer environment. In overcoming their word 

recognition deficits, subjects can focus on comprehension. 

Relevance and Significance of the Study 

Researchers proposed different methods to improve word recognition skills (Rinsky, 

1997). The researchers often used those methods in non-computer environments. One 

of those methods relates to comparison procedures. This method becomes relevant to the 

present study. 
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Kennedy, Itkonen, and Lindquist (1994) used the comparison method to help their 

subjects' with sight words. They reported some positive changes in their subjects' 

performance. The researcher of the present study used a version of Kennedy et al. study 

for recognizing words. The following points out differences between the studies: 

The present study consists of control and testing groups. The previous study did not have 

control and testing groups. 
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The present study focuses on word recognition. The previous study did not focus on word 

recognition. 

Subjects in the present study receive no observer assistance during testing. Subjects in the 

previous study received observer assistance during testing. 

Subjects in the present study receive no teaching instruction of words before testing. 

Subjects in the previous study received teaching instruction of words before testing. 

Subjects in the present study had psychological documentation indicating word 

recognition deficit. Subjects in the previous study had psychological documentation 

indicating moderate learning disabilities. 

The investigator of the present study used a larger sample size than the previous study. 

The investigator used single words as stimulus rather than multiple words. 

The investigator used a computer environment rather than a non-computer environment. 

Roger and Peutrill (1994) carried out another study that used the comparison method. 

They developed their study to teach subjects with reading difficulties recognition of 

crucial words. Roger and Pertrill also reported positive results. This study becomes 



relevant to the current study in the method employed. The differences between this 

study and the present study are as follows: 

The investigator of the present study used text and not pictures. 

The investigator of the present study relied on audio responses and not visual. 

The investigator tested subjects once and did not re-test. 

The investigator did not reverse the control and testing groups. 

The investigator did not use the combination of visual and audio cues. 

The use of the comparison method indicates that this method does bring about some 

positive outcomes. However, it remains unknown if the comparison method used in 

computer environment results in greater positive results. 
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The significance of the present study is that it will lead to further developments 

accommodating students with learning disabilities, which are evident with deficit 

computer skills. It provides educators with information to better serve college students 

with word recognition deficit skills. The outcome of this study gives the educators 

accurate data that will help this population achieve greater success with word recognition. 

Beyond that, it will allow software and courseware developers to examine a simple 

comparison procedure in a technological setting and find ways to use such a procedure. 

The result of this study gives the students a solution to their word recognition problems in 

the computer environment. Further research into this study will enable them to achieve 



accurate word recognition skills. The solution helps students with learning disabilities 

find their own stimulus words for computer practice. Moreover, it will lead to the 

identification of specific words that confuse subjects. 

To perform measurements, the researcher of the present study constructed several 

questions. The researcher set out to find answers to subjective and objective questions. 

The following are the questions: 

Subjective question: 

1) Did the proposed solution increase subjects' low word recognition skills? 

Objective Questions 

1) Did the subjects in the testing group complete the tasks with more accuracy than those 

in the control group? (The definition of accuracy appears in Chapter III section 4b) 

2) How many correct words does each subject recognize? 

3) How long does it take to complete the test session? 

Barriers and Issues 

Individuals with learning disabilities have one or more learning barriers. Pierce (1995) 

refers to the barriers as a category of multiple disabilities. Reading disability appears as 

one of those disabilities. 
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According to Crawford and Snart (1994), individuals with reading difficulty experience 

little success with word recognition. Those individuals display these problems: 

They have poor knowledge of spelling sounds (Bruck, 1993). 

They have poor recognition of single words (Bruck, 1993). 

They have decoding difficulties (Kim & Goetz, 1994). 

They are unable to analyze words into consonant and vowel segments (Shankweiler, 

1995). 

They have slow speed of accurate identification of names of printed words (Bowers, 

1991). 

They have inadequate syntax of the language, letter identification, and use of letters 

(Rosner, 1995). 

Researchers proposed many solutions for word recognition. Some of these solutions 

include word patterns, practice exercises, whole-word modeling, phonetic prompting, 

dual-route, paired-association, and comparison methods. The investigator of the present 

study used a simple comparison method with single word cues to assist students in 

computer tasks. 

Clinicians usually diagnose word recognition deficit during childhood and the condition 

persists into adulthood (Bruck, 1993). Word recognition problems have not been 
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in many adults. Therefore, the present study focuses on college students with a possible 

solution offered. 

The goal of this study is to present a simple procedure to help college students with word 

recognition deficit recognize words. The investigator used the simple procedure in a 

computer environment. 

Word recognition uses audio and visual processes (Barker, Torgesen, & Wagner, 1992). 

This issue suggests that both processes assist readers with comprehension. The 

investigator of the present study focused on visual word recognition in a computer 

environment. 

Rose, Meyer and Pisha (1994) identified computer technology as an issue for adult 

learners. They proposed a need for new approaches to learning using technologies that 

are flexible and diverse. According to French et al. (1995), education professionals need 

to explore means of providing effective practice and reinforcement through computers. 

Resources -Computer Applications for Adults with Learning Problems 
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Spear-Swerling and Sternberg (1996) indicated that computer programs can be effective in 

improving word recognition skills. However, Farmer, Klein, and Bryson (1992) state that 

computer programs must provide specific feedback in order to be effective. The barrier in 

computer applications for adults with learning problems appears to be the type of 

feedback. 



Support - Academic Services 

Keirn, McWhirter and Bernstein (1996) examined the relationship between academic 

achievement and the use of various academic support services of students with learning 

disabilities. They found that students who used the computer laboratory had higher 

academic performances than those who did not use the laboratory. This result indicated 

that the issue of support services may produce positive outcomes for students with 

learning difficulties. 

Hypotheses: 

H1 : Subjects in the testing group will score higher on word recognition skills. 

H2 : Subjects in the testing group will complete tasks in less than fifty minutes. 

H3: Subjects in the testing group will complete tasks accurately as defined in chapter 

three (section 4a). 

Limitations 

Identifying reading deficits as a single cause shows an inadequate way of identify the 

problems (Spear-Swerling & Sternberg, 1996). The commonly cited causes include 

inadequate pre-reading experience, inadequate schooling, neurological problems, deficits 

in cognitive abilities, and limited exposure to reading activities (Vellutino, Scanlon, 

Sipay, Small, Pratt, Chen, & Denckla, 1996). According to Vellutino et aI., researchers 
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suggested the possibility that reading deficits may relate to inadequate ability. They 

pointed out that this came from genetic studies. In their review, Vellutino et aI., said that 

researchers of genetic studies documented that reading deficits occur more in near 

relatives and more in twins. They indicated that the researchers of genetics and twin 

studies showed that measures of reading ability exhibit high degrees of heritability. Such 

findings appear to link inadequate ability to reading deficits. Reading deficits develop 

and operate with intrinsic and extrinsic variables. According to Pierce (1995), such 

deficits relate to more than one e1ement-- environmental and non-environmental. Beyond 

this, Hoffman (1995) said that reading deficits exist with academic and non-academic 

problems. Moreover, Francis, Shaywitz, Stuebing, Shaywitz, and Fletcher (1996) said 

that reading deficit may relate to the absence of skills that never developed sufficiently. 

This indicates that reading deficiency incorporates several variables beyond the control of 

the reader. 

Perceptual 

Barsalou (1992) said that different types of perceptual information produces different 

responses. Rosner (1995) indicated that visual perception contributes to word 

recognition. Borsting (1995) pointed out that visual perception extracts and organizes 

visual information from the environment and integrates it with information from other 

sensory modalities. He also stated that the relationship between vision perception and 

reading has been controversial. However, visual perception plays a role in reading 

performance. 
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Borsting (1995) emphasized that the relationship between visual perception and reading 

is very complex. He said that the relationship does not provide causal mechanisms for 

determining how perceptual deficit interferes with the reading process. Because of the 

complex nature of both vision perception and reading, the cause-effect relationship 

becomes difficult. Beyond this, it also becomes difficult in a study to isolate an 

individual factor while keeping other factors equal within groups. Hence, this contributes 

to one of the limitations of this study. 

Memory 

Deficits in memory result in difficulties in recalling visual and auditory presented 

materials (McLoughlin, Fitzgibbon, & Young, 1994). Memory exists as one factor 

associated with reading deficits (Webster, 1992). Individuals with memory difficulties 

show word recognition problems (Willows, 1995). Swanson, Ashbaker, and Lee (1996) 

indicated that those individuals have constraints in their storage capacity. According to 

Webster, Hall, Brown, and Bolen (1996), such individuals have trouble in transferring 

information into memory. They also said that those individuals show some difficulties 

with memory strategies. Since memory and word recognition problems relate to each 

other, memory deficiency becomes a hindrance to acquiring good word recognition skills. 

Phonological Process 

Brady (1991) stated that individuals with word recognition problems show deficiency in 

the phonological process. Phonological processing skills involve the manipulation and 
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recognition of single speech sounds in language (McBride-Chang, 1995). According to 

Willows (1995), individuals with phonological processing problems experience difficulty 

differentiating the sound units in the spoken language. Willows also said, that such 

difficulty may come from either receptive or expressive weakness, or both. Beyond this, 

Willow pointed out that phonological processing deficits have direct academic 

consequences. One of those consequence relates to poor word recognition. Several 

researchers established the association between phonological processing skills and word 

recognition (Brady & Shankweiler, 1991; Sawyer & Fox, 1991; Gough, Ehri & Treiman, 

1992). This association shows that phonological processing as a limitation of the present 

study. 

Delimitations 

Word recognition deficit leads to comprehension problems (Spear-Sweling & Sternberg, 

1996). This deficit clearly represents the fundamental problem underlying difficulties in 

comprehension (Willows, 1995). Hence, students must recognize words before they can 

comprehend text. 

According to Rosner (1995), comprehension depends on the syntax of the language; 

identifying the letters and the conventions that govern their use in reading, word 

recognition, and knowledge ofthe subject matter. Rosner also states, students must know 

the language of the text to learn to read. However, the syntax of the language by itself 
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appears inadequate for transfonning printed words into their oral fonn. Students also 

need to know how to discriminate the similarities and differences between certain 

manuscript letters. These basic skills still appear insufficient for competent reading 

comprehension. Students also must know how to recognize words and know the subject 

matter ofthe text. For these reasons, word recognition becomes a delimitation for 

subj ects in the current study. 

Definition of Terms 

Agnosia - The inability to understand or recognize certain sensory stimuli (Spafford & 

Grosser, 1996). 

Alexia - Reading defect caused by actual brain injury (Kavale & Forness, 1995) 

Auditory processing - The inability to attend to discriminate, remember, recognize, or 

comprehend infonnation presented by sounds even though the person has nonnal 

intelligence and hearing sensitivity (Roeser & Downs, 1995). 

Bottom-up theory - Readers read the letters and words on the page, moving across the 

lines and down the page, processing these letters and words sequentially, and then 

figuring out the meaning the author intended (French et aI., 1995). 



Congenital word blindness - Stemming from defective brain development in the left 

angular gyrus (Kavale and Forness, 1995). 

Direct instruction - The process ofteaching problem solving strategies when possible to 

small groups, using systematic correction procedures, reviewing cumulative material 

previously learned, and insistence on mastery (Schloss, Alper, Young, Arnold-Reid, 

Aylward, and Dudenhoeffer, 1995). 

Dyslexia - A medical term that suggests a specific syndrome of behaviors and generally 

has no acceptable symptomatology association other than reading difficulties (Hoffinan, 

1996). 

Landmark Knowledge - Visual marks in the environment such as buildings, statues, etc. 

(Knight, Dillon & Richardson, 1996). 

Metacognition - A process that is based upon self-knowledge, task knowledge and self­

monitoring (Manzo & Manzo, 1993). 

Onsets - The consonants that come at the beginning of syllables (Treiman, 1992). 

Paired association - The process of associating an arbitrary response with an arbitrary 

stimulus (Gough & Juel, 1991). 
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Perceptual deficit - Refers to the meaning attached to the information received through 

the senses (Dechant, 1991). Refers to an individual's deficits in interpreting or making 

sense out of visual information despite intact visual system (Wong, 1996). 

Phonological awareness - Refers to structure of words in one's language (Torgesen, 

Wagner & Rashotte, 1994) 

Phonological processing deficit - Refers to the use of information about the sound 

structure oflanguage in processing written input (Dockrell & McShane, 1993). 

Rimes - The vowel and consonants at the end of syllables (Treiman, 1992). 

Route knowledge - The ability to navigate from one point to another with landmark 

knowledge (McKnight, Dillon & Richardson, 1991). 

Sight words - Words a reader can recognize instantly in print (Gillet & Temple, 1994). 

Strephosymbolia - Twisted symbols (Wong, 1996). 

15 

Survey knowledge - A fully developed cognitive map (McKnight, Dillion & Richardson, 

1991). 



16 

Top-down theory - The process where reading begins by emphasizing the prior 

knowledge and experience the reader bring to the text that relates to the author's message. 

(French et aI., 1995). 

Word Recognition - A process that uses information from comprehension of the text and 

information from the printed visual symbols (Barker, Torgesen & Wagner, 1992). 

Summary 

This chapter describes the purpose of the study by pointing out statements on reading, 

comprehension, and word recognition. The statement of the problem, major research 

questions, and definitions of terms were presented in this chapter. The literature and 

research will provide information on related issues. 
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Chapter II 

Review of Literature 

Introduction 

This chapter presents and reviews literature that provides factors relevant to this study. 

This first section examines the history, causes and problems associated with learning 

disabilities. The next three sections offer theories and research that investigate word 

recognition problems, the reading process and profile, and problems encountered by adult 

learners. Section five offers, for consideration, research of the influence of computers on 

reading problems. Finally, section six gives a review of the statistical procedure used in 

this study. 

The Nature of Learning Disabilities 

Learning problems existed for centuries before education officials identified the problems 

as disabilities (Wong, 1996; Dunn, 1995; Torgesen, 1991). Hayes (1994) and Hoover 

(1992) said that individuals with learning disabilities have some trouble with the reading 

process. The causes for the disabilities varies (Lerner, 1993). 
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History of Learning Disabilities 

Cruickshank, Lewandowski, Opp, and Rosenberger (1993) dated learning problems back 

to Galen (130 to 201 C. E.). During this time, learning disabilities were not an 

"acceptable" excuse for what observers thought to be "laziness". This refusal to 

recognize such a prevalent problem delayed the mainstreaming of the idea of learning 

disabilities until 1962 (pinlan, 1994). After 1962, the condition of specific deficits 

displayed by individuals, while maintaining general functions, brought about learning 

problem reports (Lyon, 1996). Doctors, neurologists, and psychologists were often the 

authors of those reports. According to Kavale and Forness (1995), these professionals 

used various terms to identify the same condition. 

In the late 1800s, a German physician, Dr. Kussmaul described a specific learning 

disability he observed in one of his adult patients as reading blindness. According to 

Selikowitz (1993), Dr. Berlin, another German physician, called the same condition 

dyslexia. Thus, this proved Kavale and Forness's theory that professionals identify the 

same condition with different terms. This theory, although proven true, was soon 

rendered obsolete after professionals began categorizing learning problems. 

Kavale and Forness (1995) stated that Morgan, in the late 1800's, provided the first in­

depth description of specific reading disability. He called this condition congenital 

word blindness. In 1917, Hinshelwood reported a reading problem case in a child 

followed by other related cases reported by Orton, Strauss and Weiner, and Cruickshank 

(Wong, 1996). Orton, in 1937, reported about children who had difficulties in learning to 
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read and he introduced the tenn Strephosymbolia (Wong, 1996). Strauss and Weiner, in 

the 1930s and 19940s, investigated children with mental retardation (Lerner, 1993) and 

noted differences within the population. Their work led to the identification of sub-

groups of children with learning problems (Torgesen, 1991). Cruickshank, in 1961, 

reported on children with cerebral palsy of nonnal intelligence and through his work 

established the International Academy of Research in Learning Disabilities (Hallahan & 

Kauffinan, 1994). 

Physicians during the early twentieth century noted specific weaknesses in children who 

showed intellectual functioning (Torgesen, 1991). In the 1960s, middle-class parents of 

those children applied political pressure and the tenn "learning disabilities" became an 

acceptable tenn with government recognition (Wong, 1996; Finlan, 1994). Samuel Kirk 

the director of the Division of Exceptional Children and Youth in the U. S Office of 

Education during the early 1960s popularized the tenn to categorize diverse types of 

learning disorders (French, Ellsworth, and Amoruso, 1995). He helped organize and 

support the parents who convinced congress to pass the Children with Learning 

Disabilities Act of 1969. Lyon (1996) and the Council for Learning Disabilities, 

Research Committee (1993) cited the act as follows: 

"Special learning disability" means a disorder in one or more basic psychological 

processes involved in understanding or in using language, spoken or written, that may 

manifest itself in an imperfect ability to listen, speak, read, write, spell, or to do 

mathematical calculations. The tenn includes conditions such as perceptual disabilities, 



20 
brain injury, minimal brain dysfunction, dyslexia, and developmental aphasia. The term 

does not apply to children who have learning problems that are primarily the result of 

visual, hearing, or motor disabilities, of mental retardation, of emotional disturbance, or 

of environmental, cultural, or economic disadvantage. (p. 56). 

This definition still provides a direction for public school officials to follow (Hammill, 

1993). According to Yocom and ColI (1995), this act, Public Law 94-142 became fully 

effective by the early 1980's. Still, the cause oflearning disabilities had not been found. 

Causes of Learning Disabilities 

Researchers reported different findings on factors that may result in learning deficits 

(French et aI., 1995). Two classes were later formed. They classified the causes by 

intrinsic and extrinsic factors. 

Intrinsic Factors 

For years, some theorists associated learning disabilities with internal factors. They said 

that students with learning disabilities displayed evidence of defective central nervous 

systems (Mercer, 1992). Lerner (1993) indicated that dysfunction in the central nervous 

system impairs learning. Theorists assumed that the source of learning deficits lied 

within the individual (McKinney, Osborne, & Schulte, 1993). This type of assumption 

comes from studies centered on inherent elements. However, this theory by itself proved 

insufficient. 
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Extrinsic Factors 

Other theorists believed that the causes relate mostly to external factors. They agreed 

with intrinsic findings, however, they added that environmental factors influenced 

academic achievement (Levine, 1997; Lyon, 1991). The environmental factors include a 

student's total environment. Total environment consists of the locale of the country in 

which a student lives, proximity to majorities, family relations, number of immediate 

family members etc. Environmental factors are closely related and sometimes overlap 

each other. Both extrinsic factors contribute to reading problems. 

Reading Problems 

Most of the students identified with learning disabilities show deficiency in reading 

(French, et aI., 1995; Reetz & Hoover, 1992). The reading process involves word 

decoding, sight word vocabulary, and comprehension (Gillet & Temple, 1994). Students 

with reading disabilities may experience problems in one or all of these areas. The 

following is a closer look at these problematic signs of reading deficiency. 

Word Decoding Problems 

Word decoding problems include perceptual, phonological processing, and memory 

deficits. Many professionals speculated as to the cause for perceptual deficits. 

Hinshelwood and Orton referred to perceptual deficits (Dockrell & McShane, 1993). 
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Weiner, Strauss and Cruickshank also made speculation about perceptual deficit (Wong, 

1996). Hinshelwood believed that this deficit occurred as a result of defects in the area of 

the brain responsible for the visual memory of words (Wong, 1996). Orton believed that 

perceptual deficit comes from confusion with letters and reversal of parts or whole words 

(Kavale & Forness, 1995). While Weiner and Stauss dealt with the visual perceptual 

problems of children with mental deficiency, Cruickshank started training programs 

directed towards the perceptual process. According to Wong (1996), "These training 

programs, however, did not advance reading acquisition in children with learning 

disabilities" (p.14). Dockrell and McShane stated that these views including current 

views showed a common misconception about children with reading difficulties. They 

examined research done on perceptual deficit and concluded that the investigators failed 

to find empirical support for their hypotheses. Dockrell and McShane further added that 

the researchers using alphabetic, linguistic stimuli, or perceptual stimuli tests neglected to 

support deficits in perceptual processing as the cause of reading difficulties. The next 

reading-decoding problem pertains to phonology. 

Deficits in phonological processing relate to reading difficulties (Wong, 1996; Muter, 

1994; Gary, 1994; Mann, 1991; Liberman & Shankweiler, 1991). Researchers pointed 

out three kinds of phonological processing skills that relate to early reading. 

Phonological awareness, phonological memory, and the rate of access for phonological 

information all play large roles in phonological processing (Blanchman, Ball, Black, & 

Tangel, 1994). First, phonological awareness helps predict reading success (Muter, 



1994). Second, phonological memory deals with short-term memory (Thogmartin, 

1997; Vihman, 1996; Aaron & Baker, 1991). Finally, rate of access for phonological 

information involves rapid naming of letters in isolation or series (Wong, 1996). 

Researchers more clearly identified the role of phonological awareness in reading 

disability than the other phonological processing skills (Torgesen, Wagner,& Rashotte, 

1994). However, researchers failed to establish the causal relationship between reading 

and memory (Wong, 1996; Dockrell & McShane, 1993). 
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Swanson and Berninger (1995) conducted a study on the role of working memory in 

skilled and less skilled readers. They investigated whether limitations in a less skilled 

reader's comprehension relate to specific or general working memory deficiencies. 

Beyond this, they also investigated whether working memory and short-term memory 

independently contribute to the reading comprehension deficits in less skilled readers. 

These researchers conducted two experiments. In experiment one, less skilled readers 

with learning disabilities and readers with level-matched reading comprehension (the 

reader's comprehension skill was assessed and he/she was placed in a level which 

corresponded with that assessment) received testing on verbal and visual-spatial working 

memory. Swanson and Berninger found the working memory ofless skilled readers with 

learning disabilities were compatible on visual-spatial working measures. In experiment 

two, the investigators placed students into four subgroups: They classified the subgroups 

as high and low reading comprehension and high and low reading recognition on working' 

memory and phonological short-term memory tasks. The results indicated that the low 
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word recognition and comprehension students had working memory and short-term 

memory deficits. However, the low comprehension readers showed average phonological 

short-term memory performance. In this report, the researchers did not find an indicator 

for memory problems. 

Bowers and Swanson's (1991) study also failed to pinpoint the cause of memory 

problems. They investigated whether students with reading disabilities have a speed 

deficit restricted to the identification of printed words, or if they have a general speed 

deficit in retrieving names of single digits. The investigators assessed students on speed 

of digit and letter naming using continuous list and computer presentation discrete-trail 

methods. Continuous list referred to digits or letters on a single sheet under various 

conditions and the repetition of digits or letters as quickly as possible. Discrete-trail 

method referred to digits and letters under various conditions using separate blocks. The 

researchers only reported that word identification shared variance with latency for digit 

naming. Another set of researchers tried to find some answers by approaching memory 

problems from a different standpoint. 

Swanson, Ashbaker, and Lee (1996) researched the working memory of students with 

reading problems. They conducted a study to determine if storage capacity or processing 

efficiency accurately characterizes deficits in the subjects. Swanson, et aL indicated that 

the subjects' constraints lied in their storage capacity. They made no indication of a 

causal relationship. 
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Webster, Hall, Brown, and Bolen (1996) examined the information processing and 

memory functioning of students diagnosed with and without learning disabilities. The 

researchers used the Learning Efficiency Test-II to examined visual versus auditory 

presentation, immediate, short-term, and long-term memory, and ordered versus 

unordered recall. They reported that the students with learning disabilities demonstrated 

difficulty with ordered versus unordered recall and had problems transferring information 

into short-term and long-term memory. Again, the researchers did not show causation. 

Despite the lack of research showing causal relation between reading and memory, the 

information from the researchers contributes to the large problem of understanding 

reading issues. 

Sight Word Vocabulary 

Sight word vocabulary problems appear when students experience difficulty recognizing 

words (Gillet & Temple, 1994). Investigators suggested some procedures for helping 

students with reading disability with sight word vocabulary problems (Seymour, 1994). 

Schloss, Alper, Young, Arnold-Reid, Aylward, and Dudenhoeffer (1995) conducted a 

study on sight words and found that direct instructional procedures, on the acquisition of 

functional sight words, increased subjects' sight word vocabulary. Carlisle (1993) 

reviewed approaches to teaching sight word vocabulary and proposed guidelines for 

effective instruction. She stated that students with reading disabilities need instructional 

procedures for identifying words to increase their word recognition skills. Rinsky (1997), 

Nicholson (1994), and Alexander and Pate (1991) suggested a meaning-emphasis 
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approach after reviewing current research. Powell and Hornsby (1993) recommended a 

systematic connection between spelling and pronunciation. In accordance with this, 

Naslund and Samuels (1992) suggested a combination of phonological, lexical, and 

syntactical approaches. Consequently other researchers like, Gillet and Temple (1994) 

agreed and added that recognizing words by sight makes it easier to read than by 

connecting letters. In spite of all these suggestions and findings, sight word vocabulary 

exists as a problem for students with low word recognition skills (Seymour, 1994). This 

brings us to another related problem-comprehension problems. 

Comprehension Problems 

Students with reading disabilities display comprehension problems (Doyle, 1996; 

Williams, 1993). Gilroy (1996) pointed out that comprehension does not make an 

independent contribution to reading achievement. Reading comprehension involves 

written information from the writer and information from the reader (Linksman, 1995; 

Dechant, 1991). Comprehension problems exit when the reader experiences difficulty 

with those processes (Hancock, 1995). Gamer, Alexander, and Hare (1991) indicated 

that comprehension problems occur as a result of unsuccessful attempts at reading. Later, 

French et al. (1995) listed characteristics that may indicate comprehension problems. The 

list is as follows: 

1. They said that students with comprehension problems show no sensitivity to 

organization of information in text 

2. Show difficulty in using or activating prior knowledge 
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3. Use no self-questioning strategies 

4. Do not summarize text 

5. Do not self-monitor comprehension. 

Word Recognition 

White and Herbert (1994) reported that reading consists of recognizing words. Because 

ofthis, French et al. (1995) in agreement with this finding, stated that reading 

comprehension requires word recognition. They indicated that word recognition comes 

before reading and therefore, sight word vocabulary is affected by word recognition 

deficits. 

Word Recognition Deficit 

Folse (1996) and Stanovich (1991a) reviewed research pertaining to students with reading 

problems. They identified acquiring and using word recognition skills as the problem. 

French et al. (1995) said that one of the traditional ways oflearning to read included 

acquiring good word recognition skills. Leo (1994) suggested that teaching beginning 

reading required word recognition ability. Researchers linked word recognition skill to 

reading ability (Wong, 1996; Gillet & Temple, 1994; Stanovich, 1991b; Gough & Juel, 

1991). 
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The researchers reported mixed findings on the best approach to correct word 

recognition deficit (Stanovich, 1991b; Gillet & Temple, 1994). However, they all agreed 

that the approaches should include current events in students' lives to help them increase 

word recognition skills. Students may identify words according to what make sense to 

them (Gillet & Temple, 1994). Beyond this, several researchers (Bos & Vaughn, 1994; 

Lipson & Wixson, 1991; Naslund & Samuels, 1992) reported on other approaches. They 

suggested that spelling-to-sound decoding and direct visual recognition appears to be 

effective approaches. 

Analogy and Letter-Sound Approaches 

Graves, Watts, and Graves (1994) said that words sharing onsets and rimes share similar 

pronunciations. Readers using the analogy approach connect onsets and rimes in words 

they already know with the same onsets and rimes in words they do not know (Fox, 

1996). This process involves the use of familiar words to recognize unfamiliar words. 

Students must know the beginning letter-sounds in words to use the analogy approach. 

They also need to know sounds of vowels and ending consonants to form recognizable 

words. According to Ehri and Robbins (1992), these basics help the students to 

recognize and remember onset and rime in the context of real words. Fox (1996) noted 

that students using the analogy approach require less phonological awareness. She 

pointed out that such approach benefits students who have difficulty decoding words and 

letter-sounds. 
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According to Gillet and Temple (1994), breaking words into sounds, and matching 

sounds with letters provides students with a more efficient memory for recognizing 

words. The letter-sound approach allows students to identify any word that sounds the 

way it is spelled (Fox, 1996). Thogmartin (1997) and Tunmer (1991) summarized from 

their research that students must display some level of phonological awareness to benefit 

from the letter-sound approach. Therefore, students experiencing difficulties with 

phonological awareness may benefit from the analogy approach. 

Cue Strategies 

Beginning learners used different cue strategies to help them identify words. Some 

strategies provide advantages over others. According to Fox (1996), the early strategies 

(environmental cue strategy, picture cue strategy, incidental cue strategy, and code cue 

strategy) indicated unreliability in identifying unfamiliar words. According to Nicholson. 

(1994), students need different types of cue strategies for effective identification of 

words. 

Gough and Juel (1991) hypothesized that students without learning deficits learn words 

first through paired-association strategy. They stated that "confronted with the task of 

learning that a certain response goes with some stimulus, the learner examines the 

stimulus, and selects from it some cue, some aspect, some property which might 

distinguish it from the other stimuli from which it must be distinguished" (p. 48). The 

students begin this process by noticing a cue. They translate that cue into a response that 
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associates only with that cue. The next time the students see that cue, they may retrieve 

the associated response. The students retain the association when they respond correctly. 

They throwaway the association when they respond incorrectly. 

Gough and Juel (1991) further explained their hypothesis on acquiring first words by 

indicating that students see their first printed words as meaningless random shapes. 

However, the students want to make sense out the words. Therefore, they examine the 

words for anything that might help them to remember. This stage identifies the step 

involving association. The cue might include pictures, tables maps, charts, graphs, 

diagrams (Leo, 1994; Dechant, 1991), characters, single-letter, or whole-words. Gough 

and Juel stated that using this procedure provides an easy way for students to recognize a 

few words and those words can become visually distinctive. 

Gough and Juel (1991) cited two unpublished experiments carried out by Gough to show 

evidence supporting their hypothesis. In the first study Gough asked thirty-two beginning 

readers without learning problems to learn four words on flash cards randomly presented. 

One of the four cards had a thumbprint in the lower left comer. He presented the cards 

until subjects got them all correct. Gough found that all the subjects learned the word 

with the thumbprint faster than the others did. This showed that the subjects associated 

the word with the thumbprint cue. Gough showed the subjects the same word on a card 

without the thumbprint and found that few of them correctly identified the word. 

Gough's experiment supported the hypothesis that students may learn to recognize words 
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by selecting a cue and making an association. Gough and Juel suggested that if a word 

accompanies an extraneous cue, the students may select that cue and may not come to 

recognize the word without the cue. 

In the next study, Gough taught thirty emerging readers without learning problems to 

read four 4-letter words on flash cards. He showed the subjects the first half and then the 

last half of each word and asked them if they could recognize the words. Gough 

presented the cards randomly. He tallied the recognition ofthe second half. 

The hypothesis stated that when students select cues from one half, they might not 

recognize the cues from the other half. Gough (1991) found that the subjects recognized 

one half of the word. Subjects who did not recognize the first half of a word recognized 

the second half twice as often as the subjects who recognized the first. Those subjects 

who did not recognize the second half recognized the first half one-and-a halftimes as 

often as the subjects who recognized the second half. 

Gough and Juel (1991) concluded by indicating that selective association bears two 

problems. First, students experienced difficulties in finding unique cues when the 

number of words increased. Second, students come across unfamiliar words with no way 

of finding their own cues. According to Fox (1996), context cue may help in those 

instances. However, Seyler (1997) pointed out that students who use context cues within 

a text for word recognition showed negative results. 



Kennedy, Itkonen, and Lindquist (1994) also used a cue strategy in their study. They 

taught three students with learning disabilities to read and match sight words using a 

comparison procedure. The researchers defined this method as the process of using 

stimulus as categories and placing given words under the appropriate categories. They 

examined the number of cues the subject used before responding correctly. The 

researchers reported that subjects started out using few cues and finished using more 

cues. 
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Roger and Peutrill (1994) conducted a study to teach reading students with reading 

disabilities to recognize words using a cue strategy. Roger and Peutrill also used a 

method for improving word recognition skills. They conducted the study using Peutrill's 

method. 

The study required two sessions. In session one, the observer wrote some of the crucial 

words that caused a student problems on separate cards. Given pictures, the observer and 

the student selected one picture that related to each word. After the student had made 

visual links between pictures and word cards, the observer and student repeated 

sentences, emphasizing the chosen words. The observer shuffled the cards and the 

student, given adequate time, matched words and pictures. The observer made notations 

on each match. In session two, the observer checked the word-picture pairs remembered 



by subjects. Then, the observer removed the picture completely. All the students read 

the words. 
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In Roger and Peutrill study, students received instructions for fifteen minutes per week 

for five weeks. The observer presented six words at each session for testing the following 

week. The observer re-tested students on learned words each week to ensure that they 

still recognized them. To balance out any possible effects of practice, the observer took a 

random sample of half the subjects and taught them using the method. The observer 

taught the other half without the method. Then, the observer reversed the control and 

testing groups after five weeks to assure proper measurement of both methods. 

The recognition of a maximum of thirty previously unknown function words, out of a 

context with no cues or prompts indicated a hundred percent success rate. The results 

indicated that those students using pictures and word association recognized more words 

than those under the control condition did. This finding suggests that the students rely on 

the visual processes in reading. 

Visual and Auditory Processes of Reading 

Barker, Torgesen and Wagner (1992) stated that word recognition requires a process that 

uses audio and visual information for comprehension. Acquired skills in word 
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recognition comes from the use of visual and auditory processes (Beech & Awaida, 

1992). 

Visual Processes of Reading 

Massaro and Sanocki (1993) said that one of the fundamentals of reading words lies 

within the visual processes. They indicated that early researchers studying word 

identification reported that word recognition appeared dependent on visual recognition of 

individual letters. According to Massaro and Sanocki, current researchers and educators 

concluded that students learned words as visual patterns of unique shapes rather than as 

unique sequences of letters. Whole-word method to teaching reading came form this 

belief. Massaro and Sanocki disagreed with this method of teaching. They pointed out 

that experimental researchers rejected the idea of word recognition based on visually 

unique shapes, ruling out visual processing. 

However, Willows, Kruk, and Corcos (1993) reviewed studies on the involvement of 

visual processing in reading disabilities. They said researchers showed that visual 

processing deficits might appear among students with reading disabilities. Willows et al. 

indicated that the researchers aimed at examining the visual processing to determine the 

role it might play in learning to read and in reading disabilities. They added that few 

studies on reading problems validated the possible link between visual processing deficit 

and reading. 
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Willows, Kruk, and Corcos (1993) said that visual recognition memory differs in 

students with reading problems, concerning their ages. Willows, Corcos, and Kershner 

(1993) conducted a study on visual recognition memory for unfamiliar symbols. They 

used subjects with and without reading problems in three age groups. The researchers 

used a computer game as the testing environment. They showed subjects a target 

stimulus selected randomly from eighteen Hebrew letters. After a break, the researchers 

showed subjects the test stimulus by the same letter or by a different letter of the same set 

of Hebrew letters. Subjects pressed one key to indicate the test item was similar to the 

target item and another key to indicate differences. They found that students with reading 

problems experienced less accuracy in their visual recognition performance. In this 

study, the deficit appeared to be displayed by the subjects in the younger age category. 

Auditory Processes of Learning 

Students use hearing to acquire language. They begin interacting with language first by 

hearing the spoken words. The auditory processes exist as a necessary part of normal 

development. In the educational system, listening appears as the primary demand on 

students. Students in their early school experience receive instructions orally. Because 

students get their first educational instructions orally, they might prefer gaining 

information using this method. Ifthis appears true, students may learn more by listening, 

thereby being classified as audio learners. However, researchers pay little attention to the 

auditory processes of learning. According to Roeser and Downs (1995) this happens 

because of difficulties with auditory instruments. They indicated that the instruments 
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provided poor quality recordings and were difficult to obtain. Beyond these factors, the 

researchers do not get a sense of the sensitivity and specificity of various audiological 

measures available. 

Auditory learning requires a normal auditory system (Roeser & Downs, 1995). Specific 

disabilities in perceptual and conceptual functioning may affect auditory learning. 

Auditory conditions can create problems for students. Auditory agnosia prevents 

students from interpreting, recognizing or identifying sounds. They ignore unfamiliar 

sounds or may respond to sounds as new experiences. 

Students with reading problems may also experience problems with their auditory 

system. Teaching methods that rely on auditory processes may not provide success for 

those students. Several reviews and summaries (Schneider, 1992; Chermak & Musiek, 

1992; Smoski, Brunt, & Tannahill, 1992) addressed this issue. For adults, the 

remediation process involves counseling, using coping strategies, and managing the 

auditory environment (Roeser & Downs, 1995). 

Adult Learners 

Tight (1996) addressed adult education and implied some broad assumptions about adult 

learners. The adult learners displayed strong and poor qualities in the learning 

environment. They bring life experiences to the classroom, take time on examinations, 



and show strong personalities. Adult learners know what they want. They spent years 

learning from radio, television, newspapers, magazines, community meetings, church, 

volunteer work, and social activities. Adult learners come prepared to learn. They try 

their best to allocate time and money toward their education. Joughin (1992) said that 

usable research on adult learners does not exist and no experimental situations exist for 

the elements mentioned above. 
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Tennant and Pogson (1995) also implied some basic assumptions of adult learners. 

According to Tennant and Pogson, procedures, rules, and regulations of campus 

operations overwhelm adult learners. They rarely take short cuts in their assignments. 

The adult learners lack concentration. Adult learners show difficulty in organizing time. 

Most of the adult learners display signs of reading problems (Fingeret & Drennon, 1997). 

They tend to read all materials the same way. The adult learners display writing 

problems. They experience difficulty with working with numbers and want meaning out 

of every procedure. Most of them appear close-minded, holding set values of right and 

wrong. 

Adults with Learning Problems 

Darden and Morgan (1996) said, "No national standard criteria for diagnosis oflearning 

disabilities exist for the adult population" (p. 186). Therefore, adults with learning 

disabilities received their diagnoses during childhood. According to Stage and Milne 

(1996), researchers conducted very few studies on adults with learning disabilities. 
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Adults with Learning Problems - Academic Abilities 

Morgan, Sullivan, Darden, & Gregg (1994) studied college students with learning 

disabilities. They examined perfonnance scores and verbal skills. Their findings 

supported Leonard's (1991) findings that successful college students with learning 

disabilities display good verbal skills. Matejcek and Dytrych (1993) and Miller (1996) 

added that some of those students could succeed in college. Given the right support and 

conditions, college age students with learning problems can achieve academically (Martin 

& McLaughlin, 1993). According to French et al. (1995) and West (1991), some college 

students with learning disabilities show intellectual strength in specific areas. 

Adults and Computers 

Adults often improve academically when the learning process includes social and 

constructive activities (Collis, 1995). Collis said that adults need flexibility in learning 

activities. Therefore, adult learning increases the growing interest in innovative 

instrumentation (Dean, 1994). 

Instrumentation 

State-of-the-art innovations in adult learning provide adults with more learning tools. 

Some of these tools include innovative software, innovative communication technologies, 

and combination of both. Such tools may shape adult learning. Buenaga, Fernandez­

Manjon, and Fernandez-Valmayor (1995) studied software tools to help adult learners 



reduce infonnation overload. They said that knowledge structures and readers' models 

could increase interpretation of infonnation most appropriate to the adult readers. 

Zwaneveld and Vuist (1995) proposed the use of innovative software tools that support 

adult learners' articulation of specific infonnation. The new technological tools must 

help adults to cope with their academic problems while accessing and processing 

infonnation. 

Practice 
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Adult learners need to utilize innovative tools. According to Ask (1995), adult learners 

appreciate flexibility of electronic environments but they do not rush to an orientation of 

sharing and exchanging knowledge. This makes it difficult to put innovations to practice. 

Ask said that various developments must be in place to correct this problem. 

Computers and Reading 

Users of computer applications read text from a visual display unit. Reading text from a 

screen-display unit may have implications worth reviewing. Researchers analyzed and 

reviewed the processes involved in reading (Dillion, 1994). They studied eye­

movements, visual displayed materials, and comprehension of readers. Computer 

application developers used infonnation from these studies and others to help them 

design effective visually displayed documents. 



Computer Screens 

Many software developers provide user manuals as visual displays on screen. Display 

screens come with different features to help readers. The resolution feature allows the 

readers to make adjustments for readability. Text also appears with features to help the 

readers visually. With these basic features, the screen displays the reading materials 

according to the readers' specification. 

Reading from Screens 

McKnight, Dillon, and Richardson (1991) and Charney (1994) reported on several 

elements of computer and reading. They reviewed some of these studies and concluded 

that the users reading from a screen tend to read slower but more accurately than users 

reading from printed text. However, Olson (1994) said that reading on screen affects 

comprehension and metacognition. 

Hypertext Reading 
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Costanzo (1994) gave an overview on reading electronic text. He said that electronic text 

presents no boundaries. Electronic text becomes unfixed and interactive (Rouet & 

Levonen, 1996; Lanham, 1992). Users may move, expand, condense, or reassemble text. 

According to Costanzo, this concept turns into hypertext. Hypertext consists of chunks 

of information and links between them (Nielsen, 1994). 



Johnson-Eilola (1994) addressed hypertext reading in his paper. He indicated that 

hypertext can make visible the goals and processes of current reading theories. This 

visibility can help theorists and educators examine concerns within reading technology. 
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Charney (1994) examined the effects of hypertext reading. He said that hypertext 

changed the way users read text. It made complex documents less complex and provided 

easy access to varying information. Hypertext provided writers of online manuals with 

flexibility by using links and nodes. According to Gall and Hannafin (1994), links 

connect nodes and define access from node to node. They said that node referred to 

organized unit of information. In the hypertext manuals, readers with less experience 

may select to follow links to nodes with definitions, examples, explanations, reminders, 

or advice. However, readers with experience may bypass the links. Writers also 

designed hypertext environments where the users receive guides at different levels of the 

links. Therefore, hypertext manuals appear suitable for all users. 

Hypertext versus Paper Document 

Snyder (1996), Garrison and Burton (1995), and McKnight, Dillon and Richardson 

(1991) reviewed studies on paper versus hypertext. They found conflicting results. The 

reviewers indicated that the users, tasks, and information types used by the researchers 

appeared incompatible. In summarizing the review, McKinght et al. pointed out that 

hypertext and paper both appeared limited. Landow (1994) implied that readers locating 

specific information within the body of text worked well with hypertext documents. 



Those readers accessing information for the first time on an unfamiliar subject and 

unable to formulate parameters worked better with paper documents. 

Conclusion 
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Hypertext systems may not yield better performance. However, they can help some 

readers navigate and acquire necessary information without going through complex 

documents. Dillon (1994) suggested that no one implementation of hypertext appears 

superior to another. As the technology improves, hypertext may become more effective. 

Hypertext versus Linear Electronic Text 

Chen and Rada (1996) and McKnight, Dillon and Richardson (1991) reviewed studies on 

hypertext and linear electronic text. They said that the researchers suggested that the 

hypertext structure places the burden of navigation on the reader and therefore leads to 

poor performance. In the linear systems, subjects knew the structure and became 

constrained by the manipulation facilities available to them. In the hypertext systems, 

subjects did not know the structure and had to suppress their knowledge of where 

information mostly appeared. However, in the hypertext systems, subjects manipulated 

text faster and more direct. 

Hypertext versus Hypertext 

Researchers conducted studies on different hypertext systems to observe the effects of 

organization or access mechanism on performance. Gaggi (1997) said that comparisons 



among hypertext systems involved much more than certain implementations. 

Nevertheless, researchers compared these systems to give designers and educators a 

better understanding of good hypertext. 

Navigation Through Electronic Text 
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Dillion (1994) stated that hypertext increases the chance of readers becoming lost. 

Therefore, navigation plays an important role in hypertext environments. Readers of 

hypertext documents navigate through text to get information. Navigating may puzzle 

some readers and cause difficulty. They might not know how the designers organized the 

information or if the hypertext document contains the information. 

The Navigation Process 

The study of navigation appears in different areas like spatial imagery, orientation, and 

distance judgment. Navigation becomes difficult for investigators to make theories from 

scattered works. However, those works do provide some agreements. 

Models of Environments 

According to Dillion (1994), models exist ofthe physical environment. We create the 

models which come from experience. Models give us a basic reference for the purpose of 

navigation. Such models guide our responses to the physical environment. Therefore, 

models can become identical to maps. 
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Cognitive Map 

Esperet (1996) and McKnight, Dillion, and Richardson (1991) cited early reports on 

navigation. They said that the theorists agreed that acquiring navigational knowledge 

comes from initial identification oflandmarks to a full-formed mental map. Landmarks, 

by themselves, provide little use for complex navigation. Nevertheless, they produce 

route and survey knowledge. Experimental investigators demonstrated that landmark, 

route, and survey knowledge become suited for specific tasks. 

Most navigation studies dealt with traveling through physical space. However, this type 

of navigation may provide useful information to hypertext designers. It may give them a 

different perspective on designing hypertext systems. 

Navigating Paper Documents 

Writers of books give readers lots of information from the book covers to the indexes. 

Book covers tell us the title of the books. The next set of information list publishers and 

publication dates. The table of contents follows this information. Within the table of 

contents, the writers list chapters, sub-titles, and page numbers. Writers organize their 

chapters around themes. At the back of the book, writers organize the index 

alphabetically to indicate where specific information can be located in the body of the 

text. Newspapers and magazines follow similar formats as books. An experienced reader 

knows all of this and expects these features in a book. 
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Models of Paper Documents 

McKnight, Dillion and Richardson (1991) cited research on models of paper documents. 

They summarized the model of one early research work conducted by van Dijk and 

Kintsch. This theory said that readers acquire layout through experience that helps in 

comprehension of materials, by allowing the reader to predict the order of elements in the 

body. McKnight, Dillon and Richardson added that such a layout applied to several text 

types showed that readers got a better understanding ofthe main ideas and subject matter. 

They pointed out that the layout structure appears irrelevant to remembering specific 

details. Lennon (1997) supported this point. 

McKnight, Dillion and Richardson (1991) reported the findings of two early studies on 

the structure on paragraphs and sentences oftext. In the first study, subjects received 

paragraphs from academic journal articles to organize them into one article as fast as they 

could. The researcher implicated that experienced readers can distinguish isolated 

paragraphs of text according to their location within a complete article. In the second 

study, subjects read a selection of paragraphs from paper and screen. They had to place 

the paragraphs in the general section to which they thought it belonged. The result 

showed a high degree of accuracy with paper. McKnight, Dillion, and Richardson 

stated that these results suggest that readers do have a model of the typical journal article 

that allows them to accurately locate information. This indicated the presence of 

cognitive maps. 
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Cognitive Map o/Texts 

To develop a cognitive map oftext, readers need landmarks. These landmarks provide 

readers with information. The landmarks include indices, contents, chapters, headings, 

summaries, page numbers and more. While reading, readers notice maps, diagrams, 

figures, and tables. These items can exist as landmarks within a specific text. Esperet 

(1996), Rouet and Levonen (1996), and McKnight, Dillion, and Richardson (1991) said 

that the reports on cognitive map indicated that as readers become more familiar with the 

various landmarks in the text and their inter-relationships when familiarity with the text 

increase. 

Conclusion 

In paper documents, the layout consists of items readers expect to see. These items direct 

readers to more specific information. The general organization of paper documents offers 

readers direction when dealing with complex information. Readers may develop models 

of the text based on landmark knowledge. 

Navigating Electronic Documents 

Electronic documents can differ from application to application. They can also differ 

from computer to computer and from year to year. Therefore, electronic documents 

involve models that may exist uniquely to a specific application or to few applications. 
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Models of Electronic Documents 

When readers open electronic documents they see an electronic layout. For example, in a 

hypertext system, readers see a welcome screen that gives a general idea of the content. 

The system also provides, within the introduction, information about the developer or 

developers and the copyright year. Such a system gives no indication that certain features 

exist. Readers would not expect linked information, non-linear structure, and navigation 

problems (Lanham, 1993). Readers' knowledge ofthe layout in a hypertext system 

seems more self-taught. 

Cognitive Map of Electronic Space 

Horton (1994) stated that the research on electronic space shows that readers can get lost 

in non-linear electronic documents while seeking information. This causes severe 

navigation problems. 

Classifying the information available in the database becomes relevant to navigation. 

The way the developers classify information influence the time taken to access data. 

Therefore, readers may experience problems with category descriptors. 

Navigational difficulties exist when readers need to locate information in the electronic 

space. Knowledge about navigation and the organization principles of the information 

structure proves important in electronic space. 
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Cognitive Map of Hypertext Document 

In acquiring a cognitive map of the hypertext document, readers must know where to find 

information. They use indicators to help them locate information. Universal landmarks 

within hypertext systems can provide indications for them. Price and Sanders (1995) and 

McKnight, Dillon, and Richardson (1991) pointed out from an early research that 

experienced readers of hypertext systems spend time in the index or content area. They 

jump from body text to content area. Such navigation may prove more effective than 

other ways of navigating. 

Navigational Information: Browsers, Map, and Cues 

Graphical browsers appear in hypertext systems. Browsers represent documents 

graphically (Kelly, 1996). They provide readers with a simplified map for locating 

specific information. Browsers show the reader the overall information space, link 

information space, and offer a means of moving from one information to another. 

Some reviews offer empirical findings on maps. According to Cockerton and Shimell 

(1997) and McKnight, Dillion, and Richardson (1991), researchers found that maps 

proved effective in helping readers navigate through text. 

Different structural cues produce varying results. Structural cues can help readers of 

hypertext systems (Dillion 1994). They involve alphabetic index, hierarchical content list, 



graphical contents, and textual list. Studies on structural cues give the developers of 

hypertext systems useful information to help them in the designing process. 

Navigating Semantic Space 
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Developers of hypertext systems create arguments for readers to find information. These 

arguments appear in the semantic space. Readers need to find their way about the 

arguments. The semantic space relates to navigation when developers design good 

structuring information. Making useful links and associations helps make for good 

structuring information. 

Conclusion 

Navigation gives the designers information about readers' actions or movements through 

electronic space. The navigation of physical environment showed some relevance to 

navigation in electronic space. Developers need clearer evidence to support the theory of 

difficulty in navigation. The models of navigation knowledge may provide designers 

with guidelines. 

Education and Technology 

The way educational technology is incorporated can influence the performance of users 

with learning disabilities. For example, the way on-line text is used in software, may not 

help users with learning problems perform a given task. Therefore, it is important that 
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the type of educational technology used with students with learning deficits provide true 

assistance. 

Educational technology offers flexibility for students with learning problems (French, 

Ellsworth & Amoruso, 1995). MacArthur (1996) said that computers might provide 

benefits for students with learning disabilities. Computers emerge as an add-on to 

existing curriculums. Educators of students with learning disabilities most often use 

computers for remediation and supplementation (Poplin, 1995). Raskind (1993) pointed 

out that they must use computer technologies to help students with learning deficits rather 

than for remediation. Tolhurst (1995) and Gunning (1992) suggested that software for 

reading should include task analysis, diagnosis, monitored instruction, exit tests and next 

level skill to help students in the reading process. 

Reading Tasks 

Reading as a manipulation task involves performance of any goal-directed activity 

(Charney, 1994; McKnight, Dillon & Richardson, 1991). This includes identifying, 

locating and processing relevant materials. Readers interact with information 

manipulation tasks differently. They may scan, browse, or read the entire text. These 

differences can become useful for hypertext developers because they imply suggestions 

for hypertext systems (Colford, 1996). 
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Task Performance 

Researchers used several methods to observe what readers do with text. These methods 

include non-interfering observations, less-intrusive observation, and verbal interaction 

with text (Dillion, 1994). With the verbal protocol method, subjects must read and think 

out loud. According to Dillion this method interferes with the normal processing 

involved in task performance. 

Task Effects 

Researchers focused on tasks that manipulate experimental variables (Lennon, 1997; 

McKnight, Dillon & Richardson, 1991). Such tasks include word recognition, letter 

recognition, proofreading, and sentence recall. McKnight, Dillion and Richardson 

summarized studies on task effects. They indicated that the measurements for task effect 

appeared inappropriate and paper experiments may not transfer to electronic documents. 

However, computer software is a solution to this problem. 

Statistics with Ranking Systems 

Ordinal Categories 

Categories used in classifying data appear in natural order along some continuum. 

For example, the categories "Most Positive", Somewhat Positive", "Neutral", Most 

Negative", and "Somewhat Negative" comes naturally ordered. This ordering refers to 

ordinal categories. Statisticians presents data classified into ordinal categories the same 
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way as other categories (Bouma, 1993). However, they maintain the natural order ofthe 

categories in tables or graphs regardless of the investigator's hypothesis. When 

statisticians can abandon categories, they assigned numerical ranks to the observations. 

They give up categories when individual observations can exist as comparisons and 

ranks. 

Ranks refer to numerals that order a set of observations from "Most" to "Least" along 

some continuum of interest (Marden, 1995; Babbie, 1992). The rank ofa given 

observation indicates its relative position in that set of observations. When the 

investigator use ranks, the results become ordinal numeral. This indicates the order of the 

observations relative to each other along the continuum of interest. 

In determining ranks, the investigator first assigns ranks to determine how many objects 

need ranking. This tells how many ranks required in the ranking system. For example, 

five objects will need 1 through 5. The investigator must account for five in the final 

ranking. The investigator then assigns ranks in a serial order. Ranks begin with the 

number one and stop at the number determined previously. When several observations, 

individuals, or objects are tied in a ranking system, the investigator assigns each a rank 

whose value corresponds to the mid-point of the two ranks. 
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The Results of Ranks 

The results appear self-evident. Ranking systems serve their purpose and require no 

lengthy discussion. Numerals assigned in ranking represent relative position within the 

particular group ranked (Fontana & Frey, 1994). When the group changes, the rank also 

changes. 

Some observations exist as distribution of scores. Statisticians may report the results of 

this using the centile ranks of selected scores. The centile rank tells the percentage 

included at and below its position in the group. For example, a score with a centile rank 

20 means that 20% of the observations in the distribution appear at or below that score. 

Correlation formulas may apply to ranks. Statisticians use different correlation formulas 

to determine the correlation between sets of ranks (Browne & Arminger, 1995). They 

look for the association between two variables. For example, statisticians compute linear 

correlation for data that appears linearly related. They use the letter r to show the degree 

of linear correlation between two sets of measures. This refers to the correlation 

coefficient. The correlation coefficient r exists independent of units of measurement. 

Therefore, all formulas for r transform the original measures into a standard scale. The 

standard scale appears the same for both variables. Statisticians use the z value for each 

original measure to get the standard scale. They compute r from z scores when 

correlation of two sets of measures expressed as different units. Also, statisticians 
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compute r from raw scores because X and Y distributions do not require conversion to z 

scores before computing r. They provide formulas for obtaining r from the raw data. 

Use a/Ranks 

Typically, statisticians do not use ranks when other measurements exist. Nevertheless, 

situations occur where quantitative measurement of a variable proves inappropriate. 

Statisticians strongly suggest the use of ranks when measures of distribution appear 

incompatible with the assumption of a normally distributed population (Marden, 1995; 

Keppel, 1991). Most of the statistical tests developed for measures assume a normal 

distribution of the parent population. To avoid this assumption, statisticians use a test for 

ranks in place of the t test or analysis of variance technique. 

Summary 

The researcher presented in this chapter findings in learning disabilities, word 

recognition, reading, adult learners, and computers. An argument was made for the 

problem students with reading disabilities experience. Those students exhibit low word 

recognition skills. In this review, investigators used several measures to help this 

popUlation increase their word recognition skills. These measures include educational 

technology, picture and word association, comparison procedures, direct reading 

instructions and practice exercises. However, word recognition deficit still exists among 

students with reading disabilities. Bruck (1993) reported that word recognition deficit 



persists into adulthood. Therefore, the investigator of the present study proposed a 

simple sample comparison procedure on word recognition computer tasks to help those 

adults. As a result of the review of literature, the current researcher presented ranking 

systems to indicate the type of statistics used. 

Contributions 

55 

This study may be statistically significant or statistically insignificant. If it appears 

statistically insignificant then other researchers will know not to pursue such research. If 

it appears statistically significant then other researchers can used the findings to promote 

other advances in the education of students with reading disabilities. 



Research Method 

Chapter III 

Methodology 

56 

The research method used in this study was a hands-on test. Subjects prepared slides for 

a university curriculum using a simple presentation tool: Microsoft® PowerPoint® 7.0. 

The investigator placed subjects randomly into two groups. One group was the control 

group and the other the testing group. Subjects in the testing group received the solution 

for improving their word recognition skills. The control group subjects did not receive 

the solution. Both groups received instructions to do exactly what was on the 

investigator-made layout sheet for each slide. 

The solution was a cue word list. It was used to improve subjects' word recognition 

skills while preparing a presentation using Microsoft® PowerPoint® 7.0. The present 

study attempts to increase the low word recognition skills of college students with 

reading disabilities. 
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Specific Procedures of the Method 

1. Task: 

The investigator gave subjects a five-slide presentation to complete and to solve the 

problem of adding a logo to all five slides. Subjects were tested individually. They 

received a text-based and a graphical display ofthe investigator-made layout sheet during 

testing. The investigator-made layout sheet contained the information for each slide. The 

graphical version of the investigator-made layout sheet showed subjects the result of the 

tasks. 

On slide one, subjects selected "Title Slide" from the AutoLayout dialog box and choose 

"OK." They typed in the text as instructed on the investigator-made layout sheet and 

added the toolbar button that searches the active presentation for specified text. On slide 

two, they selected "Bulleted List" and changed the background color to any color on this 

slide only. For slides three and four, subjects selected "Text & Clip Art" and inserted the 

specified clip arts. They cropped or trimmed the picture on slide three and they moved 

the picture on slide four. On slide five, subjects selected "Text Only" and changed the 

title color. Finally, subjects added a logo to the master slide. Subjects used the help 

topics "Find" tab option when necessary. 



58 
2. Treatment: 

The testing group received an investigator-made cue word list of search words as the 

solution to increase low word recognition skills. Subjects used the list to type in search 

words to find help topics. The control group subjects did not receive the investigator­

made cue word list. Subjects in the testing group did the following with the investigator­

made word list before reading help topics: 

1) Select a word from the investigator-made cue word list that relates to what you are 

trying to do at this point. This is your sample word. 

2) Choose two words from the cue word list that are in the same category as your sample 

word. These are your comparison words. 

3) Select one word from your comparison words. 

4) Use it in the "Find" tab option under "Microsoft PowerPoint Help Topics" to find 

"How to do" topics. 

5) Read the topics and select the one that has two or more of the words from the words 

you selected. 

6) Begin reading the selection in the help topic window line by line. 

7) Perform the tasks. 

3. Strategy: 

The investigator used a version of simple/sample comparison procedure to help students 

with reading problems improve their word recognition skills. According to Kennedy, 
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Itkonen, and Lindquist (1994), simple comparison refers to the process of placing words 

into categories to form stimuli. 

When subjects receive a sample word, they may match the sample word with comparison 

words. Associating sample words with comparison words may demonstrate equivalency. 

Establishing equivalence among words may increase subjects' word recognition skills. 

The goal of the present procedure was to see what the outcomes are on word recognition 

when subjects with reading difficulties receive simple comparison procedures before they 

read online help topics. 

Data Collection Process 

4. Processes: 

Four processes were used to collect data. The processes were observations, recordings, 

correct answers, and amount accomplished. 

• Observations referred to making notations about problems encountered by the 

subjects while completing tasks. 

• Recordings referred to tape recording subjects' while they were completing tasks. 

• Correct answers referred to the total correct items on the five slides. 

• Amount accomplished referred to the total amount of slides completed. 
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The investigator analyzed the actual recordings of all verbal responses and all observer 

notations to extrapolate information for the individual and objective questions. 

4a. Subjective Question: 

Did the proposed solution increase subjects' low word recognition skills? 

To determine an increase, the investigator used a set of questions and ranking on the 

replies. The ranking system was as follow: 1 - Most positive 2 - Somewhat positive 3-

Neutral 4- Somewhat negative 5- Most negative. 

French, Ellsworth and Amoruso (1995) pointed out characteristics that provided 

identification of students with reading disability. The investigator summarized questions 

from their work to develop the ranking form questionnaire. During an interview session, 

the observer completed the questionnaires because the subjects have reading/word 

recognition difficulties. The observer explained each question so the students understood 

them and to avoid skewed data. The observer asked the subjects the following questions: 

Did you read the same help topic more than once? 

Did you understand the organization of the information in the help topics? 

Did you use prior knowledge of any computer skills to help you? 

Did you ask yourself questions about what you were doing? 

Did you make notes or summarize the text before starting? 

Did you ask yourself questions to help you understand the instructions? 
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The observer read the following statement to the subjects immediately after they 

answered the above questions: "The responses in this research report will be anonymous 

and there will be no mention of your name." 

4b. Objective Questions: 

Did the subjects in the testing group complete the tasks with higher accuracy than those 

in the control group? The investigator measured accuracy using two measures: 1) 

Subjects completing tasks exactly as specified in the investigator-made layout sheet. 2) 

Subjects scoring high on the word recognition task. Accuracy was determined after the 

observer completed the checklist form for each subject. The observer gave subjects who 

completed the five slides without errors and scored high on word recognition a check 

mark in the accuracy box. Subjects who fell within any other conditions did not receive 

an accuracy check mark. 

How many correct answers? To compute the number of correct responses, the 

investigator made a list of all the words in the following help topics: Add a toolbar button, 

Change background color, Crop or trim portions, Move an object or set of objects, 

Change text color and Add a logo. 

Words appeared once in the word list. Each word had a score box next to it. The 

observer marked a "1" when the word was recognized and a "0" when it was not 

recognized. To determine high scorers, the observer divided the total number of words 

into the total number of recognized words. The investigator considered scores greater 
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than half of the total words as high scores. This detennined word recognition scores and 

reading deficit. "Poor word recognition diverts resources from the processes that are 

necessary for comprehension" (Bruck, 1993, p.259) and low word recognition skill is 

primary in students with reading deficits. 

How long does it take to complete the test session? To compute this, the investigator 

kept track of each subjects' timing. Since subjects had fifty minutes to complete the 

tasks, the investigator made a table indicating where they shut off at fifty minutes. 

Selecting Subjects 

5. Organizing: 

The investigator reviewed personal data files for clients in the 1996 - 1997 session at the 

private organization to detennine their eligibility for this study. This organization keeps 

psychological documentation of clients' academic and social abilities. 

5a. Selecting: 

The investigator selected subjects based on two criterias. First, subjects were clients of a 

private organization that assist students with learning disabilities with academic and non-

academic issues for the school year 1996-1997. Second, each subject had documentation 

indicating reading difficulties. 



Grouping Subjects 

5b. Groups: 

This study had a sample size of fourteen which was the total number of signed consent 

forms. The investigator randomly placed subjects into two groups evenly. Subjects 

picked a number between one and fourteen. The numbers were not recyclable. Those 

individuals who picked numbers I through 7 went into the control group and the 

remaining individuals went into the testing group. 

Participants of the Study 

5c. Subjects: 

Age - 18-30 years-old, college students 

Gender - male and female 

Number of males - 11 

Number of females - 3 

Total of participants - 14 

Ethnicity - Caucasians 

Socio-economic profile - Middle class 

Educational background - High school graduatesN ocational graduates 

Educational plans - Complete junior college or vocational training 

Employment status - Less than half ofthe participants held part-time jobs 
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Type of reading disability - Word recognition deficit 

Academic assistance - All participants receive independent tutoring and attend a study 

hall session at least once a week. 

Experience using a computer - All 

Experience using a presentation program - No 

Timing Procedure 

6. Time: 

The observer timed subjects during task completion. Each subject had 50 minutes to 

complete the 5-slide presentation. The time limit was fifty minutes based on pilot work. 

Recording Observation 

7. Recording: 
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The observer taped recorded verbal responses made by subjects and identified subjects by 

numbers. Subjects responded on sixty-minute lecture tapes. These tapes have thirty 

minutes recording per side. When side A of the tape finished, the observer requested 

subjects to stop and allow the change to side B. The tape recorder remained on 

throughout the duration ofthe tasks. During the recording, subjects made comments not 

relating to the tasks. Therefore, the observer erased all non-related comments. Beyond 

this, the tapes were erased after notes were made. 
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Observer Role 

8. Observer: 

The observer made written notations of subjects' actions and tape-recorded both groups 

during completion of tasks. Beyond this, the observer completed a ranking form for each 

subject and the accomplishment form. 

Categorization and Description of the Data 

9. Descriptions: 

Number of subjects in the study - The total number of subjects that participated in the 

study. 

Number of females - The number of females that participated in the study. 

Number of males - The number of males that participated in the study. 

Type of reading disability - Have trouble with anyone of the reading processes 

Experience using a computer - Yes, if subjects had academic or non-academic interaction 

with a computer. 

Experience using a presentation program - Yes, if subjects had academic or non-academic 

interaction with a presentation program. 
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Formats for Presenting Results 

10. Presenting Results: 

The investigator presented the results using ranking correlation. Generally, researchers 

use correlation with the assumption of having a nonnal distribution. However, when the 

population parameters are unknown, researchers use correlation by ranking observations 

and correlation by rank values. 

Results in rank correlation consist of two factors. First, observations of judgements and 

opinions can be part of the result. Second, the results may be relative observations by 

ordinal scales for two ranked series. The researcher of this study employed both factors. 

This fonnula calculates r directly from the raw data (no ties: Direct observational data) 

n*iixy-iix*iiy 
r=-r============================ 

~([n * iixA
2 - (iixf2][n * iiyA2 - (iiyf2]) 

With ties: rc (relative observation) 

The researcher used scaler rankings on Series 1 and Series 2 by obtaining data for each 

category: Control Series 1 - New Series 2. 

r= 
1-(6*iid

A
2) 

(n
A

3-n) 

The standard deviation describes the scatter of the observations and their means. 



Standard Error of Estimate = Standard Deviation 

oxy= 
(iiy" 2 - a * iiy - b * axy) 

(n-2) 

a & b = Constants of regression 

L (x" 2 * iiy - ax * axy) 
a= 

(n*ax"2-(iix)"@) 

(n * axy - ax * iiy) 
b= (n*iix"2-(iix)"2) 

Standard Deviation of Scatter: ss 

oxy= 
(ii(y- yc)"2) 

(n-2) 

The investigator presented the results for the current study in a discussion form. For 

illustration purposes, the investigator used some tables and graphics. 

Projected Outcomes 

lOa. Hypotheses: 

HI: Subjects in the testing group will score higher on word recognition skills. 

H 2: Subjects in the testing group will complete tasks in less than fifty minutes. 

H 3: Subjects in the testing group will complete tasks accurately as specified in this 

chapter (section 4a). 
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Standard Error of Estimate = Standard Deviation 

oxy= 
(ay"2 - a * ay - b * axy) 

(n-2) 

a & b = Constants of regression 

L(x"2 *ay- ax *axy) 

a= (n*ax"2-(ax)"@) 

(n * iixy - ax * ay) 
b= (n*iix"2-(iix)"2) 

Standard Deviation of Scatter: ss 

oxy= 
(a (y - yc)" 2) 

(n-2) 

The investigator presented the results for the current study in a discussion form. For 

illustration purposes, the investigator used some tables and graphics. 

Projected Outcomes 

lOa. Hypotheses: 

HI: Subjects in the testing group will score higher on word recognition skills. 

H 2: Subjects in the testing group will complete tasks in less than fifty minutes. 

H 3: Subjects in the testing group will complete tasks accurately as specified in this 

chapter (section 4a). 
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Resource Requirements 

12. Instruments: 

Description of investigator-made word recognition list: This was all the words that 

appeared in Microsoft® PowerPoint® 7.0 help topics "Add a toolbar button, Change 

background color, Crop or trim portions, Move an object or set of objects, Change text 

color and Add a logo." The investigator placed words in alphabetical order in a two­

column format. Column one had the words and the other column had the points. The 

investigator-made word list can be found in Appendix I. 

Description ofthe investigator-made cue word list: This word list consisted of words 

from the help topic of a task and placed under a category based on that task. Each 

category had four words relating to the task of that category. The investigator-made cue 

word list can be found in Appendix F. 
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Description of investigator-made layout sheet: This type written sheet had all the data for 

the 5-slide presentation. The investigator-made layout sheet can be found in Appendix D. 

Description of ranking form: The ranking form consisted of six questions. The 

investigator used a ranked system with numbers from one to five where one was most 

positive and five was most negative. The ranking form can be found in Appendix K. 
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Description of accomplishment fonn: The number participants selected during random 

assignment to groups were written on this fonn with check boxes. The investigator 

named the check boxes as follow: Errors, Yes, and No. Along side, the check boxes were 

checklist items. These items were as follow: Subject completed 0 slide, Subject 

completed 1 to 2 slides, Subject completed 3 to 4 slides, and Subject completed 5 slides. 

At the end ofthe checklist were "Yes" and "No" boxes with the statement "Received high 

word recognition score". The accuracy box appeared as the last item on this fonn. The 

accomplishment fonn can be found in Appendix J. 

Description of software program: Microsoft® PowerPoint 7.0 is a presentation program 

designed to assist users in improving their spoken presentation skills. 

Description of computer system: The computer where Microsoft® PowerPoint 7.0 was 

installed in was a multimedia Pentium microprocessor running at 133MHz with 24 

megabytes of RAM and a 1.5 megabyte hard drive. It had Microsoft® Windows®95 as 

the operating system and all the other programs that accompanied Windows®95. 

Description of recording device: The recorder was a Sony® tape recorder. It held one 

tape and allowed one recording at a time. The Sony® tape recorder had the following 

features: record, fast forward, rewind, play, batteries, wall plug, headphone and built in 

speakers. 
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Setting 

Testing took place in the private organization tutoring room. This tutoring room had a 

desktop computer with comfortable chairs and ample lighting. The room was spacious 

and carpeted. There were two full size windows adjacent with shades half-drawn. The 

observer placed a display board on the right hand side ofthe computer monitor. It faced 

the adjacent windows. Subjects were seated with their backs to the windows. 

This private organization assists college students with learning disabilities with college 

related issues. They provide assistance in tutoring, financial planning, academic 

scheduling, independent living skills, employment, socialization, and entertainment. 

Each student receives a tutor for every class. They attend tutoring session everyday. 

Students take no more than two classes during their first semester. Based on their 

success, they can register for one to three classes thereafter. Most of the students attend 

junior college. Meanwhile, other students attend vocational schools. The same 

registration procedure applies to these students. All the participants of this study were 

enrolled in a junior college at the time ofthis study. 
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Reliability and Validity 

The instruments and protocols used in this study were all investigator-made except for the 

presentation program. Since this study used human subjects, the university Institutional 

Review Board (IRB) reviewed the instruments and protocols. The board approved the 

investigator-made materials. 

Summary 

The aim ofthis study was to use an investigator-made cue word list to increase college 

age students with low word recognition skills while creating slides for a university 

curriculum using a simple presentation tool. The investigator randomly divided fourteen 

subjects into two groups. One group received the treatment and the other did not. 

Subjects received fifty minutes to complete a five-slide presentation. The investigator 

used four different data collection processes. Beyond this, the investigator hypothesized 

those subjects in the testing group will score higher on word recognition skills, complete 

tasks in less than fifty minutes, and accurately complete tasks. 

Expectations 

This study may provide useful information to students suffering word recognition 

problems and aid educators, courseware developers, and software engineers who assist 
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them. The results may give those individuals information for addressing word 

recognition problems of students with reading difficulties. It may help the educational 

and technical professional design educational programs within computer environments 

that make word recognition becomes less of a challenge for students with reading deficits. 

Technical professionals may apply the findings to online instructional aides. In this 

section ofthe computer environment, subjects may use the sample comparison procedure 

to help them recognize words. 

The constraints and limitations mentioned in chapter one do affect the study. However, 

with accurate use of the procedure subjects may increase their word recognition skills. 

The investigator of this study recommends additional studies in computer environments 

and word recognition skills using other comparison procedures. This study determines 

whether the simple sample comparison procedure may produce significant results that 

might further more investigation. 

This study contributes statistical findings in the area of computer education. The findings 

give other researchers directions in computer environments and word recognition deficits. 
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Chapter IV 

Results 

Introduction 

In this chapter, results from the current study are presented. For illustration purpose, the 

investigator used tables and graphs to demonstrate either individual or group 

performances. Beyond this, the investigator organized the raw data into different 

elements to examine. The results from the raw data were introduced as the findings. 

Finally, the investigator concludes the chapter with a summary of the findings. 

Data Analysis 

Table 1 
Slides Ctrl Test 

Group Group 
Subjects got to 0 0 0 
Subjects got to 1 to 2 0 1 
Subjects got to 3 to 4 2 3 
Subjects got to 5 5 3 

(SlIdes each group got to) 

This table indicates the slides subjects attempted before allotted time expired. 
Subjects started the slides but did not complete the required tasks. 



Figure 1 

Slides 

Table 2 
Slides 
Completed only 0 
Completed only 1 
Completed only 2 
Completed only 3 
Completed only 4 
Completed only 5 

Slides Got To 

Subjects Subjects Subjects Subjects 
got to 0 got to 1 to got to 3 to got to 5 

2 4 

Subjects 

Ctrl Test 
0 0 
0 0 
0 2 
2 1 
5 2 
0 2 

(SlIdes Subjects Completed) 

IIIIICtrl Group 

II1II Test Group 

This table shows slides the groups finished. The groups completed slides when they 
applied all the task instructions for the slides. 
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Figure 2 

Table 3 

Slides 
1 
2 
3 
4 
5 

Slides Completed 

Slides 

o 1 2 3 4 

Completed Slides 

Errors (Ctrl) Errors (Test) 
2 1 
4 3 
5 0 
6 0 
4 2 

(Errors) 

5 

III Ctrl 

III Test 

The investigator examined each slide for errors and noted how many errors the groups 
made on each slide. 
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Figure 3 

Errors 

5 

4 

3 II Errors (Ctrl) 

Slides II1II Errors (Test) 
2 

1 

0 
1 2 3 5 

Errors 

Word Recognition: (Subjects 1-7 Control Group and Subjects 8-14 Testing Group) 

Table 4 
SUBJECTS NUMBER OF WORDS CORRECT NUMBER OF WORDS SCORE 
Subject 1 186 186 100 
Subject 2 165 186 88 
Subject 3 163 186 87 
Subject 4 169 186 90 
Subject 5 166 186 89 
Subject 6 148 186 79 
Subject 7 147 186 79 
Subject 8 183 186 98 
Subject 9 186 186 100 
Subject 10 154 186 82 
Subject 11 183 186 98 
Subject 12 185 186 100 
Subject 13 185 186 100 
Subject 14 157 186 84 

The word recognition table indicates the word recognition scores for each subject. The 
investigator calculated the scores by dividing the number of words correct by the number 
of words. 



Questions: Individual Responses: (Subjects 1-7 Control Group and Subjects 8-14 
Testing Group) 

Table 5 
SUBJECTS Questiou 1 Questiou 2 Questiou 3 Question 4 Question 5 Question 6 
Subject 1 1 2 1 1 5 2 
Subject 2 5 5 5 1 5 1 
Subject 3 1 4 2 1 5 5 
Subject 4 1 5 5 1 5 2 
Subject 5 1 2 2 4 5 5 
Subject 6 1 5 2 5 1 5 
Subject 7 1 5 5 1 2 5 
Subject 8 1 5 4 2 5 5 
Subject 9 1 1 5 1 5 1 
Subject 10 1 2 4 2 5 2 
Subject 11 1 1 1 1 5 1 
Subject 12 1 2 1 1 5 1 
Subject 13 1 2 1 2 5 1 
Subject 14 1 5 5 5 5 5 
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This question table indicates the responses subjects' made after having the question read 
to them. The response scale ranges from 1 as being most positive to 5 as being most 
negative. 

Individual Performance: (Subjects 1-7 Control Group and Subjects 8-14 Testing Group) 

Table 6 
SUBJECTS SLIDE COMPLETED ERRORS ON HIGH WORD ACCURACY 

SUBJECTS SLIDES SLIDES RECOGNITION 
GOTTO SCORE 

Subject 1 5 4 3,4 &5 Yes No 
Subject 2 5 4 1,2,3,4 &5 No No 
Subject 3 5 4 2,3 &4 No No 
Subject 4 5 4 2,3,4 & 5 No No 
Subject 5 5 4 3,4&5 No No 
Subject 6 4 3 1&2 No No 
Subject 7 4 3 2,3 &4 No No 
Subject 8 4 3 None Yes Yes 
Subject 9 5 5 None Yes Yes 
Subject 10 3 2 1&2 No No 
Subject 11 4 4 Noue Yes Yes 
Subject 12 5 4 1,2 & 5 Yes No 
Subject 13 5 5 5 Yes No 
Subject 14 I 2 2 None No No 

This table shows how each subject did on the five-slide presentation tasks. 



Subjects' Timing: (Subjects 1-7 Control Group and Subjects 8-14 Testing Group) 

Table 7 
SUBJECTS Less than 50 50 MINUTES 

MINUTES 
Subject 1 Yes 
Subject 2 Yes 
Subject 3 Yes 
Subject 4 Yes 
Subject 5 Yes 
Subject 6 Yes 
Subject 7 Yes 
Subject 8 Yes 
Subject 9 Yes 
Subject 10 Yes 
Subject 11 Yes 
Subject 12 Yes 
Subject 13 Yes 
Subject 14 Yes 

The timing table indicates subjects' timing based on the fifty minutes allotted time to 
complete the five-slide presentation. 

Testing Factors 

The investigator organized the raw data into several factors to look for trends. 

Type of group errors: 

Control group 

Change title color 
Add logo 
Change font sizing 
Change background color 
Move picture 
Crop picture 
Typographic errors 
Add toolbar button 

Testing group 

Change title color 
Add logo 
Change font sizing 
Change background color 
Move picture 

Typographic errors 
Add toolbar button 
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Words the groups did not recognize: 

Control group 

Scheme 
Dimensional 
Electronic 
Affects 
Adjust 
Apart 
Automatically 
Dialog 
Presentation 
Options 
Default 

Testing group 

Scheme 
Dimensional 
Electronic 

Automatically 
Dialog 

Options 
Default 

Number of times subjects changed to a different cue word in the same task: 

43 19 

Number of incomplete slides: 

7 3 

Number of errors that depended on the word recognition tasks. 

5 2 

Number of times the groups looked at the help menu {repetition}. 

38 16 

Number of times the groups requested observer help {intervention}. 

23 12 
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Navigation problems - Only two subjects in the Testing group used the hypertext link in 

the help menu. Most ofthe subjects did not recognize a hypertext link. Overall, the 

subjects navigated the text linearly without problems. 

Frequency of non-recognized words: 

Control group 

11 non-recognized words 

Error types of incomplete slides: 

Cropping picture 
Typographic errors 
Moving picture 
Change background color 
Change title color 
Adding a toolbar 
Terminated testing 

Add toolbar button 
Font sizing 

Testing grOUP 

7 non-recognized words 

Typographic errors 

Change title color 
Adding a toolbar 
Terminated testing 
Adding logo 
Add toolbar button 
Font sizing 

What are the occurrences of each error between the groups? 

Typographic errors (5X) 
Cropping picture (6X) 
Moving picture (6X) 
Change background color (5X) 
Change title color (4X) 
Adding a toolbar (2X) 
Terminated testing (1 X) 

Add toolbar button (5) 
Font sizing (4X) 

(#X represents the number of times) 

Typographic errors (3X) 

Change background color (3X) 
Change title color (IX) 
Adding a toolbar (2x) 
Terminated testing (IX) 
Adding logo (IX) 
Add toolbar button (2X). 
Font sizing (2X) 



Number of occurrences on unrecognized words? 

Control group 

Scheme (2X) 

Dimensional (3X) 
Electronic (IX) 
Affects (IX) 
Adjust (IX) 
Apart (2X) 
Automatically (3X) 
Dialog (IX) 
Presentation (3X) 
Options (IX) 
Default (2X) 

Testing group 

Scheme (IX) 

Dimensional (IX) 
Electronic (2X) 

Automatically (IX) 
Dialog (2X) 

Options (IX) 
Default (I X) 
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The investigator used a sample of the normal user population to formulate the correlation 
against the control and testing groups. That member of the normal user population 
completed the same tasks under the same conditions as the control group. The following 
presents the results: 

Key: 

I=Most 
2=Second Most 
3=Least 
4=None 

Categories 
Group 

1) Used Online help Menu 
2) Add toolbar button error 
3) Change background color error 
4) Crop picture error 
5) Move picture error 
6) Change title color error 
7) Add logo error 
8) Font sizing error 
9) Least time to complete 

Sample Control Group Testing 

3 I 2 
3 I 2 
4 I 2 
3 2 4 
4 I 4 
3 I 2 
4 I 2 
4 I 2 
2 3 I 
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10) Typographic error 4 1 2 

Correlation Results: 

Groups Correlation Coeff. of Unbaised Stnrd error 
Determination coeff.! DET 

Sample + Cntd -0.753411 0.567627 0.567627 0.470735 
Sample + Test 0.301511 0.090909 0.090909 0.959403 
Test + Cntrl -0.156174 0.02439 0.02439 0.707107 

Findings 

The researcher used the information from the tables, graphs and the correlation results to 

determine the answer to the following hypotheses: 

H1: Subjects in the testing group will score higher on word recognition skills. 

H2 : Subjects in the testing group will complete tasks in less than fifty minutes. 

H3: Subjects in the testing group will complete tasks accurately as specified in chapter 

three (section 4a). 

For Hl, the researcher found that the testing group performed better at word recognition 

skills. Subjects in the testing group were subjects eight through fourteen. Therefore, the 

results supported H1• 
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results supported H1• 
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Based on the timing table, the result shows that two subjects in the testing group 

completed the tasks within the allotted time. Moreover, no one in the control group 

completed the tasks within the allotted time. Therefore, the data on timing supported H2 • 

Three subjects in the testing group performed the tasks accurately. None ofthe subjects 

in the control group performed the tasks accurately. Therefore, the data on accuracy 

supported H3 • 

The investigator also used the tables, graphs, and correlation data to determine the results 

for the subjective and objective questions. The question, did the proposed solution 

increase subjects' low word recognition skills, result was taken from the word recognition 

table and the individual response table. The data indicates that those subjects who 

received the solution scored higher on word recognition skills than subjects who did not 

receive the solution. Beyond this, more subjects in the testing group indicated that they 

understood the information in the help topics. 

For the objective question, how many correct answers, the investigator used the results 

from the word recognition table. The data shows that more than half ofthe subjects 

answered correctly. To answer the question, how long did it take to complete the test 

session, the investigator used the result from the timing table. The data indicates that two 

of the fourteen subjects finished the tasks in less than fifty minutes. 
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Summary 

The data analysis shows the results on completion, accuracy, word recognition skill, and 

timing of sUbjects. Subjects in the testing group appeared to have performed better at 

accuracy, word recognition and timing than the control group. 
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Chapter V 

Conclusions, Implications, Recommendations, and Summary 

Conclusions 

The study investigated a simple comparison procedure in a computer environment using 

college students with reading disabilities. The simple comparison procedure is an 

investigator-made cue word list of search words that subjects used to type in search words 

to find help topics. It was hypothesized that subjects in the testing group will score 

higher on word recognition skills, complete tasks within allotted time, and complete tasks 

accurately. The investigator tested the hypotheses using correlation analysis ofthe 

collected data. In conclusion, the data supported the hypotheses. 

This study includes some strength among subjects in both groups. Subjects in the current 

study showed great interest in their academic studies. They involved themselves in 

academic activities like tutoring, workshop, training, and counseling at least once a week 

to help them succeed in college. Those subjects have the support and financial backings 

of their parents or guardians. 
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Individuals with reading deficiencies problems are a prime weakness. They have 

weaknesses that prevent them from being successful in academics. These individuals 

experience problems with word recognition, decoding words, analyzing consonants and 

vowels, spelling sounds, and identifying printed words. These weaknesses playa role on 

their performance in a scholastic setting. 

Reading deficits involve limitations. These limitations include variables beyond the 

control ofthe subjects. The variables may result from undeveloped skills (Francis, 

Shaywitz, Stuebing, Shaywitz, & Fletcher, 1996). These variables consist of visual 

perceptual and memory problems. 

Implications 

This study impacts computer technology and computer applications for adults with 

learning deficits. The proposed solution in the current study influenced the way adult 

learners with learning problems perform word recognition tasks in a computer 

environment. This proposed solution requires the use of cue words to help subjects 

recognize words while reading help topics in a computer environment. 

The current study influences computer technology by the use of innovative 

instrumentation. Innovative learning tools like the proposed simple comparison 

procedure in the present study can provide better results for adult learners with reading 
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deficits. This study suggests that computer technology should provide those learners with 

necessary support needed to handle their academic deficits while in a computerized 

learning environment. The support should include procedures that focus on these 

individuals abilities. 

This study also affects computer application. The present study offers a flexible approach 

in completing word recognition tasks in a computer setting. It implies that the electronic 

environment should be adaptive for adult learners with reading deficits to achieve at word 

recognition tasks. This environment should provide cue words for the adult learners. 

Recommendations 

The researcher of the current study proposed several recommendations in academic and 

professional practices. The recommendations come from collective data relating to adult 

learners with reading difficulties and computers. These recommendations include 

adaptive procedures, flexible techniques, and more investigation with reading disabilities 

and computer technology. 

Academic practices for adults with reading deficits should incorporate adaptive 

procedures for accommodating the learners. These adaptive procedures are cue words, 

categories of words, and words that relate to the tasks. Those learners need cues that help 

them make associations. Because of memory and visual processing deficits, adult 



learners with reading difficulties must receive systematic assistance with word 

recognition tasks. 
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Professional practices in the area of computer technology and application should include 

techniques that are more flexible for adults with reading deficits. Flexibility may include 

categorizing and using patterns in words that share common attributes. These techniques 

should provide those adults with ways to succeed at word recognition tasks in computer 

environments. The environment should include a step-by-step simple comparison 

procedure like the one proposed in the current study. 

The researcher of the current study recommends more studies in the areas of reading 

deficits and computers. This research should include the following: 

• The use of spelling-to-sound decoding approach to word recognition in a computer 

environment with adults with reading disabilities. 

• The use of direct visual recognition approach to word recognition in a computer 

environment with adults with reading disabilities. 

• The effects of on-line wizard help on adults with reading deficiencies. 

Further research may help adult learners with reading deficits overcome their academic 

problems while working in electronic environments. Beyond this, further research may 

provide innovative approach in computer applications that attends to the needs of adults 

with reading difficulties. 
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Summary 

The researcher of the present study explored whether a simple comparison procedure on 

word recognition can increase word recognition skills in college students with reading 

disabilities. The researcher conducted the study within a computer environment to 

determine if the simple comparison procedure allows adult learners with reading 

difficulties to overcome their deficits in word recognition. 

Word recognition is achieved by using a decoding approach. Bos and Vaughn (1994) 

said that spelling-to-sound decoding and direct visual recognition helps students to 

recognize words. Fox (1996) and Leo (1994) indicated that cue word association helps 

students to recognize words. These word-decoding approaches are cited as effective 

techniques. 

College students with reading deficits display problems with word recognition. Those 

students in their college experience will need to read and comprehend text in computer 

• 
environments. Reading comprehension relies on the ability to recognize words. Since 

reading ability depends on word recognition, adult learners with reading difficulties must 

achieve at word recognition to succeed at academics. 



Individuals with reading deficits have problems with decoding, combining sounds, and 

spelling words. These problems prevent them from recognizing words in text. Many 

investigators offered assistance to word recognition skills. However, college students 

with reading deficits still have problems with word recognition. This word recognition 

problem is evident in different learning environments. The investigator of the current 

study proposed the use of an existing procedure with modification in a computer 

environment. The goal was to determine if such a procedure would produce positive 

outcomes. 
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In selecting the subjects for the current study, the investigator reviewed psychological 

records of clients at a private organization that assist college students with learning 

disabilities for the school year 1996-1997. The investigator selected subjects documented 

as having reading difficulties and had a sample size of fourteen. Participants of the study 

were between the ages of eighteen and thirty. They were both male and female with an 

social economic classification as middle class Caucasians. 

To group the subjects, the investigator placed subjects into two groups randomly. Each 

group consisted of seven participants. All the participants received the task of 

completing a five-slide presentation for a university curriculum using Microsoft® 

PowerPoint®. However, only subjects in the testing group received the treatment which 

was the investigator-made cue word list. 
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The significance ofthis study is to provide educational and technical professionals with 

infonnation they can use to assist adult learners with reading deficits. The current study 

provides these professionals with infonnation on the following: 

Types of errors that depend on word recognition. 

Frequency in change of cue words, repetition, and intervention. 

Navigation problems. 

Correlation data. 

Such infonnation may be included in software development. In addition, the current 

study can also provide college students with reading deficits with a solution to their 

academic problems. This solution, a simple comparison procedure, can give the 

professionals a way to help those college students find their own stimulus words. 

To quantify and measure the impact of this study, the researcher used SUbjective and 

objective questions approved by ranking methods. Beyond this, the investigator 

projected some outcomes and presented three hypotheses. The hypotheses were 

supported by the results. 



The investigator used tables and graphs to help present the results. The tables consisted 

of data taken from individual and group performances. Each graph provided an 

additional view of the related table. 

Based on the statistical findings, the following are the results: 

The testing group performed better at word recognition tasks than the control group. 

The testing group completed the tasks with more accuracy than the control group. 

Subjects in the testing group got more words correct than those in the control group. 

It took some subjects in the testing group less than fifty minutes to complete the tasks. 

The investigator of the current study recommends further studies relating to word 

recognition deficits and computers. Findings from the present study may stimulate 

further investigations. Beyond this, the findings may give other researchers a path to 

follow. 
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Appendix A 

Consent Form 

Dear Clients: 

As a candidate for a Ph.D. in computer education at Nova Southeastern University, I am 

required to conduct an independent research worthy of publication. I have chosen a 

learning disability population to complete this requirement. I will like your permission to 

participate as a subject in my study. This study involves completing a given computer 

task. 

If you consent to be a participant, please print and sign on the space provided below. 

Signature __________________________________________________________ __ 

Date ------------------



AppendixB 

Lab Test Format 

1. You are going to prepare slides for a University Curriculum 

using a simple presentation tool: PowerPoint. 

2. Preparation for test: Demonstrate a simple PowerPoint presentation using another 

subject. 

a. Show students icon buttons on lower left to review slides so they can review 

theirs after they have prepared their slides. 

Reducing learning curve: 

b. Show students wizard slide 

Explain: OK CANCEL NEWSLIDE 

C. Show students AutoLayout MENU: 

Explain panel in lower right of MENU that lists the selection in text. 

d. Show students the Help MENU template for FIND and how to type 

a search request. 

e. Show students the FIND template for CLIP-ART and where to type 

in search word. (words not related to test). 

f. Show students how to trim or move CLIP-ART. 

g. Show students how to exit presentation and save exercise. 

h. Mount a card in test space with list of courses and 

departments to enter as data to slides. 
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Departments 

Computer Science: 

Mathematics: 

Electrical Engineer: 

Statistics: 
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Appendix C 

List of Courses and Departments 

Courses 

Programming, Database, Operating Systems, Networks, & 
Software development methods 

Algebra, Pre-calculus, & Calculus 

Basic circuits, Digital circuits, Physics, Electric Motors, 
& Electronics 

Queuing theory, Mean-square methods, statistical 
computing, Time series prediction, & Resampling 
methods 



Appendix D 

Investigator-made Layout Sheet 

Testing begins with PowerPoint at new presentation screen. 

To begin: Create a new presentation. Please choose "Blank Presentation" 

Slide 1: From AutoLayout slide, choose the first slide "Title 
Slide" 

Type title: University Curriculum 
Use font: Wide Latin / Type size-44 
Type subtitle: General Requirements 
Use Font: Time New Roman / Type size-40 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics "Find" tab option. 

Slide 2: From AutoLayout slide, choose "Bulleted List" 
Type title: COMPUTER SCIENCE 
Use font: Algerian / Type size-54 
Add text: Five (5) courses 
Use font: Times New Roman / Type size-32 
Change background color to any color for this slide only. 
Ifnecessary, use Help Topics "Find" tab option. 

Slide 3: 
Type title: 
Use font: 
Add text: 
Use font: 
Insert Clipart: 

From AutoLayout slide, choose "Text & Clip Art" 
MATHEMATICS 
Algerian / Type size-SO 
Three (3) courses 
Times New Roman / Type size-32 
Under "Categories", choose "Signs". Select the 
description "Balance Truthful Scales". 

Crop or trim the top portion of the picture on this slide. 

If necessary, use Help Topics "Find" tab option 

Slide 4: 
Type title: 
Use font: 
Add text: 
Use font: 
Insert Clipart: 

From AutoLayout slide, choose "Text & Clip Art" 
ELECTRICAL ENGINEERING 
Algerian / Type size-60 
Four (4) courses 
Times New Roman / Type size-32 
Under "Categories", choose "Energy". 
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Select the description "Idea Brainstonn Light Bulb". 
Move the picture on this slide below the double "EE" in "ENGINEERING". 

Ifnecessary, use Help Topics "Find" tab option 

Slide 5: From AutoLayout slide, choose "Bulleted List" 
Type Title: STATISTICS 
Use font: Algerian / Type size-88 
Add text: Five (5) courses 
Use font: Times New Roman / Type size-32 
Change title color to any color for this slide only. 

Ifnecessary, use Help Topics "Find" tab option 

Can you solve the problem of having the logo appear in the upper left corner on all 
slides? 
Please insert a logo and have it appear in the upper left corner on all slides. 

Insert c1ipart: Select description: Professor Leadership 
Infonnat ... and Filename "Popular" as your logo. 

If necessary, use Help Topics "Find" tab option 

When you are finished, please save your presentation using your last name. 
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Appendix E 

Testing Group Tasks Before Reading Help Topics 

1) Select a word from the investigator-made cue word list that relates to what you are 

trying to do at this point. This is your sample word. 
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2) Choose two words from the cue word list that are in the same category as your sample 

word. These are your comparison words. 

3) Select one your comparison words. 

4) Use it in the "Find" tab option under "Microsoft PowerPoint Help Topics" to find 

"How to do" topics. 

5) Read the topics and select the one that has two or more of the word from the words 

you selected. 

6) Begin reading the selection in the help topic window line by line. 

7) Perform the tasks. 



Appendix F 

Investigator-made Cue Word List 

SLIDE 1: Adding the toolbar button that searches the active presentation for specified 
text. 

CUE WORDS 

toolbar buttons create add 

SLIDE 2: Changing background color to any color for this slide only. 

CUE WORDS 

change color color-scheme background 

SLIDE 3: Crop or trim the picture on this slide. 

CUE WORDS 

crop trim reSize object layout 

SLIDE 4: Move the picture on this slide below the double "EE" in "ENGINEERING." 

CUE WORDS 

align object drag position move 

SLIDE 5: Change title color to any color for this slide only. 

CUE WORDS 

title text coloring palette 

Adding a logo to all slides 
Can you solve the problem of having the logo appear in the same place on all slides? 

CUE WORDS 

logo items adding master 
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Appendix G 

Five-Slide Presentation 

Uni"V"ersi-ty 
Cu.rricu1-u.n:1. 

General Requirements 
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COMPUT t SCIENC I 

• Five (5) courses 

MATHEMATICS 
• Three (3) courses 



E ECTRICA 
ENGINEERING 

• Four (4) course 

STATISTICS 
Five (5) courses 
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Appendix H 

Questionnaire 

1. Did you read the same help topic more than once? 

2. Did you understand the organization ofthe information in the help topics? 

3. Did you use prior knowledge of any computer skills to help you? 

4. Did you ask yourself questions about what you were doing? 

5. Did you make notes or summarize the text before starting? 

6. Did you ask yourself questions to help you understand the instructions? 

The responses you give in this research report will remain anonymous and there will be 
no mention of your name. 
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Appendix I 

Word Recognition 

Words Points Words Points Words Points 
A Category Frame 
Add Change Freeform 
Adding Changing From 
Adjust Choose Gallery 
Affects Circles Graphic 
After Click Handle 
Again Clicking Handouts 
All Clip Have 
Already Color Insert 
Also Colors Install 
Although color-scheme Is 
An Crop Isn't 
And Cropping It 
Any Create Item 
Apart Default Just 
Appear Delete Letter 
Appears Deleted Later 
Application Designed Menu 
Apply Dialog Need 
As didn't New 
Assign Digital Note 
Area Dimensional Notes 
Arrow Dimming Objects 
Arrows Display Of 
Art Down Off 
Audience Drag On 
Automatically Dragging Options 
Autoshapes Draw Once 
Available Drawn One 
Background Drawing Or 
Balanced Drawings Other 
Basic During Over 
Become Each Pages 
Before Edit Paragraphs 
Bitmaps Effect Part 
Box Eight Permanently 
Boxes Electronic Placeholders 
Built-in Every Point 
But Example Portions 
Button File Position 
By Fill PowerPoint = 
Can Follow Presentation 
Can't For Presentation's 
Categories Format Provide 
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Quick Specify Wordart 
Readable Such You 
Recolored Text Your 
Rectangles Then You've 
Restore Time 
Return Tip 
Reveal Toolbar 
Rotating Tool 
Run Tools 
Save Triangles 
Scaled Trim 
Scanned Use 
Select Using 
Selected Up 
Set View 
Settings Want 
Setup Way 
Shapes Well 
Show What 
Six When 
Slanting Which 
Slide With 
Slides Word 

Investigator-made word-list of all the words appearing in Microsoft® PowerPoint®7.0 help topics "Add a 
toolbar button, change background color, crop, move an object or set of objects, change text color and add 
a logo." 
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Appendix J 

Accomplishment Form 

Checklist: 

Subject completed 0 slide Errors: YesD DNo 

Subject completed 1 to 2 slides Errors: YesD DNo 

Subject completed 3 to 4 slides Errors: YesD DNo 

Subject completed 5 slides Errors: YesD DNo 

Received high word recognition score: YesD DNo 

Accuracy I 



Appendix K 

Ranking Form 

Ranking system: 1 - Most positive 
3 - Neutral 
5 - Most negative 

2 - Somewhat positive 
4 - Somewhat negative 

___ Subject read the same help topic more than once. 

___ Subject showed sensitivity to organization of information in the text. 

___ Subject showed difficulty in using or activating prior knowledge. 

___ Subject employed self-questioning strategies to aid in attending to and 

comprehending text. 

___ Subject summarized text before starting a particular task. 

___ Subject self-monitored his or her comprehension. 
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Appendix L 

Recorded Responses 

Demonstration 

OBSERVER: (Note: This demonstration was repeated fourteen times for each subject) 

You are going to prepare a slide for a university curriculum using a simple 
presentation tool call PowerPoint. On the computer screen is PowerPoint. I Want you to 
click on blank presentation. This is the "Ok" button and this one is the "Cancel" button. 
Please slick on the Ok button for a blank presentation. The New Slide AutoLayout 
screen appears. Each AutoLayout slide has a name. At the lower right hand comer is the 
name. Please click on the second AutoLayout slide and the name changes. On the upper 
right hand comer is the Ok and Cancel button. Please click on the Ok button. To type in 
title, click where it says "Click to add title" and begin typing. To type in text, click 
where it says "Click to add text" and begin typing. 

I'll like to show you how to add a new slide. To do so, please click on the "New 
Slide" button on the bottom right hand comer of the screen. The "New Slide" 
AutoLayout screen appears. Please select the "Text & Clip art" AutoLayout slide and 
click the Ok button. 

I am going to show you how to add clip art. To do so, please double click on the 
area that says "Double click to add clip art." The clip art gallery screen appears. It has 
categories and pictures. Please click on the category "Academics" and select the picture 
with the description "Reward Accomplishment." Then, click the "Insert" button. I am 
going to show you how to crop or trim this clip art. To do so, please clip on the picture 
and go to the "Tools" menu. Then, select "Crop Picture." and the cropping tool appears. 
Please place the cropping tool over this resize handle. Please hold down the left mouse 
button and drag the cropping tool to about here. Then, release the mouse button. You 
have just crop or trim the top portion of this picture. 

I am going to show you how to use the help topic "Find" template. To do so, 
select the "Help" menu and click on the "Find" template. There are three sections to this 
template. The first section is where you are going to type in a search word or phase. For 
example, lets add a freeform drawing object. Please type in the word "freeform." In the 
second section, some matching words appeared. In the third section, topics appeared. 
Please read the topics and select the one that best fit adding a freeform object. 



Select the topic "Add a freefonn drawing object" and click on the "Display" button 
on you upper right hand corner. The "Adding a freefonn object" topic appears on the 
screen. Now, exit the help topic and return to the slide. To do so, click on the "X" on 
your far upper right hand corner. 
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I am going to show you how to review your slides. On your lower left hand corner are 
five icon buttons. These buttons are used to view slides as: Slide, Outline, Slide Sorter, 
Note Pages and Slide Show. 

The last things I am going to show you are how to exit and save a presentation. To do so, 
go to the "File" menu and select "Save" Here, where it says "Filename" ,use your last 
name. Then, on your upper right hand corner click on the "Save" button. 

Mounted on this display board is a card with list of courses and departments to enter as 
data to slides. From the new presentation window, please choose blank presentation. 
Select bulleted list from the AutoLayout screen and begin typing in the data. 

(Note: The researcher presents the next fourteen responses collectively; however, each subject were tested 
individually.) 

SUBJECT 1: 
"Okay." 
SUBJECT 2: 
"Finished." 
SUBJECT 3: 
"Okay." 
SUBJECT 4: 
"What is next." 
SUBJECT 5: 
"Okay." 
SUBJECT 6: 
"Okay." 
SUBJECT 7: 
"Okay." 
SUBJECT 8: 
"Finished." 
SUBJECT 9: 
"Done." 
SUBJECT 10: 
"Okay." 
SUBJECT 11: 
"Finished." 
SUBJECT 12: 
"Okay." 
SUBJECT 13: 
"Okay." 
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SUBJECT 14: 
"Okay. " 

OBSERVER: 
"Save your presentation. Please go to the file menu and select save. You are going to use 
your last name as your filename." 

Control Group Testing 

OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes. 

Subject 1 
SUBJECT 1: 
"To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Should requirements be capitalized." 

OBSERVER: 
"Yes." 

SUBJECT 1: 
"Use Font Time New Roman. Type size forty. Add the toolbar button that searches the 
active presentation for specified text. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 1: 
"Find a help topic that tell me how to add the tool bar button." 

OBSERVER: 
"What word are you typing in?" 

SUBJECT 1: 
Add. Add a custom color scheme as a standard scheme or, add a freeform, add a guide, 
add a line, add a rectangle, add an arc, add an auto shape, add an ellipse, add an 



d f 'C'. • b' 111 embosse e .lect to a PowerPomt 0 ~ect, add an entry to the auto Correct list, add art to 
the clip art gallery, add or change a fill, add or change a header or footer on notes pages 
or handouts, add or change a patterned fill, add or change a patterned slide background, 
add or change a shaded fill, add or change a shaded slide background, add or change a 
slide background picture, add or change a text shadow or text embossed effect, add or 
change a textured fill, add or change a textured slide background add or change the date, 
time, slide number, or footer text, add or delete a toolbar button. This one says, add or 
delete a toolbar button. I'll try this one. 

OBSERVER: 
"Okay, read out aloud." 

SUBJECT 1: 
Add or delete a toolbar button.. One, display the toolbar you want to change, and then 
click Customize on the Tools menu. Two, to add a button, click the name of the category 
in the Categories box, and then drag the button from the Buttons area to a toolbar. To 
delete a button, drag it off the toolbar. Tip, when you delete a built-in toolbar button 
from a toolbar, the button is still available in the Customize dialog box. However, when 
you delete a custom toolbar button, it is permanently deleted. To delete a custom toolbar 
button from a toolbar but save it for later use, create a toolbar for storing unused buttons, 
move the button to this storage toolbar, and then hide the storage toolbar. Okay, how do I 
get off the here. 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 1: 
"No ." 

OBSERVER: 
"Okay." 

SUBJECT 1: 
"Do I go to help?" 

OBSERVER: 
"Yes." 

SUBJECT 1: 
Okay, display the toolbar you want to change, and then click Customize on the Tools 
menu. To add a button, click the name of the category in the Categories box, and then 
drag the button from the Buttons area to a toolbar. To delete a button, drag it offthe 
toolbar. Tip, when you delete a built-in toolbar button from a toolbar, the button is still 
available in the Customize dialog box. However, when you delete a custom toolbar 
button, it is permanently deleted. To delete a custom toolbar button from a toolbar but 



save it for later use, create a toolbar for storing unused buttons, move the button to this 
storage toolbar, and then hide the storage toolbar. Okay, how do I get off the here. 

OBSERVER: 
"What are you thinking?" 

SUBJECT 1: 
"I am trying to think which one I should pick." 

OBSERVER: 
"What does the layout sheet say?" 

SUBJECT 1: 
"Add the toolbar button that searches the active presentation for specified text. 
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If necessary, use Help Topics Find tab option. So, should I pick the animation text. No. 
Sort to category, view, find new, arc shape, tools. This one. I don't know what to do." 

OBSERVER: 
"Do you want to go back to the help topic?" 

SUBJECT 1: 
"Yes, One, display the toolbar you want to change, and then click Customize on the 
Tools menu. Two, to add a button, click the name ofthe category in the Categories box, 
and then drag the button from the Buttons area to a toolbar. To delete a button, drag it off 
the toolbar. Am going to close this window. Select "Tools" from the toolbar menu, then 
"Customize. Categories: File, Edit, View, Insert, Format, Tool. Buttons. I don't know 
what to do." 

OBSERVER: 
"What are you doing?" 

SUBJECT 1: 
"Am going to the help topic add." 

OBSEVER: 
"Okay." 

SUBJECT 1: 
"One, display the toolbar you want to change, and then click Customize on the Tools 

menu. I've done that. Two, to add a button, click the name of the category in the 
Categories box, and then drag the button from the Buttons area to a toolbar. Okay, I'll 
close this window. I'll try it again. Am Selecting "Tools" from the toolbar menu, then 
"Customize. Categories: File, buttons" 

OBSERVER: 
"Do you know which button searches the active presentation for specified text?" 
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SUBJECT 1: 
"No." 

OBSERVER: 
"Click on a category then the buttons and read the description for each." 

SUBJECT 1: 
Okay, Category, "File." Creates a new presentation base on the blank presentation 
template. Open an existing presentation. Saves the active presentation using current 
settings. Sends the active presentation through electronic mail. Adds or changes the 
electronic mail routing slip of the active presentation. Next category," Edit". Copies the 
selection to the clipboard and removes the selection. Copies the selection to the 
clipboard. Inserts the clipboard contents. Copies the formatting of the selection to 
another object. Reverse the last change. Reverse the last undo. Repeats the last change. 
Creates a copy of the selection. Searches the active presentation for specified text. This 
one. Where do I drag it. 

OBSERVER: 
"On any toolbar." 

SUBJECT 1: 
Slide two, from AutoLayout slide, choose "Bulleted List." Type title, COMPUTER 
SCIENCE. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. 
Use font, Times New Roman. Type size thirty two. Change background color to any 
color for this slide only. Ifnecessary, use Help Topics Find tab option. Change 
background color." 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 1: 
"No." 
OBSERVER: 
"What are going to do?" 

SUBJECT 1: 
"Change the background color. 

OBSERVER: 
"What does this part of the layout sheet reads?" 

SUBJECT 1: 
"If necessary, use Help Topics Find tab option." 



114 

OBSERVER: 
"Go ahead and use help." 

SUBJECT 1: 
"Okay." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 1: 
"Change the background color on this slide only." 

OBSERVER: 
"What word are you going to type in?" 

SUBJECT 1: 
"Color." 

OBSERVER: 
"Are you reading?" 

SUBJECT 1: 
"Yes." 

OBSERVER: 
"What is it you are reading?" 

SUBJECT 1: 
"The part that says "Click a topic then click display." 

OBSERVER: 
"Please read out aloud." 

SUBJECT 1: 
Accent colors, Add a custom color scheme as a standard scheme, add an embossed effect 
to a PowerPoint object, add or change a fill, add or change a patterned fill, add or change 
a shaded fill. Add or change a textured fill, add other colors from imported art to drop­
down color palettes" "Where is background color?" "Add, change, or remove a bullet, 
add, change, or remove a text shadow or embossing, add, change, or remove an object 
shadow, adding a logo, adding other colors to drop-down color palettes, applying the 
color scheme of one slide to another, arcs, attribute, background color. Here it is. 

OBSERVER: 
"Okay." 
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SUBJECT 1: 
"Background color. The underlying color of a PowerPoint slide. The background color 
on a slide is similar to the canvas for a painting. Ifthe background color (the canvas) is 
white, for instance, you can paint any other color on top of it, but the underlying color 
remains white. Everywhere you don't add paint, the white shows. I don't think this is 
what I want." 

OBSERVER: 
"Okay, you didn't find anything in the help topic. What are you going to do?" 

SUBJECT 1: 
I am going to help and type color. Background color, change background color. "No." 
Coloring. ''No''. Colors. Accent color, add or change a fill, add other colors from 
imported art to drop-down color palettes, adding a logo, adding other colors to drop­
down color palettes, change a fill color, change a slide background color. Am going to 
select this one. Change a slide background color. When you change a slide's background 
color, you can use one ofthe eight coordinated color-scheme colors or you can use a 
color that isn't part of the current color scheme. If you use a color-scheme color and then 
later change your presentation's color scheme, the background color changes to 
coordinate with the new color scheme. If you choose a color that's not part of the current 
color scheme"Jhe color stays the same even if you change the color scheme. 
If you've already changed a slide's background color, you can also return it to the color 
scheme's default background color. When you change the background, you can apply it to 
the current slide by clicking "Apply", or to all the slides and the slide master by clicking 
"Apply To All." What do you want to do? Change the slide background to a color 
scheme color. Change the slide background to a color other than a color scheme color 
Change to the default slide background. Am going to select "Change the slide 
background to a color scheme color. Change the slide background to a color scheme 
color 
One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click the color you want. 

OBSERVER: 
"Did that topic help." 

SUBJECT 1: 
No. In the format menu click slide color-scheme then click change color. There it goes. 
I am going to click on the "X" button on the help topic screen. Next instruction on the 
sheet. Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, 
mathematics. Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. Ifnecessary, use Help Topics Find tab option 

OBSERVER: 
"What are you doing?" 
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SUBJECT 1: 
"I am trying to see if! can crop the picture. "Crop the top portion of the picture." I can't 
seem to make my picture look like this one on the display board." 

OBSERVER: 
"What are you going to do?" 

SUBJECT: 
"I am going to use help and type crop." 

OBSERVER: 
"What word search word did you type?" 

SUBJECT 1: 
"Crop." "Bitmap, crop, crop or trim off portions of a picture. I am selecting this one. 
Crop Picture command (Tools menu). To trim or restore portions of a picture, click Crop 
Picture, position the cropping tool over a resize handle, and then drag to crop the picture. 

OBSERVER: 
"What are you doing?" 

SUBJECT 1: 
I am closing this window. Oh, I don't remember what to do. I have to go back to the 
help menu. I am typing in crop and clicking "Okay." No, that's not what I want. I'll go 
back to the help topics. I am typing in crop then am selecting "Crop or trim off portions 
of a picture." To trim or restore portions of a picture, click Crop Picture, position the 
cropping tool over a resize handle, and then drag to crop the picture. 

OBSERVER: 
"What are you going to do?" 

SUBJECT1: 
"I want to take the top part ofthis picture off." 

OBSERVER: 
"How do you do that? What does the help topic tells you?" 

SUBJECT 1: 
"Just click the picture and position the cropping tool over the resize handle then drag to 
crop the picture. I go to tool menu then click crop picture and I put it over to resize 
handle. I didn't do anything. I'll go back to the tool menu and select crop picture. I am 
putting the cropping tool over the resize handle and hold down the mouse button to drag 
the picture. 



117 
OBSERVER: 
"Okay. Read the next instruction on the layout sheet." 

SUBJECT 1: 
Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, electrical 
engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) courses. Use 
font, Times New Roman. Type size thirty two. Okay. Insert Clip art, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb". 
Move the picture on this slide below the double "EE" in "Engineering". Ifnecessary, use 
Help Topics Find tab option. Okay. OOPS, I almost got it. There it goes. 

OBSERVER: 
"Okay, go to the next instruction." 

SUBJECT 1: 
"Slide five, from AutoLayout slide, choose "Bulleted List". Type title, statistics. 
Use font, Algerian. Type size eighty eight. Type subtitle, five (5) courses. Use font, 
Times New Roman. Type size thirty two. Change title color to any color for this slide 
only. Ifnecessary, use Help Topics Find tab option." "I am trying to find out where I 
can change color. I'll go to help." 

OBSERVER: 
"What word are you typing?" 

SUBJECT 1: 
Color. I am looking for the topic. Change a slide background color. Change a slide 
background color. When you change a slide's background color, you can use one of the 
eight coordinated color-scheme colors or you can use a color that isn't part of the current 
color scheme. If you use a color-scheme color and then later change your presentation's 
color scheme, the background color changes to coordinate with the new color scheme. If 
you choose a color that's not part of the current color scheme, the color stays the same 
even if you change the color scheme. If you've already changed a slide's background 
color, you can also return it to the color scheme's default background color. When you 
change the background, you can apply it to the current slide by clicking Apply, or to all 
the slides and the slide master by clicking Apply To All. 

OBSERVER: 
"Is that what you want." 

SUBJECT 1: 
"I want to change title color. I am going back to help. I am typing the word title. I: want 
this topic." 

OBSERVER: 
"What is that? Read it?" 
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SUBJECT 1: 
"No. I don't what this." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 1: 
"Change title color." 

OBSERVER: 
"Where are you going?" 

SUBJECT 1: 
"To the Find tab option." 

OBSERVER: 
"What word are you typing?" 

SUBJECT 1: 
"Color. Under color, custom color-scheme." 

OBSERVER: 
"Do you want to do that?" 

SUBJECT 1: 
No, change text color,. No, I don't want to do that." 

OBSERVER: 
"What is it you want to change?" 

SUBJECT 1: 
"The color ofthe title." 

OBSERVER: 
"Is a title a text or a picture?" 

SUBJECT 1: 
It's a text. I'll type text in. I am looking for change text color. Here it is. Change text 
color. When you change text color, you can use one of the eight coordinated color­
scheme coiors, or you can use a color that isn't part of the color scheme. If you use a 
color-scheme color and then later change your presentation's color scheme, the text color 
changes to coordinate with the new color scheme. If you choose a color that's not part of 
the current color scheme, the text color stays the same even if you change color schemes. 
If you change text color, you can also return text color to the color scheme's default text 
color. What do you want to do? Change text to a color scheme color. Change text to a 
color other than a color scheme color. Change text to the default text color. I am 



selecting "Change text to a color scheme color." One, in slide or notes view, select the 
text you want to change. Two, on the Format menu, click Font. Three, on the Color 
drop-down list, click your choice in the color palette." Okay, next instruction from the 
sheet. 

OBSERVER: 
"Okay." 

SUBJECT 1: 
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"Can you solve the problem of having the logo appear in the upper left corner on all 
slides? Please insert a logo and have it appear in the upper left corner on all slides. 
Insert clip art, select description, Professor Leadership Informat and filename "Popular" 
as your logo. Ifnecessary, use Help Topics Find tab option. When you are finished, 
please save your presentation using your last name." 

OBSERVER: 
"Do you know how to insert a logo?" 

SUBJECT 1: 
"No." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 1: 
"Go to help." 

OBSEVER: 
"What are you typing?" 

SUBJECT 1: 
"I made a mistake." 

OBSERVER: 
"Okay. What did you type?" 
SUBJECT 1: 
"I typed two I's for logo." 

OBSERVER: 
"Okay." 

SUBJECT 1: 
Adding a logo. It's easy to add your logo to a presentation using scanned or digital art. 
Or you can create what you need using clip art, WordArt, and the PowerPoint tools. To 
have a logo appear on every slide in your presentation, insert it on the slide master. 



Before you import a digital file or a scanned version of your logo, you may want to 
adjust the colors and contrast in an application that lets you edit bitmaps. 
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You can use clip art images to create a logo in your presentation and then use PowerPoint 
commands to change an image's fill and line color, take it apart, even combine it with 
other clip-art images, drawings, and text. If you didn't install the ClipArt Gallery with 
PowerPoint, just run PowerPoint Setup again. You can draw a logo, or add drawn art as a 
frame for your logo, for example, using the PowerPoint tools. To create composite 
shapes, use the AutoShapes tools and the Freeform drawing tool. Or you might try using 
WordArt to add special text effects to your logo or to your company name by slanting, 
rotating, or curving text. 

OBSERVER: 
"What are you doing?" 

SUBJECT 1: 
"I am reading the instruction on the sheet." 

OBSERVER: 
"Read out aloud, please." 

SUBJECT 1: 
"Can you solve the problem of having the logo appear in the upper left comer on all 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
Insert clip art, select description, Professor Leadership Informat and filename "Popular" 
as your logo. Ifnecessary, use Help Topics Find tab option. When you are finished, 
please save your presentation using your last name." 

OBSERVER: 
"Okay." 

SUBJECT 1: 
"I am going back to help topic and type in add a logo." 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 1: 
"Yes, but I have already read this. I want an embedded object inserted on my slide." 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 1: 
Adding a logo. It's easy to add your logo to a presentation using scanned or digital art. 
Or you can create what you need using clip art, WordArt, and the PowerPoint tools. To 
have a logo appear on every slide in your presentation, insert it on the slide master. 



Before you import a digital file or a scanned version of your logo, you may want to 
adjust the colors and contrast in an application that lets you edit bitmaps. 
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You can use clip art images to create a logo in your presentation and then use PowerPoint 
commands to change an image's fill and line color, take it apart, even combine it with 
other clip-art images, drawings, and text. If you didn't install the ClipArt Gallery with 
PowerPoint, just run PowerPoint Setup again. You can draw a logo, or add drawn art as a 
frame for your logo, for example, using the PowerPoint tools. To create composite 
shapes, use the AutoShapes tools and the Freeform drawing tool. Or you might try using 
WordArt to add special text effects to your logo or to your company name by slanting, 
rotating, or curving text. I am trying to insert a logo. 

OBSERVER: 
"What did you do?" 

SUBJECT 1: 
"I don't remember." 

OBSERVER: 
"Do you want to use help topic again." 

SUBJECT1: 
"Yes." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 1: 
"I am trying to find out how to insert a logo. I am go to help topics and type in adding a 
logo." 

OBSERVER: 
"What are the topics?" 

SUBJECT 1: 
"Adding a logo." 
OBSERVER: 
"Is that what you are trying to do?" 

SUBJECT 1: 
"I am trying to insert a logo." 

OBSERVER: 
"Is there a difference?' 

SUBJECT 1: 
"I am typing in insert, but there are no topics." 



OBSERVER: 
"Okay." 

SUBJECT 1: 
"Adding a logo. I already red this." 

OBSERVER: 
"Did it help you." 

SUBJECT 1: 
"No." 

OBSERVER: 
" Okay, What is it that you read? What's the topic?" 

SUBJECT 1: 
"Adding a logo." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 1: 
"Am thinking I can't understand what to do." 

OBSERVER: 
"After you did what?" 

SUBJECT 1: 
"After I type in adding a logo.: 

OBSERVER: 
"What do you think?" 

SUBJECT 1: 
"Am stuck. Help, find, logo. No, that still takes me back there. 

OBSERVER: 
"Is that what you want to do." 

SUBJECT 1: 
"No. I want to inset a logo and have it appear in the upper left hand corner. Adding a 
logo. Background item. That's no help." 

OBSERVER: 
"Relax, do you want to stop?" 
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OBSERVER: 
"Okay." 

SUBJECT 1: 
"Adding a logo. I already red this." 

OBSERVER: 
"Did it help you." 

SUBJECT 1: 
"No." 

OBSERVER: 
" Okay, What is it that you read? What's the topic?" 

SUBJECT 1: 
"Adding a logo." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 1: 
"Am thinking I can't understand what to do." 

OBSERVER: 
"After you did what?" 

SUBJECT 1: 
"After I type in adding a logo.: 

OBSERVER: 
"What do you think?" 

SUBJECT 1: 
"Am stuck. Help, find, logo. No, that still takes me back there. 

OBSERVER: 
"Is that what you want to do." 

SUBJECT 1: 
"No. I want to inset a logo and have it appear in the upper left hand comer. Adding a 
logo. Background item. That's no help." 

OBSERVER: 
"Relax, do you want to stop?" 
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SUBJECT 1: 
"Am getting frustrated." 

OBSERVER: 
"Okay, Do you want to stop here?" 

SUBJECT 1: 
"Yes." 

OBSERVER: 
"Okay, I am going to ask you six questions. I will read the questions to you and I want 
you to answer them out aloud. Number one, did you read the same help topic more than 
once? 

SUBJECT 1: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 1: 
''No.'' 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 1: 
"Yes, double click and drag. 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 1: 
"Yes." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 1: 
"No." 

OBSERVER: 
''Number six, did you ask yourself questions to help you understand the instructions?" 
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SUBJECT 1: 
"A little, somewhat." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 2 
OBSERVER 
"Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes." 

SUBJECT 2: 
"To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements" Okay." 

OBSERVER: "Go ahead." 

SUBJECT 2: 
"Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 2: 
"Find tab option. Is that it? Button. Add or delete toolbar button." 

OBSERVER: 
"Read out aloud?" 

SUBJECT 2: 
Display the toolbar you want to change, and then click Customize on the Tools menu. 
To add a button, click the name ofthe category in the Categories box, and then drag the 
button from the Buttons area to a toolbar. To delete a button, drag it off the toolbar. 
Tip When you delete a built-in toolbar button from a toolbar, the button is still available 
in the Customize dialog box. However, when you delete a custom toolbar button, it is 
permanently deleted. To delete a custom toolbar button from a toolbar but save it for later 



use, create a toolbar for storing unused buttons, move the button to this storage 
toolbar, and then hide the storage toolbar. How to do this? I don't know. 

OBSERVER: 
"Okay, move on. Close the help window." 

SUBJECT 2: 
"Okay, slide two." 

OBSERVER: 
"How do you go to slide two." 

SUBJECT 2: 
"I am clicking on "New Slide" button." 
"Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. 
Use font, Times New Roman. Type size thirty two. Change background color to any 
color for this slide only. Ifnecessary, use Help Topics Find tab option. Change 
background color." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 2: 
"Find the tab option, but you got to use the help topics." 

OBSERVER: 
"What do you need help to do?" 

SUBJECT 2: 
"Find tab option." 

OBSERVER: 
"What is the instruction?" 

SUBJECT 2: 
"Change background." 

OBSERVER: 
"What are you typing in as your search word." 

SUBJECT 2: 
"Color. Am looking for background color'." 

OBSERVER: 
"Did you find it?" 
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SUBJECT 2: 
"No. Just nothing." 

OBSERVER: 
"What are you typing in?" 

SUBJECT 2: 
"Color. Add or change a fill" 

OBSERVER: 
"Did find any topics?" 

SUBJECT 2: 
"Yes, I found background color. The underlying color of a PowerPoint slide. The 
background color on a slide is similar to the canvas for a painting. If the background 
color (the canvas) is white, for instance, you can paint any other color on top of it, but the 
underlying color remains white. Everywhere you don't add paint, the white shows." 

OBSERVER: 
"Okay." 

SUBJECT 2: 
"No, Don't know. I guess I'll move on to the third slide." 

OBSERVER: 
"Okay." 

SUBJECT 2: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. Ifnecessary, use Help Topics Find tab option 

OBSERVER: 
"Okay?" 

SUBJECT 2: 
"Crop or trim. That I don't know how to do. I don't know. So, am just going to new 
slide." 

OBSERVER: 
"If you need help, use Help Topics Find tab option. So, what are you going to do?" 
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SUBJECT 2: 
"Go to help." 

OBSERVER: 
"What are you typing?" 

SUBJECT 2: 
"Crop." "Crop or trim off portions of a picture. To trim or restore portions of a picture, 
click Crop Picture, position the cropping tool over a resize handle, and then drag to crop 
the picture. Which I don't know what to do. So, am going on to the next slide." 

OBSERVER: 
"Okay." 

SUBJECT 2: 
Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, electrical 
engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) courses. Use 
font, Times New Roman. Type size thirty two. Okay. Insert Clipart, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb". 
Move the picture on this slide below the double "EE" in "Engineering". Ifnecessary, use 
Help Topics Find tab option. I am going to the help topic and type in picture moving or 
something Moving. I don't know. Moving from slide to slide in a slide show. I guess. 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 2: 
I am trying to move the picture on this slide below the double "EE" in engineering." 

OBSERVER: 
"What does it say on the screen?" 

SUBJECT 2: 
"Moving from slide to slide in a slide show. That's not it. Am just going to cancel and 
go on to a new slide. I have no idea how to do that." 

OBSERVER: 
"Okay." 

SUBJECT 2: 
"Slide five, from AutoLayout slide, choose "Bulleted List". Type title, statistics. 
Use font, Algerian. Type size eighty eight. Type subtitle, five (5) courses. Use font, 
Times New Roman. Type size thirty two. Change title color to any color for this slide 
only. Ifnecessary, use Help Topics Find tab option." "I am going for help." 



OBSERVER: 
"Okay" 

SUBJECT 2: 
"Change title color for this slide only. So, am going to type change title color." 

OBSERVER: 
"Read out aloud." 

SUBJECT 2: 
"Click a topic then click display. I can't find anything. So, am just going to get out of 
here." 

OBSERVER: 
"Okay." 

SUBJECT 2: 
"Can you solve the problem of having the logo appear in the upper left corner on all 
slides? Please insert a logo and have it appear in the upper left corner on all slides. 
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Insert clip art, select description, "Professor Leadership Informat" and filename 
"Popular" as your logo. Ifnecessary, use Help Topics Find tab option. Am just not going 
to do that. When you are finished, please save your presentation using your last name." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 2: 
"Am reading this. Can you solve the problem of having the logo appear in the upper left 
corner on all slides? Please insert a logo and have it appear in the upper left corner on all 
slides. Insert clip art, select description, "Professor Leadership Informat" and filename 
"Popular" as your logo. Ifnecessary, use Help Topics Find tab option. Am going to type 
in insert." 

OBSERVER: 
"Please read out aloud." 

SUBJECT 2: 
It's easy to add your logo to a presentation using scanned or digital art. Or you can create 
what you need using clip art, WordArt, and the PowerPoint tools. To have a logo appear 
on every slide in your presentation, insert it on the slide master. 
Before you import a digital file or a scanned version of your logo, you may want to adjust 
the colors and contrast in an application that lets you edit bitmaps. 
You can use clip art images to create a logo in your presentation and then use PowerPoint 
commands to change an image's fill and line color, take it apart, even combine it with 
other clip-art images, drawings, and text. If you didn't install the ClipArt Gallery with 
PowerPoint, just run PowerPoint Setup again. You can draw a logo, or add drawn art as a 
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frame for your logo, for example, using the PowerPoint tools. To create composite 
shapes, use the AutoShapes tools and the Freeform drawing tool. Or you might try using 
WordArt to add special text effects to your logo or to your company name by slanting, 
rotating, or curving text. This I don't understand. So, am getting out of here. Can you 
solve the problem of having the logo appear in the upper left comer on all slides? Please 
insert a logo and have it appear in the upper left comer on all slides. Insert c1ipart, select 
description, "Professor Leadership Informat" and filename "Popular" as your logo. If 
necessary, use Help Topics Find tab option. 

OBSEVER: 
"What are you thinking?" 

SUBJECT 2: 
"I don't know how to do this." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 2: 
"Get out of here." 

OBSERVER: 
"Did you finished everything on the layout sheet?" 

SUBJECT 2: 
" When you are finished, please save presentation using your last name." 

OBSERVER: 
"Go ahead and save your presentation. Okay, I am going to ask you six questions. I will 
read the questions to you and I want you to answer them out aloud. Number one, did you 
read the same help topic more than once?" 

SUBJECT 2: 
"No." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 2: 
"No." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 
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frame for your logo, for example, using the PowerPoint tools. To create composite 
shapes, use the AutoShapes tools and the Freeform drawing tool. Or you might try using 
WordArt to add special text effects to your logo or to your company name by slanting, 
rotating, or curving text. This I don't understand. So, am getting out of here. Can you 
solve the problem of having the logo appear in the upper left comer on all slides? Please 
insert a logo and have it appear in the upper left comer on all slides. Insert c1ipart, select 
description, "Professor Leadership Informat" and filename "Popular" as your logo. If 
necessary, use Help Topics Find tab option. 

OBSEVER: 
"What are you thinking?" 

SUBJECT 2: 
"I don't know how to do this." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 2: 
"Get out of here." 

OBSERVER: 
"Did you finished everything on the layout sheet?" 

SUBJECT 2: 
"When you are finished, please save presentation using your last name." 

OBSERVER: 
"Go ahead and save your presentation. Okay, I am going to ask you six questions. I will 
read the questions to you and I want you to answer them out aloud. Number one, did you 
read the same help topic more than once?" 

SUBJECT 2: 
"No." 

OBSERVER: 
"Number two, did you understand the organization ofthe information in the help topics?" 

SUBJECT 2: 
"No." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 
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SUBJECT 2: 
"Yes, I did." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 2: 
"Yes." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 2: 
''No.'' 

OBSERVER: 
''Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 2: 
"Yes." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 3 
OBSERVER 
"Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes." 

SUBJECT 3: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. I am going to the help topic. 

OBSERVER: 
"Type in a search word to help you." 



SUBJECT 3: 
"I don't know of any." 

OBSERVER: 
"Move on." 

SUBJECT 3: 
"Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. 
Use font, Times New Roman. Type size thirty two. Change background color to any 
color for this slide only. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 3: 
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Change background color to any color for this slide only. Ifnecessary, use Help Topics 
Find tab option. I am going to type in color. Accent colors. Colors that are applied to 
secondary features on a slide. Accent colors are available on all of the color menus along 
with the main colors from your scheme. These colors are also used in charts. I don't 
know. I'll type color. Change background color to any color for this slide only. Am 
trying to figure out what am doing. I am very confused. Change the background color to 
any color on this slide only. In slide view, on the format menu click custom background. 
Under the background fill click the down arrow and then click other color. 

OBSERVER: 
"Okay. Good" 

SUBJECT 3: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion ofthe picture on this slide. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it ;you are trying to doT' 

SUBJECT 3: 
"Am trying to cut it down." 

OBSERVER: 
"Okay, go ahead and crop the picture." 
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SUBJECT 3: 
"Am going to the help menu. Trim or restore portion of a picture. Crop picture. Position 
the cropping tool over the resize handle and then drag to crop picture. Okay, let me get 
out of here." 

OBSERVER: 
"Okay." 

SUBJECT 3: 
Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, electrical 
engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) courses. Use 
font, Times New Roman. Type size thirty two. Okay. Insert Clipart, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb". 
Move the picture on this slide below the double "EE" in "Engineering". Ifnecessary, use 
Help Topics Find tab option. I don't know what to do. Move the picture on this slide 
below the double "EE" in "Engineering. 

OBSERVER: 
"What is it ;you want to do?" 

SUBJECT 3: 
I want to put the picture right here. Now it moves." 

OBSERVER: 
"Okay." 

SUBJECT 3: 
"Slide five, from AutoLayout slide, choose "Bulleted List". Type title, statistics. 
Use font, Algerian. Type size eighty eight. Type subtitle, five (5) courses. Use font, 
Times New Roman. Type size thirty two. Change title color to any color for this slide 
only. Ifnecessary, use Help Topics Find tab option. I am going for help." 

OBSERVER: 
"What are you typing?" 

SUBJECT 3: 
"I am typing in color. No, I got to get out of here." 

OBSERVER: 
"Okay." 

SUBJECT 3 
Accent colors, add a custom color scheme as a standard scheme add an embossed effect 
to a PowerPoint object, add or change a fill, add or change a patterned fill, add or change 
a shaded fill, add or change a textured fill. One, in slide view, click the object you want 
to change. Two, Click. Three, on the Fill Color drop-down, click SUBJECT 3: 
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"It's easy to add your logo to a presentation using scanned or digital art. Or you can 
create what you need using clip art, WordArt, and the PowerPoint tools. To have a logo 
appear on every slide in your presentation, insert it on the slide master. 
Before you import a digital file or a scanned version of your logo, you may want to adjust 
the colors and contrast in an application that lets you edit bitmaps. 
You can use clip art images to create a logo in your presentation and then use PowerPoint 
commands to change an image's fill and line color, take it apart, even combine it with 
other clip-art images, drawings, and text. If you didn't install the ClipArt Gallery with 
PowerPoint, just run PowerPoint Setup again. You can draw a logo, or add drawn art as a 
frame for your logo, for example, using the PowerPoint tools. To create composite 
shapes, use the AutoShapes tools and the Freeform drawing tool. Or you might try using 
WordArt to add special text effects to your logo or to your company name by slanting, 
rotating, or curving text. This I don't understand. So, am getting out of here. Can you 
solve the problem of having the logo appear in the upper left comer on all slides? Please 
insert a logo and have it appear in the upper left comer on all slides. Insert clip art, select 
description, "Professor Leadership Informat" and filename "Popular" as your logo. If 
necessary, use Help Topics Find tab option. 

OBSEVER: 
"What are you thinking?" 

SUBJECT 3: 
"I don't know how to do this." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 3: 
"Get out of here." 

OBSERVER: 
"Did you finished everything on the layout sheet?" 

SUBJECT 3: 
"When you are finished, please save presentation using your last name." 

OBSERVER: 
Textured. Four, select the texture you want. The sheet says to change the title color for 
this slide only. One, in slide view, click the object you want to change. Two, Click. 
Three, on the Fill Color drop-down, click Textured. Four, select the texture you want. I 
did this. On the fill color choose drop-down. Which one is that one? On the fill color 
texture choose drop-down. I don't know what is texture? 



OBSERVER: 
"Okay, move on." 

SUBJECT 3: 
"Change the title color to any color for this slide only. Color. Accent colors, add a 
custom color scheme as a standard scheme add an embossed effect to a PowerPoint 
object. I just read all this. Move on, next thing to do." 

OBSERVER: 
"Okay." 

SUBJECT 3: 
Can you solve the problem of having the logo appear in the upper left comer on all 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
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Insert clip art, select description, "Professor Leadership Informat" and filename 
"Popular" as your logo. Ifnecessary, use Help Topics Find tab option. Am just not going 
to do that. When you are finished, please save your presentation using your last name. I 
don't know what to do. I am stuck. I am confused. It says can you solve the problem of 
having the logo appear in the upper left comer on all slides? 

OBSERVER: 
"Okay, your time is up. Go ahead and save your presentation. I am going to ask you six 
questions. I will read the questions to you and I want you to answer them out aloud. 
Number one, did you read the same help topic more than once?" 

SUBJECT 3: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 3: 
"Confusing, somewhat." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 3: 
"Yes, I know how to use file and save." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 3: 
"Yes." 
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OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 3: 
"No." 

OBSERVER: 
''Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 3: 
"Yes." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 4 
OBSERVER 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes. 

SUBJECT 4: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics Find tab option. What do I do? 

OBSERVER: 
"Do exactly what is on the layout sheet?" 

SUBJECT 4: 
"Add the toolbar." 

OBSERVER: 
"If you don't know what to do, where are you going to get help?" 

SUBJECT 4: 
"Right here." 
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OBSERVER: 
"What does it say?" 

SUBJECT 4: 
"Add toolbar." 

OBSERVER: 
"What are you typing?" 

SUBJECT 4: 
Am typing the word toolbar. Add a freefonn, add a line, add a rectangle, add an arc, add 
an AutoShape, add an ellipse, add or delete a toolbar button. This one. Display the 
toolbar you want to change, and then click Customize on the Tools menu. To add a 
button, click the name of the category in the Categories box, and then drag the button 
from the Buttons area to a toolbar. To delete a button, drag it off the toolbar. Tip. 
When you delete a built-in toolbar button from a toolbar, the button is still available in 
the Customize dialog box. However, when you delete a custom toolbar button, it is 
pennanently deleted. To delete a custom toolbar button from a toolbar but save it for later 
use, create a toolbar for storing unused buttons, move the button to this storage toolbar, 
and then hide the storage toolbar. So, what am I going to do? 

OBSERVER: 
"That is the help topic . What is it you want to do?" 

SUBJECT 4: 
"Add a toolbar." 

OBSERVER: 
"Did you find any topic that tells you how to add a toolbar?" 

SUBJECT 4: 
"Am not sure what to do here?" 

OBSERVER: 
"The help topic tells you." 

SUBJECT 4: 
"Click customize on the tool menu. 

OBSERVER: 
"What are you thinking after reading that? 

SUBJECT 4: 
"Customize," 



OBSERVER: 
"What is the next step?" 

SUBJECT 4: 
"To add a button. Click the name of a category on the category box and then drag the 
button on a tool bar area." 

OBSERVER: 
"Okay." 

SUBJECT 4 : 
What is it am looking for?" 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 4: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What does it say on the screen?" 

SUBJECT 4: 
"Open an existing presentation 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 4: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you want to try something else? 

SUBJECT 4: 
"Am not sure what am doing here." 

OBSERVER: 
"Okay." 

SUBJECT 4: 
"Am stuck. Stuck." 

OBSERVER: 
"Do you want to move on?" 
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SUBJECT 4: 
"Yes. " 

OBSERVER: 
"Close this window and move on to the next instruction on the layout sheet." 

SUBJECT 4: 
"Okay, am clicking on ' 'New Slide" button. Slide two, from AutoLayout slide, choose 
"Bulleted List." Type title, computer science. Use font, Algerian. Type size fifty fOUf. 
Type subtitle, Five courses. Use font, Times New Roman. Type size thirty two. Change 
background color to any color for this slide only. If necessary, use Help Topics Find tab 
option. How do I do that?" 

OBSERVER: 
"If you don't know what to do, where do you go for help?" 

SUBJECT 4: 
"At the help menu. Change background color to any color for this slide only." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 4: 
Change background color. Add or change a file. Change a slide background color. 
When you change a slide's background color, you can use one of the eight coordinated 
color-scheme colors or you can use a color that isn't part ofthe current color scheme. If 
you use a color-scheme color and then later change your presentation's color scheme, the 
background color changes to coordinate with the new color scheme. If you choose a color 
that's not part of the current color scheme, the color stays the same even if you change the 
color scheme. If you've already changed a slide's background color, you can also return it 
to the color scheme's default background color. When you change the background, you 
can apply it to the current slide by clicking Apply, or to all the slides and the slide master 
by clicking Apply To All. What do you want to do? Change the slide background to a 
color scheme color. Change the slide background to a color other than a color scheme 
color. Change to the default slide background. I am going to change the slide 
background color to a color-scheme color. One, in slide view, on the Format menu, click 
Custom Background. Two, under Background Fill, click the down arrow, and then click 
the color you want. 

OBSERVER: 
"What are you doing?" 

SUBJECT 4: 
"Where is color background? Oh, wait a minute." 



OBSERVER: 
"What are you looking for?" 

SUBJECT 4: 
"Custom background." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 4: 
"Looking for the down-arrow and change the color. Apply to all." 

OBSERVER: 
"What are you doing?" 

SUBJECT 4: 
"Selecting a new slide." 

OBSERVER: 
"Okay." 

SUBJECT 4: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
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Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion ofthe picture on this slide. If necessary, use Help Topics Find tab option. What 
do you mean crop or trim this picture? I don't understand. What do I do? 

OBSERVER: 
"If you don't understand go to help" 

SUBJECT 4: 
"Okay. I need to type in crop. What is the next thing I do?" 

OBSERVER: 
"What are you reading?" 

SUBJECT 4: 
"Crop or trim. To trim or restore portions of a picture, click Crop Picture, position the 
cropping tool over a resize handle, and then drag to crop the picture." 

OBSERVER: 
"Can you do that?" 
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SUBJECT 4: 
"To trim or restore portions of a picture, click Crop Picture, position the cropping tool 
over a resize handle, and then drag to crop the picture. What am I suppose to do? I don't 
understand." 

OBSERVER: 
"Do you want to give it a try or do you want to move on?" 

SUBJECT 4: 
"Move on." 

OBSERVER: 
"Okay. What is the next instruction on the layout sheet?" 

SUBJECT 4: 
Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, electrical 
engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) courses. Use 
font, Times New Roman. Type size thirty two. Okay. Insert Clipart, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb". 
Move the picture on this slide below the double "EE" in "Engineering". If necessary, use 
Help Topics Find tab option. Okay. Let's see. All right its moving now. Now, slide 
fi ve. New slide. 

OBSERVER: 
"Okay." 

SUBJECT 4: 
"Slide five, from AutoLayout slide, choose "Bulleted List". Type title, statistics. 
Use font, Algerian. Type size eighty eight. Type subtitle, five (5) courses. Use font, 
Times New Roman. Type size thirty two. Change title color to any color for this slide 
only. If necessary, use Help Topics Find tab option. I am going for help." 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 4: 
"No," 

OBSERVER: 
"Please go to the help menu." 

SUBJECT 4: 
"Okay." 
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OBSERVER: 
"What are you typing in?" 

SUBJECT 4: 
"Change title color." 

OBSERVER: 
"Okay." 

SUBJECT 4: 
"Create my own design template. Create my own presentation template with suggested 
content. Make a slide that differs form the slide master." 

OBSERVER: 
"Does any of these options says change title color?" 

SUBJECT 4: 
"No. I don't understand. Could you please explain. 

OBSERVER: 
"Do you want to type in another word? Maybe one word." 

SUBJECT 4: 
"Am typing change. Add or change a fill, add or change a header or footer on notes 
pages or handouts, add or change a patterned fill, add or change a patterned slide 
background, add or change a shaded fill, add or change a shaded slide background, add or 
change a shaded slide background, add or change a slide background picture. I don't 
know what am doing." 

OBSERVER: 
"Okay. Is title a picture or a text." 

SUBJECT 4: 
"A picture. No. A text." 

OBSERVER: 
"Go ahead and read the topic options on the screen." 

SUBJECT 4: 
"I still don't get it." 

OBSERVER: 
"Do you see a topic that says change text color?" 
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SUBJECT 4: 
"Let's see. Oh, change a textured fill. One, in slide view, click the object you want to 
change. Two, click. Three, on the Fill Color drop-down, click Textured. Four, select the 
texture you want." 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 4: 
"Yes." 

OBSERVER: 
"What is it you want to do 7" 

SUBJECT 4: 
"Change title color." 

OBSERVER: 
"Does this tell you how to change a title color?" 

SUBJECT 4: 
"No." 

OBSERVER: 
"Do you want to go on and try something else or move on?" 

SUBJECT 4: 
"Let's move on," 

OBSERVER: 
"Okay. Close this window." 

SUBJECT 4: 
"Can you solve the problem of having the logo appear in the upper left comer on all 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
Insert clip art, select description, "Professor Leadership Informat" and filename 
"Popular" as your logo. Ifnecessary, use Help Topics Find tab option. No, I can't." 

OBSERVER: 
"Do you want to try?" 

SUBJECT 4: 
"No. " 

OBSERVER: 
"Okay. If you were to try it what word would you type in?" 



SUBJECT 4: 
"Professor Leadership." 

OBSERVER: 
"What does it say here?" 

SUBJECT 4: 
"Can you solve the problem of having the logo appear in the upper left comer on all 
slides?" 

OBSERVER: 
"What word would you type in?" 

SUBJECT 4: 
"Logo." 
OBSERVER: 
"If you were to type in logo, you will get instructions for adding a logo." 

SUBJECT 4: 
"Where do I type logo?" 

OBSERVER: 
"Under the Find tap option in help." 

SUBJECT 4: 
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Okay. It's easy to add your logo to a presentation using scanned or digital art. Or you can 
create what you need using clip art, WordArt, and the PowerPoint tools. To have a logo 
appear on every slide in your presentation, insert it on the slide master. 
Before you import a digital file or a scanned version of your logo, you may want to adjust 
the colors and contrast in an application that lets you edit bitmaps. You can use clip art 
images to create a logo in your presentation and then use PowerPoint commands to 
change an image's fill and line color, take it apart, even combine it with other clip-art 
images, drawings, and text. If you didn't install the ClipArt Gallery with PowerPoint, just 
run PowerPoint Setup again. You can draw a logo, or add drawn art as a frame for your 
logo, for example, using the PowerPoint tools. To create composite shapes, use the 
AutoShapes tools and the Freeform drawing tool. Or you might try using WordArt to add 
special text effects to your logo or to your company name by slanting, rotating, or 
curving text. I have no idea. 

OBSERVER: 
"What is it you are supposed to do?" 

SUBJECT 4: 
Add a logo and have it appear on the upper left hand comer." 
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OBSERVER: 
"Do you want to give it a try?" 

SUBJECT 4: 
"No," 

OBSERVER: 
"What does it say here?" 

SUBJECT 4: 
"When you are finished save your presentation using your last name." 

OBSERVER: 
"Go ahead and save your presentation." 

SUBJECT 4: 
"Okay." 

OBSERVER: 
"I am going to ask you six questions. I will read the questions to you and I want you to 
answer them out aloud. Number one, did you read the same help topic more than once?" 

SUBJECT 4: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 4: 
"No. " 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 4: 
"No. " 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 4: 
"Yes." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 
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SUBJECT 4: 
''No.'' 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 4: 
"Yes, I tried." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 5 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes. 

SUBJECT 5: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics Find tab option. What do I do? 
OBSERVER: 
"What is it you are going to do?" 

SUBJECT 5: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"If you don't know what to do, please use help?" 

SUBJECT 5: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What word will you type in to get help on adding a toolbar button?" 
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SUBJECT 5: 
"Toolbar. " 

OBSERVER: 
"Okay." 

SUBJECT 5: 
Create a custom toolbar. One, on the View menu, click Toolbars. Two, click New. 
Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the Make 
Toolbar Available To box, click the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new toolbar. Seven, under Buttons, drag the button or 
other item to the new toolbar I don't know what am doing. 

OBSERVER: 
"What does it say here?" 

SUBJECT 5: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Can you follow the instruction on the screen?" 

SUBJECT 5: 
I'll try. Create a custom toolbar. One, on the View menu, click Toolbars. Two, click 
New. Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the 
Make Toolbar Available To box, click the template where you want to store the toolbar. 
Five, click OK. Six, in the Categories box, click the category that contains the command 
or other item you want to add to the new toolbar. Seven, under Buttons, drag the button 
or other item to the new toolbar. I don't know what am doing. 

OBSERVER: 
"What are you doing?" 

SUBJECT 5: 
"It says type in a name for a new toolbar. What am I typing in?" 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 5: 
"Add a toolbar button. Am going to type in active presentation. I don't know what to 
do." 

OBSERVER: 
"Okay. Move on. Close these windows." 
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SUBJECT 5: 
"Okay. Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 5: 
"I want to change color. So, am going to help. Am going to type in background color." 

OBSERVER: 
"Okay." 

SUBJECT 5: 
Change background color. Add or change a file. Change a slide background color. 
When you change a slide's background color, you can use one of the eight coordinated 
color-scheme colors or you can use a color that isn't part of the current color scheme. If 
you use a color-scheme color and then later change your presentation's color scheme, the 
background color changes to coordinate with the new color scheme. If you choose a color 
that's not part of the current color scheme, the color stays the same even if you change the 
color scheme. If you've already changed a slide's background color, you can also return it 
to the color scheme's default background color. When you change the background, you 
can apply it to the current slide by clicking Apply, or to all the slides and the slide master 
by clicking Apply To All. What do you want to do? Change the slide background to a 
color scheme color. Change the slide background to a color other than a color scheme 
color. Change to the default slide background. I think I want to change the background 
to a color other than the color-scheme color. So, that is what am going to do. One, in 
slide view, on the Format menu, click Custom Background. Two, under Background Fill, 
click the down arrow, and then click other color. Then click the color you want. Okay. 
That looks cool. 

OBSERVER: 
"Okay." 

SUBJECT 5: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. If necessary, use Help Topics Find tab option. 

OBSERVER: 
"Do you know which part of the picture you are going to crop?" 
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SUBJECT 5: 
"No." 

OBSERVER: 
"Look at the display board." 

SUBJECT 5: 
"Okay. Am going to crop the top" 

OBSERVER: 
"Do you know how to crop?" 

SUBJECT 5: 
"No. Am going to the help menu and type the word crop." 

OBSERVER: 
"What topic options did you get?" 

SUBJECT 5: 
"Bitmap, crop, crop or trim off portions of a picture. This one. To trim or restore 
portions of a picture, click Crop Picture, position the cropping tool over a resize handle, 
and then drag to crop the picture." 

OBSERVER: 
"Are you reading?" 

SUBJECT 5: 
"Yes, am reading again." 

OBSERVER: 
"Please read out aloud." 

SUBJECT 5: 
"To trim or restore portions of a picture, click Crop Picture, position the cropping tool 
over a resize handle, and then drag to crop the picture." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 5: 
"Am looking for the cropping tool. Where is the cropping tool?" 

OBSERVER: 
"Do you see tools on the menu bar?" 
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SUBJECT 5: 
"Yes, now am looking for crop picture. Here it is. Okay I did it." 

OBSERVER: 
"What is the next thing you are going to do?" 

SUBJECT 5: 
Am going to a new slide. Slide four, from AutoLayout slide, choose "Text & Clip Art". 
Type title, electrical engineering. Use font, Algerian. Type size sixty. Type subtitle, 
Four (4) courses. Use font, Times New Roman. Type size thirty two. Okay. Insert 
Clipart, under "Categories", choose "Energy." Select the description "Idea Brainstorm 
Light Bulb". Move the picture on this slide below the double "EE" in "Engineering". If 
necessary, use Help Topics Find tab option. 

OBSERVER: 
"Do you know how to move the picture? " 

SUBJECT 5: 
"Yes. Am going to move it right here." 

OBSERVER: 
"Okay. Go ahead." 

SUBJECT 5: 
"This looks closer." 

OBSERVER: 
"Did you used the help topic?" 

SUBJECT 5: 
"No, I figured it out." 

OBSERVER: 
"Okay." 

SUBJECT 5: 
Let's see. Slide five. Am going to a new slide. Slide five, from AutoLayout slide, 
choose "Bulleted List". Type title, statistics. Use font, Algerian. Type size eighty eight. 
Type subtitle, five (5) courses. Use font, Times New Roman. Type size thirty two. 
Change title color to any color for this slide only. If necessary, use Help Topics Find tab 
option. I am going to do what I did the last time. No. Am not sure. 

OBSERVER: 
"What are you going to do?" 
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SUBJECT 5: 
"Go to the help menu and type in color. Accent colors, add a custom color scheme as a 
standard scheme, add an embossed effect to a PowerPoint object, add or change a fill Am 
going to choose when giving a slide show." 

OBSERVER: 
"What you want to do?" 

SUBJECT 5: 
"Change title color, but I don't see that." 

OBSERVER: 
"Is a title a picture or a text?" 

SUBJECT 5: 
"Oh, its a text. Am selecting change text to a color scheme color. One, in slide or notes 
view, select the text you want to change. Two, on the Fonnat menu, click Font. Three, 
on the Color drop-down list, click your choice in the color palette. Am going to fonnat 
and choose font then am choosing a color." 

OBSERVER: 
"What happened?" 

SUBJECT 5: 
"I don't know." 

OBSERVER: 
"What are you doing?" 

SUBJECT 5: 
" Am reading this." 

OBSERVER: 
"Read out aloud." 

SUBJECT 5: 
"Change text to a color scheme color. One, in slide or notes view, select the text you 
want to change. Two, on the Fonnat menu, click Font. Three, on the Color drop-down 
list, click your choice in the color palette. Am going to fonnat and choose font then am 
choosing a color." 

OBSERVER: 
"Okay." 

SUBJECT 5: 
"Am not sure what I did wrong. It did nothing." 



OBSERVER: 
"What do you want to doT' 

SUBJECT 5: 
"I don't know how to do it?" 

OBSERVER: 
"Okay" 

SUBJECT 5: 
"Am going to try it again." 

OBSERVER: 
"Okay your time is up. Please save your presentation. I am going to ask you six 
questions. I will read the questions to you and I want you to answer them out aloud. 
Number one, did you read the same help topic more than once?" 

SUBJECT 5: 
"Yes. " 

OBSERVER: 
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"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 5: 
"Yes." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 5: 
"No," 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 5: 
"Yes. Like: What is this? I never seen this before?" 

OBSERVER: 
' 'Number five, did you make notes or summarize the text before starting?" 

SUBJECT 5: 
''No.'' 
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OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 5: 
"Yes, mentally." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 6 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes. 

SUBJECT 6: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 6: 
"Add a toolbar button that searches the active presentation for specified text. You are to 
use help. So, I go to help." 

OBSERVER: 
"Okay." 

SUBJECT 6: 
"I want to add a tool bar button. After typing in toolbar button, The topics are: Add a 
free form, add a line, add a rectangle add an arc, add an AutoShape, add an ellipse, add or 
delete a toolbar button, create custom toolbar. What I'll like to do is add a toolbar button 
that searches the active presentation for specified text." 
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OBSERVER: 
"What are you selecting?" 

SUBJECT 6: 
Create a custom toolbar. One, on the View menu, click Toolbars. Two, click New. 
Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the Make 
Toolbar Available To box, click the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new toolbar. Seven, under Buttons, drag the button or 
other item to the new toolbar. This is the instruction to create a custom toolbar. 

OBSERVER: 
"What are you going to do?" 

SUBJECT 6: 
"Under view menu, click toolbars." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 6: 
"Am looking for toolbar to click on. Add the toolbar button that searches the active 
presentation for specified text. Am going back to help and type toolbar." 

OBSERVER: 
"What are the options?" 

SUBJECT 6: 
"Add a freeform, add a line, add a rectangle, add an arc, add an AutoShape, add an 
ellipse, add or delete a toolbar button. Which is what we want." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 6: 
"Reading." 

OBSERVER: 
"Please read out aloud." 

SUBJECT 6: 
Add or delete a toolbar button. One, display the toolbar you want to change, and then 
click Customize on the Tools menu. Two, to add a button, click the name ofthe category 
in the Categories box, and then drag the button from the Buttons area to a toolbar. 
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To delete a button, drag it off the toolbar. Tip. When you delete a built-in toolbar 
button from a toolbar, the button is still available in the Customize dialog box. However, 
when you delete a custom toolbar button, it is permanently deleted. To delete a custom 
toolbar button from a toolbar but save it for later use, create a toolbar for storing unused 
buttons, move the button to this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What are you thinking?" 

SUBJECT 6: 
"Am trying to find out where the toolbar is and click customize in the tools menu. Here 
is the tools menu." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 6: 
Trying to find the toolbar. Am going to help once again and type in add toolbar button." 

OBSERVER: 
"Okay." 

SUBJECT 6: 
"Add a freeform, add a line, add a rectangle, add an are, add an AutoShape, add an 
ellipse, add or delete a toolbar button." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 6: 
"Which one to select. Am trying to find out where they have the toolbar." 

OBSERVER: 
"What are you doing?" 

SUBJECT 6: 
"Am reading these." 

OBSERVER: 
"Please, read out aloud." 

SUBJECT 6: 
"Are, line, rectangle, freeform. I believe this is the toolbar because in help it had all of 
these tool. 
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OBSERVER: 
"What does the help instruction tells you to do?" 

SUBJECT 6: 
Once again, am going to help and type add toolbar button. Add or delete a toolbar button. 
One, display the toolbar you want to change, and then click Customize on the Tools 
menu. Two, to add a button, click the name of the category in the Categories box, and 
then drag the button from the Buttons area to a toolbar. 
To delete a button, drag it offthe toolbar. Tip. When you delete a built-in toolbar button 
from a toolbar, the button is still available in the Customize dialog box. However, when 
you delete a custom toolbar button, it is permanently deleted. To delete a custom toolbar 
button from a toolbar but save it for later use, create a toolbar for storing unused buttons, 
move the button to this storage toolbar, and then hide the storage toolbar." Okay, let's try 
this. 

OBSERVER: 
"What are you looking for?" 

SUBJECT 6: 
"Which category that has the button that searches the active presentation for specified 
text. Categories: File, Edit, View, Insert, Format, Tool." 

OBSERVER: 
"Read the description here after you click on the buttons." 

SUBJECT 6: 
Category, "File." Creates a new presentation base on the blank presentation template. 
Open an existing presentation. Saves the active presentation using current settings. 
Sends the active presentation through electronic mail. Adds or changes the electronic 
mail routing slip of the active presentation. Next category," Edit". Copies the selection 
to the clipboard and removes the selection. Copies the selection to the clipboard. Inserts 
the clipboard contents. Copies the formatting of the selection to another object. Reverse 
the last change. Reverse the last undo. Repeats the last change. Creates a copy of the 
selection. Searches the active presentation for specified text. This one is it. Am going to 
add it to tools. Am dragging it on tools. 

OBSERVER: 
"What are you doing now?" 

SUBJECT 6: 
"Am dragging it again because it didn't work the first time. Now it works." 

OBSERVER: 
"Okay, what is the next instruction on the layout sheet?" 
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SUBJECT 6: 
" Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 6: 
"It says to change background color. Am going to help and type change background 
color." 

OBSERVER: 
"Did you find any topic." 
SUBJECT 6: 
"No." 

OBSERVER: 
"Why? Is background spelled correctly?" 

SUBJECT 6: 
"No, I have to change that." 

OBSERVER: 
"Do you see any topic options?" 

SUBJECT 6: 
"Yes. A few. Add or change a fill, background color, change a slide background color." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 6: 
Change background color to any color for this slide only. Am selecting change a slide 
background color. Add or change a file. Change a slide background color. 
When you change a slide's background color, you can use one ofthe eight coordinated 
color-scheme colors or you can use a color that isn't part of the current color scheme. If 
you use a color-scheme color and then later change your presentation's color scheme, the 
background color changes to coordinate with the new color scheme. If you choose a color 
that's not part of the current color scheme, the color stays the same even if you change the 
color scheme. If you've already changed a slide's background color, you can also return it 
to the color scheme's default background color. When you change the background, you 
can apply it to the current slide by clicking Apply, or to all the slides and the slide master 
by clicking Apply To All. What do you want to do? Change the slide background to a 



color scheme color. Change the slide background to a color other than a color scheme 
color. Change to the default slide background. 

OBSERVER: 
"What are you reading now?" 

SUBJECT 6: 
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The layout sheet. Change background color to any color for this slide only. Am going to 
select the option that says change the background color other than a color-scheme color. 
One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click other color. Then click the color 
you want. Okay, I am going to try this. Format menu. Custom background. Fill, Down­
arrow and click the color I want. Am going to choose apply. 

OBSERVER: 
"Okay." 

SUBJECT 6: 
"Am going to the next slide." 

OBSERVER: 
"Okay." 

SUBJECT 6: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. If necessary, use Help Topics Find tab option. Am 
going to help and type crop. Am choosing crop or trim a portion of a picture. Bitmap, 
crop, crop or trim off portions of a picture. To trim or restore portions of a picture, click 
Crop Picture, position the cropping tool over a resize handle, and then drag to crop the 
picture. Am looking at the display board to see how the picture should look. 

OBSERVER: 
"Please read this instruction." 

SUBJECT 6: 
"Crop or trim the top portion of the picture. Am going to rim the top off." 

OBSERVER: 
"What is the instruction in the help topic for cropping a picture?" 
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SUBJECT 6: 
"Am going back to help and type crop. Crop or trim the top portion of a picture. To trim 
or restore portions of a picture, click Crop Picture, position the cropping tool over a 
resize handle, and then drag to crop the picture." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 6: 
"How to cut the top of the picture off." 

OBSERVER: 
"Your time is up. Please save your presentation. I am going to ask you six questions. I 
will read the questions to you and I want you to answer them out aloud. Number one, did 
you read the same help topic more than once?" 

SUBJECT 6: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 6: 
"No, totally." 

OBSERVER: 
''Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 6: 
"Yes, a bit." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 6: 
"No." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 6: 
"Yes, mental notes." 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 
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SUBJECT 6: 
"No," 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 7 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. You have fifty minutes. 

SUBJECT 7: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
"What are you thinking?" 

SUBJECT 7: 
"How to find the toolbar button." 

OBSERVER: 
"Go to help if you need to." 

SUBJECT 7: 
"Okay." 

OBSERVER: 
"What is it you are tying to do?" 

SUBJECT 7: 
"Add a tool bar button that searches the active presentation for specified text." 
"Am going to help and type find." 

OBSERVER: 
"What is it you want to do?" 



160 

SUBJECT 7: 
Add a toolbar button that searches the active presentation for specified text." I am going 
to type toolbar. Add a freefonn, add a line, add a rectangle add an arc, add an 
AutoShape, add an ellipse, add or delete a toolbar button, create custom toolbar. 
Create a custom toolbar. One, on the View menu, click Toolbars. Two, click New. 
Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the Make 
Toolbar Available To box, click the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new tool bar. Seven, under Buttons, drag the button or 
other item to the new toolbar. This is the instruction to create a custom toolbar. 

OBSERVER: 
"Okay. You found the toolbar topic and you have closed out the help window. What is it 
you are going to do now?" 

SUBJECT 7: 
"Add a button, click a category box. Am clicking on a category." 

OBSERVER: 
"What are you reading?" 

SUBJECT 7: 
"The descriptions." 

OBSERVER: 
"Read out aloud." 

SUBJECT 7: 
Category, "File." Creates a new presentation base on the blank presentation template. 
Open an existing presentation. Saves the active presentation using current settings. 
Sends the active presentation through electronic mail. Adds or changes the electronic 
mail routing slip ofthe active presentation. Next category," Edit". Copies the selection 
to the clipboard and removes the selection. Copies the selection to the clipboard. Inserts 
the clipboard contents. Copies the fonnatting ofthe selection to another object. Reverse 
the last change. Reverse the last undo. Repeats the last change. Creates a copy of the 
selection. Searches the active presentation for specified text. I found it. Am going to 
add it to tools. Am dragging it on tools. 

OBSERVER: 
"You are going to following the instructions in the help topic." 

SUBJECT 7: 
"Yes, drag it on a toolbar." 
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OBSERVER: 
"Okay." 

SUBJECT 7: 
"Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. Ifnecessary, use Help Topics Find tab option." Am going to help and choose 
accent color." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 7: 
"Change background color to any color on this slide only." 

OBSERVER: 
"What are you going to type in?" 

SUBJECT 7: 
"Background." 

OBSERVER: 
"Okay." 

SUBJECT 7: 
"Add or change a fill, add or change apattemed slide background, add or change a shaded 
slide background, add or change a slide background picture, add or change a textured 
slide background, background color. Am going to choose." 

OBSERVER: 
"What are you trying to do? " 

SUBJECT 7: 
"Change background color. Am going to choose accent. Colors that are applied to 
secondary features on a slide. Accent colors are available on all of the color menus along 
with the main colors from your scheme. These colors are also used in charts." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 7: 
"Change background color." 

OBSERVER: 
"Do you know what to do?" 
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SUBJECT?: 
No. Am going back to help and type color. No, background color. Change a slide 
background color. When you change a slide's background color, you can use one of the 
eight coordinated color-scheme colors or you can use a color that isn't part ofthe current 
color scheme. If you use a color-scheme color and then later change your presentation's 
color scheme, the background color changes to coordinate with the new color scheme. If 
you choose a color that's not part ofthe current color scheme, the color stays the same 
even if you change the color scheme. If you've already changed a slide's background 
color, you can also return it to the color scheme's default background color. When you 
change the background, you can apply it to the current slide by clicking Apply, or to all 
the slides and the slide master by clicking Apply To All. What do you want to do? 
Change the slide background to a color scheme color. Change the slide background to a 
color other than a color scheme color. Change to the default slide background. Am going 
to choose change the slide background color to a color-scheme color. One, in slide view, 
on the Format menu, click Custom Background. Two, under Background Fill, click the 
down arrow, and then click other color. Then click the color you want. Okay, I am going 
to try this. Format menu. Custom background. Fill , Down-arrow and click the color I 
want. Am going to choose apply. 

OBSERVER: 
"After reading the instruction, do you know what to do?" 

SUBJECT?: 
"One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click other color. Then click the color 
you want. Okay, I am going to try this. Format menu. Custom background. Fill, Down­
arrow and click the color I want. Am going to choose apply. Okay. Am clicking on 
Format. Customize. Down-arrow. Choose a color. Okay." 

OBSERVER: 
"What are you doing now?" 

SUBJECT?: 
"Choosing a new slide." 

OBSERVER: 
"Okay." 

SUBJECT?: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses. 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
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portion of the picture on this slide. Ifnecessary, use Help Topics Find tab option. Am 
going to help and type crop. 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 7: 
"Yes. " 

OBSERVER: 
"If you don't know go to help." 

SUBJECT 7: 
"Am going back to help." 

OBSERVER: 
"What are you reading?" 

SUBJECT 7: 
Crop or trim the top portion of a picture. Am going to type trim and click on crop or trim 
picture. To trim or restore portions of a picture, click Crop Picture, position the cropping 
tool over a resize handle, and then drag to crop the picture. Am going to drag it. No. To 
trim or restore portions of a picture, click Crop Picture, position the cropping tool over a 
resize handle, and then drag to crop the picture. Now, am going to try it again. It didn't 
work. To trim or restore portions of a picture, click Crop Picture, position the cropping 
tool over a resize handle, and then drag to crop the picture. Okay. Let's see. No, it 
didn't work. Am going to type in crop. To trim or restore portions of a picture, click 
Crop Picture, position the cropping tool over a resize handle, and then drag to crop the 
picture. 

OBSERVER: 
"What are you looking for?" 

SUBJECT 7: 
"Crop picture." 

OBSERVER: 
"Did you click on any of these toolbar menu?" 

SUBJECT 7: 
"No, not yet. I found it under Tools and am putting it on the resize handle." 

OBSERVER: 
"What happened?" 
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SUBJECT 7: 
"I lost my cropping tool. Let's try it again." 

OBSERVER: 
"Do you know where the resize handle is?" 

SUBJECT 7: 
"No, am trying it again." 

OBSERVER: 
" What happened." 

SUBJECT 7: 
"It keeps going down the page." 

OBSERVER: 
"What are you reading?" 

SUBJECT 7: 
"Crop or trim the top portion of this picture. It's not working." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 7: 
"Crop or trim the top portion of this picture." 

OBSERVER: 
"Okay." 

SUBJECT 7: 
"It is getting smaller." 

OBSERVER: 
"What are you going to do 7" 

SUBJECT 7: 
"I don't know." 

OBSERVER: 
"Do you want to move on?" 

SUBJECT 7: 
"Am getting frustrated. Yes." 
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OBSERVER: 
"Okay, please read the next instruction on the layout sheet." 

SUBJECT 7: 
Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, electrical 
engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) courses. Use 
font, Times New Roman. Type size thirty two. Okay. Insert Clip art, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb". 
Move the picture on this slide below the double "EE" in "Engineering". If necessary, use 
Help Topics Find tab option. Okay, am going to try this. Click on the picture and drag it 
here. 

OBSERVER: 
"Did you get it?" 

SUBJECT 7: 
"Yes. If necessary, use Help Topics Find tab option. Okay, am going to the next slide." 

OBSERVER: 
"Okay." 

SUBJECT 7: 
"Slide five, from AutoLayout slide, choose "Bulleted List". Type title, statistics. 
Use font, Algerian. Type size eighty eight." 

OBSERVER: 
"Your time is up. Please save your presentation. I am going to ask you six questions. I 
will read the questions to you and I want you to answer them out aloud. Number one, did 
you read the same help topic more than once?" 

SUBJECT 7: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 7: 
"Yes. " 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 7: 
"No." 
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OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 7: 
"Yes." 

OBSERVER: 
"Number five, did you make notes or summarize tbe text before starting?" 

SUBJECT 7: 
"Yes, mental notes." 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 7: 
''No,'' 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and tbere 
will be no mention of your name." 

Testing Group 

SUbject 8 

OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are tbe slides. You may refer to tbe display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
1) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as yhour sample word. These are 

your comparison words. 
3) Select one word. 



4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find 
"How to do" topics. 
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5) Look read the topics and select to read the one that has two or more of the word from 
the words ;you selected. 

6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 8: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics Find tab option. 

OBSERVER: 
"What is the?" 

SUBJECT 8: 
"Adding the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Tell me what you are doing?" 

SUBJECT 8: 
"Am going into the help topics" 

OBSERVER: 
"What are you reading?" 

SUBJECT 8: 
"Adding the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What you reading now?" 

SUBJECT 8: 
"I don't know. Am getting lost. Oh, the cue word list." 

OBSERVER: 
"What are you typing ?' 

SUBJECT 8: 
"Toolbar." 
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OBSERVER: 
"Is that one of the words you've selected from the cue word list?" 

SUBJECT 8: 
"Yes." 

OBSERVER: 
"Okay, what are the topic options?" 

SUBJECT 8: 
"Add a freeform. Add a line. Add a rectangle. Add an arc. Add an AutoShape. Add an 
ellipse. Add or delete a toolbar button." 

OBSERVER: 
"What are you trying to do?" 

SUBJECT 8: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Did you find any of the cue words in the topic options?" 

SUBJECT 8: 
"Yes, it says add or delete a toolbar button." 

OBSERVER: 
"Could you read that out aloud." 

SUBJECT 8: 
Add or delete a toolbar button. One, display the toolbar you want to change, and then 
click Customize on the Tools menu. Two, to add a button, click the name of the category 
in the Categories box, and then drag the button from the Buttons area to a toolbar. To . 
delete a button, drag it off the toolbar. Tip. When you delete a built-in toolbar button 
from a toolbar, the button is still available in the Customize dialog box. However, when 
you delete a custom toolbar button, it is permanently deleted. To delete a custom toolbar 
button from a toolbar but save it for later use, create a toolbar for storing unused buttons, 
move the button to this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What are you thinking?" 

SUBJECT 8: 
"What country am in right now. Am a little bit lost." 
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OBSERVER: 
"Okay, what is it you want to do?" 

SUBJECT 8: 
"Add a toolbar button that searches the active presentation for specified text. So, display 
the toolbar I want then click Customize." 

OBSERVER: 
"What are you thinking." 

SUBJECT 8: 
"Oh, I don't know. I have to add a toolbar button that searches the active presentation for 
specified text." 

OBSERVER: 
"Did you find the instructions?" 

SUBJECT 8: 
"Yes, it says it here." 

OBSERVER: 
"Can you follow the instructions?" 

SUBJECT 8: 
"I don't know. It's all confusing, confusing to me." 

OBSERVER: 
"Okay, What is confusing?" 

SUBJECT 8: 
"It just keep saying the same thing over and over again." 

OBSERVER: 
"Do you want to move on or try it again." 

SUBJECT 8: 
"I don't know. Even from help topics, I don't understand." 

OBSERVER: 
"Do you want to move on?" 

SUBJECT 8: 
"Yes," 



OBSERVER: 
"Okay. Close these windows and go ahead reading the next information on the layout 
sheet?" 

SUBJECT 8: 
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"Okay. Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. If necessary, use Help Topics Find tab option." Am going to help and choose 
accent color." 

OBSERVER: 
"Tell me what you are going to do?" 

SUBJECT 8: 
"Am going to help. I want to change background color to any color for this slide only." 

OBSERVER: 
"What are you reading now?" 

SUBJECT 8: 
"The cue word list." 

OBSERVER: 
"Tell me the words you are selecting." 

SUBJECT 8: 
"Background and color." 

OBSERVER: 
"Which one are you typing?" 

SUBJECT 8: 
"Background." 

OBSERVER: 
"Okay." 

SUBJECT 8: 
"Add or change a fill. Change a slide background color. Change an object shadow to the 
default shadow. Change the default format of the blank presentation. Change the fill to 
match the background. Change the slide background. Change the slide background to a 
color other than a color-scheme color." 

OBSERVER: 
"What is it you want to do? " 



171 

SUBJECT 8: 
"Change the background color." 

OBSERVER: 
"What topic are you selecting?" 

SUBJECT 8: 
Change a slide background color. When you change a slide's background color, you can 
use one of the eight coordinated color-scheme colors or you can use a color that isn't part 
of the current color scheme. If you use a color-scheme color and then later change your 
presentation's color scheme, the background color changes to coordinate with the new 
color scheme. If you choose a color that's not part of the current color scheme, the color 
stays the same even if you change the color scheme. If you've already changed a slide's 
background color, you can also return it to the color scheme's default background color. 
When you change the background, you can apply it to the current slide by clicking 
Apply, or to all the slides and the slide master by clicking Apply To All. What do you 
want to do? Change the slide background to a color scheme color. Change the slide 
background to a color other than a color scheme color. Change to the default slide 
background. Am selecting change the slide background color to a color-scheme color. 
One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click other color. Click the color you 
want. 

OBSERVER: 
"What are you going to do?" 

SUBJECT 8: 
"In slide view, on the Format menu, click Custom Background. I need to get out ofthis 
and go to format. It says I need to go to slide view." 

OBSERVER: 
"What is it you are going to do?" 

SUBJECT 8: 
"Change background color to any color for this slide only. So, I need to get to custom 
background. " 

OBSERVER: 
"Okay." 

SUBJECT 8: 
"Title or slide." 



OBSERVER: 
"What are you reading?" 

SUBJECT 8: 
"Let see, it says background fill, apply to all, apply, cancel." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 8: 
"I don't know what am thinking. I don't know what to do next." 

OBSERVER: 
"Did you want to go back to the help menu?" 

SUBJECT 8: 
"I could, but I have very bad short term memory." 

OBSERVER: 
"What do you want to do?" 

SUBJECT 8: 
"Go back to help menu." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 8: 
"Looking at the cue words." 

OBSERVER: 
"What is it you are typing?" 

SUBJECT 8: 
"Background, am selecting change a background color. Do I have to read all of this 
again?" 

OBSERVER: 
"Are you reading?" 

SUBJECT 8: 
"No, I have already read this. Am going down here and select. Change a slide 
background color other than a color-scheme color." 

OBSERVER: 
"Okay." 
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SUBJECT 8: 
"In slide view, on the Fonnat menu, click Custom Background. Under Background Fill, 
click the down arrow, and then click other color. Click the color you want. I hope I can 
remember this." 

OBSERVER: 
"Do you want to leave the help window open?" 

SUBJECT 8: 
"Can 1." 

OBSERVER: 
"Try it." 

SUBJECT 8: 
"Okay. Am looking for fonnat then custom background. Okay, let me close the help 
now." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 8: 
"I don't know. I should have left the help window open." 

OBSERVER: 
"What do you want to do?" 

SUBJECT 8: 
"Go back to help." 

OBSERVER: 
"Okay." 

SUBJECT 8: 
"Okay,. If I keep going back and forth, I'll never get this." 

OBSERVER: 
"It's okay." 

SUBJECT 8: 
"Am choosing background color from the cue word list to type in." 

OBSERVER: 
"Okay." 
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SUBJECT 8: 
"Change the slide background color, am selecting because that is what I did before. 
Since I remember what I did before, am selecting change a slide background color other 
than a color-scheme color. Okay. In slide view, on the Format menu, click Custom 
Background. Under Background Fill, click the down.arrow, and then click other color. 
Click the color you want. I hope I can remember this." 

OBSERVER: 
"Tell me what you are doing?" 

SUBJECT 8: 
"Am getting out." 

OBSERVER: 
"What did you just close?" 

SUBJECT 8: 
"I did it again. Am never going to get this right. I can never remember these three steps 
without going back and forth." 

OBSERVER: 
"Do you want to try it again?" 

SUBJECT 8: 
"Yes," 

OBSERVER: 
"What are you doing?" 

SUBJECT 8: 
Hitting help for the millionth time." 

OBSERVER: 
"It's okay." 

SUBJECT 8: 
"Am selecting change the slide background color and I want to change a slide 
background color other than a color-scheme color. I wish I can write this down on paper 
because I could never remember this." 

OBSERVER: 
"You may write it down." 



SUBJECT 8: 
"I've got it. Now am going to exit out of help. Am now going to fonnat and choose 
custom background. Then, am now going to click the down-arrow. Okay, am clicking 
any color I want. Its a lot of color. Then, I hit okay. What is next?" 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 8: 
"Change background color to any color for this slide only. I did that." 

OBSERVER: 
"What are your options on the screen?" 

SUBJECT 8: 
"Apply, apply to all, cancel and preview." 

OBSERVER: 
"Which one would you select?" 

SUBJECT 8: 
Apply, not apply to all." 

OBSERVER: 
"What is the next instruction on the layout sheet?" 

SUBJECT 8: 
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Slide three. Am going to a new slide. Slide three, from AutoLayout slide, choose "Text 
& Clip Art" type title, mathematics. Use font Algerian. Type size eighty. Type subtitle, 
three (3) courses. Use font Times New Roman. Type size thirty. Insert Clipart, under 
"Categories", choose "Signs". Select the description "Balance Truthful Scales". Crop or 
trim the top portion of the picture on this slide. Ifnecessary, use Help Topics Find tab 
option. 

OBSERVER: 
"Do you kuow how to do that?" 

SUBJECT 8: 
"No, I don't remember." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 8: 
"Go to help and use the cue word list." 
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OBSERVER: 
"What is it you are trying to do?" 

SUBJECT 8: 
"Select cue words to typing in. Am going to select crop and trim." 

OBSERVER: 
"Which word would you type in first?" 

SUBJECT 8: 
"Crop, because its the same thing." 

OBSERVER: 
"What are your topic options?" 

SUBJECT 8: 
"Bitmap. Crop or trim off portion of a picture. PowerPoint sometimes crop the borders 
on embedded picture. Whatever that is. So, am going to select crop or trim off portion of 
a picture." 

OBSERVER: 
"Okay." 

SUBJECT 8: 
"Crop or trim the top portion of a picture. To trim or restore portions of a picture, click 
Crop Picture, position the cropping tool over a resize handle, and then drag to crop the 
picture." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 8: 
"Go to the tools menu and select crop picture. Am getting rid of the help screen topic." 

OBSERVER: 
"What are you looking for?" 

SUBJECT 8: 
"Crop picture." 

OBSERVER: 
"Did you find it?" 

SUBJECT 8: 
"Yes. " 
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OBSERVER: 
"What are you doing now?" 

SUBJECT 8: 
"Wait. Yes, I've got it." 

OBSERVER: 
"What are you gong to do?" 

SUBJECT 8: 
"Am going to slide four. Slide four, from AutoLayout slide, choose "Text & Clip Art". 
Type title, electrical engineering. Use font, Algerian. Type size sixty." 

OBSERVER: 
"Your time is up. Please save your presentation. I am going to ask you six questions. I 
will read the questions to you and I want you to answer them out aloud. Number one, did 
you read the same help topic more than once?" 

SUBJECT 8: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 8: 
"Yes." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 8: 
"Yes, tools (some), file, edit, and view." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 8: 
"Yes," 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 8: 
"Yes," 
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OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 8: 
"Yes. " 

OBSERVER: 
"The responses you have made in this research report wi 11 remain anonymous and there 
will be no mention of your name." 

Subject 9 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
I) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as yhour sample word. These are 

your comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 
5) Look read the topics and select to read the one that has two or more of the word from 

the words ;you selected. 
6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 9: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. " Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 
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OBSERVER: 
"What are you going to doT' 

SUBJECT 9: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you know what to doT' 

SUBJECT 9: 
"No." 
OBSERVER: 
"What are you going to doT' 

SUBJECT 9: 
"Go to help and am going to type the word or words am trying to find. Am looking at the 
cue word lists for words. Am typing in add." 

OBSERVER: 
"What are the topic options?" 

SUBJECT 9: 
"Add a freeform, add a line, add a rectangle, add an arc, add an ellipse, and 
add or delete a toolbar button." 

OBSERVER: 
"What is it you want to doT' 

SUBJECT 9: 
"What I'll like to do is add or delete a toolbar button." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
It tells me, One, display the toolbar you want to change, and then click Customize on the 
Tools menu. Two, to add a button, click the name of the category in the Categories box, 
and then drag the button from the Buttons area to a toolbar. To delete a button, drag it off 
the toolbar. Tip, when you delete a built-in toolbar button from a toolbar, the button is 
still available in the Customize dialog box. However, when you delete a custom toolbar 
button, it is permanently deleted. To delete a custom toolbar button from a toolbar but 
save it for later use, create a toolbar for storing unused buttons, move the button to this 
storage toolbar, and then hide the storage toolbar. 



OBSERVER: 
"What are you thinking?" 

SUBJECT 9: 
"It sounds like a lot of work. Am going to click off the help topic. I hit insert on the 
menu bar to see if! find Customize. I hit tools and its there." 

OBSERVER: 
"What is it you want to doT' 

SUBJECT 9: 
"What I want to do is add a toolbar button that searches the active presentation for 
specified text." 

OBSERVER: 
"What are you looking at right now?" 

SUBJECT 9: 
"Am looking at buttons." 

OBSERVER: 
"Did you click on the buttons?" 

SUBJECT 9: 
"Not yet." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"Am clicking on the button Paper. Create a new presentation based on a blank 
presentation template." 

OBSERVER: 
"Is that what you want to doT' 

SUBJECT 9: 
"No," 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"Second one is Open. Third one is Save. Fourth is Print. Fifth is Send Mail. Sixth is 
Routing Slip. Am going to the Edit category. The buttons there are Cut, Copy, Paste, 
Format Painter, Undo, redo, Repeat, Duplicate and Find." 
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OBSERVER: 
"What are you thinking?" 

SUBJECT 9: 
"I have to find." 

OBSEVER: 
"What is it you want to do?" 

SUBJECT 9: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you see the descriptions for these buttons?" 

SUBJECT 9: 
"No, I didn't." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 9: 
"Am going to click on repeat to see." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"It says repeat the last change. I click on the binocular button and it says it searches the 
active presentation for a specified text. That is the toolbar button I want to add." 

OBSERVER: 
"What are you going to do now?" 

SUBJECT 9: 
Am going to drag the button to any of the toolbars. I've chosen to add it to the toolbar at 
the side." 

OBSERVER: 
"Have you added it?" 

SUBJECT 9: 
"Yes." 
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OBSERVER: 
"Okay, What are you going to do?" 

SUBJECT 9: 
Close this window and go to new slide. Slide two, from AutoLayout slide, choose 
"Bulleted List." Type title, computer science. Use font, Algerian. Type size fifty four. 
Type subtitle, Five courses. Use font, Times New Roman. Type size thirty two. Change 
background color to any color for this slide only. If necessary, use Help Topics Find tab 
option. Am going to be using help topics for this. Am selecting background and color 
from the cue word list. Am typing in background. I see a list of topics that I can choose 
from such as: Add or change a fill, Background color, Change a slide background color, 
change an object shadow to the default shadow, change the default format of the blank 
presentation, change the fill to match the background. Am going to choose background 
color." The underlying color of a PowerPoint slide. The background color on a slide is 
similar to the canvas for a painting. If the background color (the canvas) is white, for 
instance, you can paint any other color on top of it, but the underlying color remains 
white. Everywhere you don't add paint, the white shows. 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 9: 
"Change background color to any color for this slide only." 

OBSERVER: 
"Does this tell you how to do that?" 

SUBJECT 9: 
No, it doesn't. Am going back to help topics and choose change a slide background 
color. When you change a slide's background color, you can use one of the eight 
coordinated color-scheme colors or you can use a color that isn't part of the current color 
scheme. If you use a color-scheme color and then later change your presentation's color 
scheme, the background color changes to coordinate with the new color scheme. If you 
choose a color that's not part of the current color scheme, the color stays the same even if 
you change the color scheme. If you've already changed a slide's background color, you 
can also return it to the color scheme's default background color. When you change the 
background, you can apply it to the current slide by clicking "Apply", or to all the slides 
and the slide master by clicking "Apply To All." What do you want to do? Change the 
slide background to a color scheme color. Change the slide background to a color other 
than a color scheme color Change to the default slide background. Am going to select 
Change the slide background to a color scheme color. Change the slide background to a 
color scheme color. One, in slide view, on the Format menu, click Custom Background. 
Two, under Background Fill, click the down arrow, and then click the color you want. 
Am going to close the help topics. Now, I click on format, go to custom background and 
click on that. Am going to the down-arrow and click on that. It gives me a list of several 
colors. Am going to select light green and click apply. 



183 

OBSERVER: 
"Okay." 

SUBJECT 9: 
''Now, am going to click on new slide. Slide three, from AutoLayout slide, choose "Text 
& Clip Art" type title, mathematics. Use font Algerian. Type size eighty. Type subtitle, 
three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"Which part of the picture you want to crop or trim?" 

SUBJECT 9: 
"The top portion of the picture." 

OBSERVER: 
"Okay, Do you know how to do that?" 

SUBJECT : 
"Yes, am going to tools, click on it and go down to crop picture. The crop button comes 
up. Am going to put that on the top left resize button of the picture and move it down to 
cut off the top portion. Am done." 

OBSERVER: 
"Good. What is it you are going to do next?" 

SUBJECT 9: 
Next am going to new slide. Slide four, from AutoLayout slide, choose "Text & Clip 
Art". Type title, electrical engineering. Use font, Algerian. Type size sixty. Type 
subtitle, Four (4) courses. Use font, Times New Roman. Type size thirty two. Okay. 
Insert Clipart, under "Categories", choose "Energy." Select the description "Idea 
Brainstorm Light Bulb." Move the picture on this slide below the double "EE" in 
"Engineering". If necessary, use Help Topics Find tab option. 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 9: 
"No. So, am going to the help topic." 

OBSERVER: 
"What is it you are going to be doing? 
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SUBJECT 9: 
"Moving the picture on the slide." 

OBSERVER: 
"Do you know how to move a picture on the slide?" 

SUBJECT 9: 
"I believe ifI click on the resize buttons." 

OBSERVER: 
"Would the resize handles help you to move the picture?' 

SUBJECT 9: 
"Probably not. So, am going to help topics. Am selecting move and objects from the cue 
word list. Am typing move." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"It gives me a list of topics to choose from: Adding and deleting toolbar, adding text 
aligning objects, aligning objects on grid, attached text, change tabs proportionally and 
changing the layout of a slide. Am going to scroll down to see if there is a topic that 
shows me how to move the light bulb. I found moving objects or set of objects." 

OBSERVER: 
"What are you looking at now?" 

SUBJECT 9: 
"Am looking at the cue words." 

OBSERVER: 
"Why did you look at the cue words?" 

SUBJECT 9: 
"In order to help me figure out which search word tells me how to move the light bulb 
over." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"Am clicking on moving objects or set of objects to see if that will give me some 
information on how to move it. One, select the object, the multiple selection, or the group 
you want to move. How? Two, drag the object to its new location. Note: A 
placeholder, like any other object, can also be moved in this way." 
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OBSERVER: 
"Okay." 

SUBJECT 9: 
"One, select the object, the mUltiple selection, or the group you want to move. How? 
Two, drag the object to its new location. Note: A placeholder, like any other object, can 
also be moved in this way." 

OBSERVER: 
"Where are you going to move the picture? 

SUBJECT 9: 
"Below the "EE" in engineering. Am clicking on the light bulb and moving it below the 
double "EE." It is now below the double "EE." 

OBSERVER: 
"Okay. What are you going to do now?" 

SUBJECT 9: 
"Now, am going to click on new slide in order to start slide number five. "Slide five, 
from AutoLayout slide, choose "Bulleted List". Type title, statistics. Use font, Algerian. 
Type size eighty eight. Type subtitle, five (5) courses. Use font, Times New Roman. 
Type size thirty two. Change title color to any color for this slide only. If necessary, use 
Help Topics Find tab option." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"Am going to help and from my cue word list choose color and change." 

OBSERVER: 
"Which word would you use first?" 

SUBJECT 9: 
"Color." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
"Lots of topics to choose: Accent colors, add a custom color-scheme as a standard 
schemes, add an embossed effect to a PowerPoint object, add or change a fill, add or 
change a patterned fill, add or change a shaded fill, and add or change a textured fill. 



What am going to do is go down the list and see ifthere is anything that show me how 
to add color to the title only." 

OBSERVER: 
"Is the title a picture or text?" 
SUBJECT 9: 
"It's a text." 

OBSERVER: 
"Okay." 

SUBJECT 9: 
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"Am gong down the list of topics. There are one hundred and twelve topics found in this. 
So, am going down to see if it shows anything for title color." 

OBSERVER: 
"A title is what?" 

SUBJECT 9: 
"Text." 

OBSERVER: 
"Okay.' 

SUBJECT 9: 
"I see add or change a textured fill. I don't think that will do it. Build body text. I don't 
thing that will help either. Change a color scheme. Change a fill color." 

OBSERVER: 
"What else are you reading?" 

SUBJECT 9: 
Change a slide background color, change an object shadow other than a color scheme 
color, change text color. Am going to click on change text color. Now, it says change 
text color. When you change text color, you can use one of the eight coordinated color­
scheme colors, or you can use a color that isn't part ofthe color scheme. If you use a 
color-scheme color and then later change your presentation's color scheme, the text color 
changes to coordinate with the new color scheme. If you choose a color that's not part of 
the current color scheme, the text color stays the same even if you change color schemes. 
If you change text color, you can also return text color to the color scheme's default text 
color. What do you want to do? Change text to a color scheme color. Change text to a 
color other than a color scheme color. Change text to the default text color. Am 
selecting change text to a color scheme color. One, in slide or notes view, select the text 
you want to change. Two, on the Format menu, click Font. Three, on the Color drop­
down list, click your choice in the color palette. Right now, am going to close help topics 
and go to format menu. Am clicking on fonts. Am going to the color palettes. Oh, first I 



have to go back and highlight the text. Now, back to format, font, color palette and 
click okay. 

OBSERVER: 
"Did the color change?" 

SUBJECT 9: 
"Yes, it did." 

OBSERVER: 
"Okay, what is the next instruction on the layout sheet?" 

SUBJECT 9: 
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Can you solve the problem of having the logo appear in the upper left comer on aU 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
Insert cJipart, select description, Professor Leadership Informat and filename "Popular" 
as your logo. If necessary, use Help Topics Find tab option. When you are finished, 
please save your presentation using your last name. Am going to help topics for this. 
Am selecting adding logo and logo from the cue word list. Am typing in adding logo. 
It's easy to add your logo to a presentation using scanned or digital art. Or you can create 

what you need using clip art, WordArt, and the PowerPoint tools. To have a logo appear 
on every slide in your presentation, insert it on the slide master. Before you import a 
digital file or a scanned version of your logo, you may want to adjust the colors and 
contrast in an application that lets you edit bitmaps. You can use clip art images to create 
a logo in your presentation and then use PowerPoint commands to change an image's fiU 
and line color, take it apart, even combine it with other clip-art images, drawings, and 
text. If you didn't instaU the ClipArt GaUery with PowerPoint, just run PowerPoint Setup 
again. You can draw a logo, or add drawn art as a frame for your logo, for example, 
using the PowerPoint tools. To create composite shapes, use the AutoShapes tools and 
the Freeform drawing tool. Or you might try using WordArt to add special text effects to 
your logo or to your company name by slanting, rotating or curving text. 

OBSERVER: 
"What are you doing now?" 

SUBJECT 9: 
" I am reading the instruction on the sheet." 

OBSERVER: 
"Read out aloud." 

SUBJECT 9: 
"Can you solve the problem of having the logo appear in the upper left comer on aU 
slides? Please insert a logo and have it appear in the upper left comer on aU slides. 



Insert clipart, select description, Professor Leadership Informat and filename 
"Popular" as your logo. If necessary, use Help Topics Find tab option. When you are 
finished, please save your presentation using your last name." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 9: 
"Am thinking to select logo and adding from the cue word list." 
OBSERVER: 
"Okay, which one are you typing ?" 

SUBJECT 9: 
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Logo. It's easy to add your logo to a presentation using scanned or digital art. Or you can 
create what you need using clip art, WordArt, and the PowerPoint tools. To have a logo 
appear on every slide in your presentation, insert it on the slide master. Before you 
import a digital file or a scanned version of your logo, you may want to adjust the colors 
and contrast in an application that lets you edit bitmaps. You can use clip art images to 
create a logo in your presentation and then use PowerPoint commands to change an 
image's fill and line color, take it apart, even combine it with other clip-art images, 
drawings, and text. If you didn't install the ClipArt Gallery with PowerPoint, just run 
PowerPoint Setup again. You can draw a logo, or add drawn art as a frame for your logo, 
for example, using the PowerPoint tools. To create composite shapes, use the AutoShapes 
tools and the Freeform drawing tool. Or you might try using WordArt to add special text 
effects to your logo or to your company name by slanting, rotating or curving text. 

OBSERVER: 
"What is the slide master?" 

SUBJECT 9: 
"I don't know. So, am going to click on the word slide master. It says: The slide that 
hold the formatted placeholders for the titles and main text as well as any background 
items that you want to appear on all slides in a presentation. If you make a change to the 
slide master, the change affects all slides in your presentation that follow the master." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 9: 
"Am thinking that if! insert a logo in the comer ofthe front of the first slide it will then 
appear on the same comer of all slides." 

OBSERVER: 
"Is that what you want?" 
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SUBJECT 9: 
"The instruction says: Please insert a logo and have it appear in the upper left comer on 
all slides. Insert clipart, select description, Professor Leadership Informat and filename 
"Popular" as your logo. So, yes." 

OBSERVER: 
"Is that what you see on the display board?" 

SUBJECT1: 
"Yes, so am closing help topic.' 

OBSERVER: 
"What are you doing now?" 

SUBJECT 9: 
"What am doing is attempting to go back to the first slide to insert the logo. Am clicking 
on the up-arrow to do that. I click on insert then clip art to add it to the slides. Now, 
what I like to do is insert. It says on the layout sheet to insert clip art description 
Professor Leadership Informat and filename "Popular which is where I am. Now, I have 
to put this on my slide master." 

OBSERVER: 
"What happened?" 

SUBJECT 9: 
"It didn't insert it on the slide master. What happened is that it was inserted on the first 
slide." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 9: 
"I am going to undo to take the clip art away. Now, am going to View and select Master 
Slide. It says click to edit the master title slide." 

OBSERVER: 
"What is it you want to do?' 

SUBJECT 9: 
"What I'll like to do is insert a logo and have it appear on the upper left comer 0 fall the 
slides. Am going to insert the clipart. Am selecting the Professor Leadership clip art. 
Now, am going to click on insert and drag it to the upper left hand comer." 

OBSERVER: 
"What are you going to do next?" 
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SUBJECT 9: 
"Oh, I'll like it to look smaller. Am going to click on the resize button on the lower right 
and make it much smaller. Now, its only appearing in the corner which I have done." 

OBSERVER: 
"Okay." 
SUBJECT 9: 
"Now, am going to choose View and move down to see ifit has appeared on all slides." 

OBSERVER: 
"Has itT' 

SUBJECT 9: 
"Yes," 

OBSERVER: 
"Please save your presentation using your last name." 

SUBJECT 9: 
"Okay." 

OBSERVER: 
"I am going to ask you six questions. I will read the questions to you and I want you to 
answer them out aloud. Number one, did you read the same help topic more than once? 

SUBJECT 9: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 9: 
"Yes." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 9: 
"Yes. 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 9: 
"Yes." 
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OBSERVER: 
''Number five, did you make notes or summarize the text before starting?" 

SUBJECT 9: 
"No." 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 9: 
"Yes. " 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 10 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
1) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as yhour sample word. These are 

your comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 
5) Look read the topics and select to read the one that has two or more of the word from 

the words ;you selected. 
6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 10: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 



Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. " Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
"Do you know how to do this?" 

SUBJECT 10: 
"No. Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 10: 
"Click on the toolbar." 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 10: 
"I don't know." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 10: 
"If necessary, use Help Topics Find tab option." 

OBSERVER: 
"Where are you going for help?" 

SUBJECT 10: 
"To the help menu." 

OBSERVER: 
"What do you have in front of you to help you?" 

SUBJECT 10: 
"The cue word list." 

OBSERVER: 
"What is it you are trying to do?" 

SUBJECT 10: 
"Add the toolbar button that searches the active presentation for specified text." 
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OBSERVER: 
"Okay, select two cue words from the cue word list." 

SUBJECT 10: 
"Toolbar and create." 

OBSERVER: 
"Which one are you typing first? 

SUBJECT 10: 
"Toolbar." 

OBSERVER: 
"What are the topic options?" 

SUBJECT 10: 
"Add a line, add a freeform, add a rectangle, add a arc, add a AutoShape, add an ellipse, 
add or deletes toolbar button. I'll select that." 

OBSERVER: 
"Okay, read out aloud." 

SUBJECT 10: 
Add or delete a toolbar button. One, display the toolbar you want to change, and then 
click Customize on the Tools menu. Two, to add a button, click the name of the category 
in the Categories box, and then drag the button from the Buttons area to a toolbar. To 
delete a button, drag it off the toolbar. Tip, when you delete a built-in toolbar button 
from a toolbar, the button is still available in the Customize dialog box. However, when 
you delete a custom toolbar button, it is permanently deleted. To delete a custom toolbar 
button from a toolbar but save it for later use, create a toolbar for storing unused buttons, 
move the button to this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 10: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Did you understand the instructions from the help topic?" 

SUBJECT 10: 
"Yes." 



194 
OBSERVER: 
"Are you ready to follow the instructions?" 

SUBJECT 10: 
"Yes." 

OBSERVER: 
"How many steps are in the instructions?" 

SUBJECT 10: 
"Two." 

OBSERVER: 
"If you are reading, read out aloud." 

SUBJECT 10: 
"Display the toolbar you want to change and then click customize on the tools menu. To 
add a button click the name of the category in the categories box and then drag the button 
from the button area to a toolbar." 

OBSERVER: 
"Do you want to give it a try?" 

SUBJECT 10: 
"Yes, I want to close the help topic window. Add the toolbar button that searches the 
active presentation for specified text." 

OBSERVER: 
"What are you clicking on?" 

SUBJECT 10: 
"The toolbar." 

OBSERVER: 
"What is the word in blue here?" 

SUBJECT 10: 
"Tools." 

OBSEVER: 
"Okay." 

SUBJECT 10: 
"Add a toolbar button that searches the active presentation for specified text." 



OBSERVER: 
"Do you remember the instructions for doing this?" 

SUBJECT 10: 
"Am lost." 

OBSERVER: 
"Okay. What is it you want to do?" 

SUBJECT 10: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Did you get help from the help topic?" 

SUBJECT 10: 
"Yes. I just don't know what you want me to do?" 

OBSERVER: 
"Read this instruction here on the layout sheet." 

SUBJECT 10: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you want to try that task again? You can be honest? Do you?" 

SUBJECT 10: 
"No," 

OBSERVER: 
"Okay, move on to the next instruction on the layout sheet." 

SUBJECT 10: 
"Am selecting new slide. Slide two, from AutoLayout slide, choose "Bulleted List." 
Type title Computer Science. Use font, Algerian. Type size fifty four. Type subtitle, 
Five courses. Use font, Times New Roman. Type size thirty two. Change background 
color to any color for this slide only. If necessary, use Help Topics Find tab option." 

OBSERVER: 
"What is it you are going to do?" 

SUBJECT 10: 
"Change background color to any color for this slide only." 
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OBSERVER: 
"Do you know how to do that?' 

SUBJECT 10: 
"No," 

OBSERVER: 
: What are you going to do?" 

SUBJECT 10: 
"Go to the help menu and the cue word list. " 

OBSERVER: 
"What is it you want to dol' 

SUBJECT 10: 
"Change the background color to any color for this slide only." 

OBSERVER: 
"What two words are you selecting from the cue word list? 

SUBJECT 10: 
"Color and background." 

OBSERVER: 
"Which one are you typing in first?" 

SUBJECT 10: 
"Background. " 

OBSERVER: 
"What are the topic options." 

SUBJECT 10: 
"Add or change a fill. Add background color." 

OBSERVER: 
'Which one are you selecting now?' 

SUBJECT 10: 
"Add background color. The underlying color of a PowerPoint slide. The background 
color on a slide is similar to the canvas for a painting. If the background color (the 
canvas) is white, for instance, you can paint any other color on top of it, but the 
underlying color remains white. Everywhere you don't add paint, the white shows." 
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OBSERVER: 
"Does this tell you how to add a background color?" 

SUBJECT 10: 
''No, not really." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 10: 
"Am going back to help topics." 

OBSERVER: 
"Okay. What are you reading!" 

SUBJECT 10: 
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Background color. Change a slide background color. Am selecting this. When you 
change a slide's background color, you can use one of the eight coordinated color-scheme 
colors or you can use a color that isn't part of the current color scheme. If you use a color­
scheme color and then later change your presentation's color scheme, the background 
color changes to coordinate with the new color scheme. If you choose a color that's not 
part of the current color scheme, the color stays the same even if you change the color 
scheme. If you've already changed a slide's background color, you can also return it to 
the color scheme's default background color. When you change the background, you can 
apply it to the current slide by clicking "Apply", or to all the slides and the slide master 
by clicking "Apply To All." What do you want to do? Change the slide background to a 
color scheme color. Change the slide background to a color other than a color scheme 
color Change to the default slide background. It tells me to change the slide background 
color to a different color. 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 10: 
"Yes," 

OBSERVER: 
"Go ahead." 

SUBJECT 10: 
"Change the slide background to a color other than the color- scheme color. One, in slide 
view, on the Format menu, click Custom Background. Two, under Background Fill, 
click the down arrow, and then click other color. Click the color you want." 

OBSERVER: 
"What are you doing now?" 
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SUBJECT 10: 
"Am going to Fonnat then click on Custom background. under Background Fill, click the 
down arrow, and then click other color. 

OBSERVER: 
"What is it you want to do now?" 

SUBJECT 10: 
"Am exiting the window." 

OBSERVER: 
"Which window did you exit." 

SUBJECT 10: 
"Am not sure. The help window. Am at the Custom background window." 

OBSERVER: 
"Do you want to read the layout sheet instruction?" 

SUBJECT 10: 
"Yes. Change the background color to any color for this slide only." 

OBSERVER: 
"You have four buttons on the screen?" 

SUBJECT 10: 
"Am going to click on the one that says Apply." 

OBSERVER: 
"What is the next task on the layout sheet?" 

SUBJECT 10: 
Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, mathematics. 
Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. If necessary, use Help Topics Find tab option. 

OBSERVER: 
"Tell me what you are thinking?" 

SUBJECT 10: 
"I think I do, but am not sure. I think I just click on the picture then move the dotted line 
down," 
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OBSERVER: 
"What will that do?" 

SUBJECT: 
"It will cut the top part of the picture." 

OBSERVER: 
"Okay. Do you want to try it?" 

SUBJECT 10: 
"Yes." 

OBSERVER: 
Did it crop the top portion of the picture?" 

SUBJECT 10: 
"No. " 

OBSERVER: 
"What did it do?" 

SUBJECT 10: 
"It moved the picture." 

OBSERVER: 
"Is it moving the picture you are trying to do?' 

SUBJECT 10: 
"Yes. No. Crop or trim." 

OBSERVER: 
"Do you know what to do?' 

SUBJECT 10: 
"Am not sure." 

OBSERVER: 
"What is the instruction here on the layout sheet?" 

SUBJECT 10: 
"If necessary, use Help Topics Find tab option." 

OBSERVER: 
"What are you going to do?" 



SUBJECT: 
"Go to the help menu." 

OBSERVER: 
"Okay." 

SUBJECT 10: 
"Am selecting two words from the cue word list, crop and trim." 

OBSERVER: 
"Which one you are typing first?" 

SUBJECT 10: 
"Crop. Am selecting crop form the topic options. To trim vertical and/or horizontal 
edges of a picture using the Cropping tool. Once you crop a picture, you can always 
uncrop it. Photos are often cropped to focus attention on a particular area of a picture." 

OBSERVER: 
"Tell me what you are thinking. Go ahead, you can say what is on you mind." 

SUBJECT 10: 
"Am just curious to know where they want the picture and how much they want trim 
off?" 

OBSERVER: 
"Okay. Look on the display board." 

SUBJECT 10: 
"Okay." 

OBSERVER: 
"Do you know now?" 

SUBJECT 10: 
"Yes." 

OBSERVER: 
"Does this help topic here tells you how to crop?" 

SUBJECT 10: 
"No. " 

OBSERVER: 
"What are you going to do?" 
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SUBJECT 10: 
"I have to find another help topic. Am highlighting crop or trim portion of a picture. 
To trim or restore portions of a picture, click Crop Picture, position the cropping tool 
over a resize handle, and then drag to crop the picture." 

OBSERVER: 
"Tell me what you are thinking?" 

SUBJECT 10: 
"I have to read this again." 

OBSERVER: 
"Okay.' 

SUBJECT 10: 
"To trim or restore portions of a picture, click Crop Picture, position the cropping tool 
over a resize handle, and then drag to crop the picture." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 10: 
"I have to find where the cropping tool is?" 

OBSERVER: 
"Does it tell you in the help instructions? 

SUBJECT 10: 
"I don't know. I have to go back to that topic." 

OBSERVER: 
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" Your time is up. Please save your presentation using your last name. I am going to ask 
you six questions. I will read the questions to you and I want you to answer them out 
aloud. Number one, did you read the same help topic more than once?" 

SUBJECT 10: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization ofthe information in the help topics?" 

SUBJECT 10: 
"Most of the time." 

OBSERVER: 
''Number three, did you use prior knowledge of any computer skills to help you?" 



SUBJECT 10: 
"Yes, basic mouse click." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 10: 
"Yes, when I got confused." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 10: 
"No," 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 10: 
"Yes," 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 11 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
1) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as your sample word. These are your 

comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 



5) Look read the topics and select to read the one that has two or more of the word 
from the words ;you selected. 

6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 11: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. " Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. . 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
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"Okay. You are going to add the toolbar button that searches the active presentation for 
specified text." 

SUBJECT 11: 
"Okay." 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 11: 
"No .. " 

OBSERVER: 
"What are you going to do?" 

SUBJECT 11 : 
"Use the help option." 

OBSERVER: 
"Okay. I want you to select two words from the cue word list?" 

SUBJECT 11: 
"Okay. Toolbar and add" 

OBSERVER: 
"Which one are you typing first?" 

SUBJECT 11: 
"Toolbar. " 
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OBSERVER: 
"What are your topic options?" 

SUBJECT 11: 
"Add or delete tool button." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
" 1 need to add the toolbar button that searches the active presentation ." 

OBSERVER: 
"What are you reading?" 

SUBJECT 11: 
"Add or delete a toolbar button, add or delete shortcut in delay box, build body text, build 
bulleted list, create a system toolbar, create a production in outline form." 

OBSERVER: 
"You are looking for a topic that tells how to add a toolbar button. Which one of these 
topics you are going to select?" 

SUBJECT 11: 
The first one. Add or delete a toolbar. One, display the toolbar you want to change, and 
then click Customize on the Tools menu. Two, to add a button, click the name of the 
category in the Categories box, and then drag the button from the Buttons area to a 
toolbar. To delete a button, drag it off the toolbar. Tip. When you delete a built-in 
toolbar button from a toolbar, the button is still available in the Customize dialog box. 
However, when you delete a custom toolbar button, it is permanently deleted. To delete a 
custom toolbar button from a toolbar but save it for later use, create a toolbar for storing 
unused buttons, move the button to this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What is the first thing you are going to do?" 

SUBJECT 11: 
"I need to read this again." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"Add or delete a toolbar. One, display the toolbar you want to change, and then click 
Customize on the Tools menu. Two, to add a button, click the name of the category in 
the Categories box, and then drag the button from the Buttons area to a toolbar. To delete 
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OBSERVER: 
"What are your topic options?" 

SUBJECT II: 
"Add or delete tool button." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
" I need to add the toolbar button that searches the active presentation ." 

OBSERVER: 
"What are you reading?" 

SUBJECT 11: 
"Add or delete a toolbar button, add or delete shortcut in delay box, build body text, build 
bulleted list, create a system toolbar, create a production in outline form." 

OBSERVER: 
"You are looking for a topic that tells how to add a toolbar button. Which one of these 
topics you are going to select?" 

SUBJECT II: 
The first one. Add or delete a toolbar. One, display the toolbar you want to change, and 
then click Customize on the Tools menu. Two, to add a button, click the name of the 
category in the Categories box, and then drag the button from the Buttons area to a 
toolbar. To delete a button, drag it off the toolbar. Tip. When you delete a built-in 
tool bar button from a toolbar, the button is still available in the Customize dialog box. 
However, when you delete a custom toolbar button, it is permanently deleted. To delete a 
custom toolbar button from a toolbar but save it for later use, create a toolbar for storing 
unused buttons, move the button to this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What is the first thing you are going to do?" 

SUBJECT II: 
"I need to read this again." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"Add or delete a tool bar. One, display the toolbar you want to change, and then click 
Customize on the Tools menu. Two, to add a button, click the name of the category in 
the Categories box, and then drag the button from the Buttons area to a toolbar. To delete 
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a button, drag it off the toolbar. Tip. When you delete a built-in toolbar button from 
a toolbar, the button is still available in the Customize dialog box. However, when you 
delete a custom toolbar button, it is permanently deleted. To delete a custom toolbar 
button from a toolbar but save it for later use, create a toolbar for storing unused buttons, 
move the button to this storage toolbar, and then hide the storage toolbar." 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 11: 
"Yes," 

OBSERVER: 
"Okay." 

OBSERVER: 
"What are you looking at right now?" 

SUBJECT 11: 
"At buttons." 

OBSERVER: 
"Did you click on the buttons?" 

SUBJECT 11: 
"yes." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"The button Paper reads create a new presentation based on a blank presentation 
template." 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT II: 
''No.'' 

OBSERVER: 
"Okay." 



SUBJECT II: 
"The second button is Open. Third one is Save. Fourth is Print. Fifth is Send Mail. 
Sixth is Routing Slip. Next category the Edit category. The buttons are Cut, Copy, 
Paste, Format Painter, Undo, redo, Repeat, Duplicate and Find." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 11: 
"I have to find the search button." 

OBSEVER: 
"What is it you want to do?" 

SUBJECT 11: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you see the descriptions for these buttons?" 

SUBJECT 11: 
"Not yet." 

OBSERVER: 
"What are you going to do?" 

SUBJECT II: 
"Click on repeat to see if the button is there." 

OBSERVER: 
"Okay." 

SUBJECT II: 
"It reads repeat the last change. The binocular button reads searches the active 
presentation for a specified text. That is the toolbar button I want to add." 

OBSERVER: 
"What are you going to do now?" 

SUBJECT II: 
Drag the button to any of the toolbars. I'll add it to the toolbar on top." 

OBSERVER: 
"Have you added it?" 
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SUBJECT 11: 
"Yes." 

OBSERVER: 
"Okay, What are you going to do?" 

SUBJECT 11: 
Go to new slide. Slide two, from AutoLayout slide, choose "Bulleted List." Type title, 
computer science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. 
Use font, Times New Roman. Type size thirty two. Change background color to any 
color for this slide only. If necessary, use Help Topics Find tab option. Am going to be 
using help topics for this. 

OBSERVER: 
"What two words are you going to select from the cue word list?" 

SUBJECT 11: 
Background and Color. I'll type background first. Add or change a fill, Background 
color, Change a slide background color, change an object shadow to the default shadow, 
change the default format of the blank presentation, change the fill to match the 
background. I'll choose background color." The underlying color of a PowerPoint slide. 
The background color on a slide is similar to the canvas for a painting. If the background 
color (the canvas) is white, for instance, you can paint any other color on top of it, but the 
underlying color remains white. Everywhere you don't add paint, the white shows. 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 11: 
"Change background color to any color for this slide only." 

OBSERVER: 
"Does this tell you how to do that?" 

SUBJECT 11: 
No. I'll choose change a slide background color instead. When you change a slide's 
background color, you can use one of the eight coordinated color-scheme colors or you 
can use a color that isn't part of the current color scheme. If you use a color-scheme color 
and then later change your presentation's color scheme, the background color changes to 
coordinate with the new color scheme. If you choose a color that's not part of the current 
color scheme, the color stays the same even if you change the color scheme. If you've 
already changed a slide's background color, you can also return it to the color scheme's 
default background color. When you change the background, you can apply it to the 
current slide by clicking "Apply", or to all the slides and the slide master by clicking 
"Apply To All." What do you want to do? Change the slide background to a color 
scheme color. Change the slide background to a color other than a color scheme color 



208 
Change to the default slide background. Am going to select Change the slide 
background to a color scheme color. Change the slide background to a color scheme 
color. One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click the color you want. I am going to 
close the help topics. Now, I click on format, go to custom background and click on that. 
Am going to the down-arrow and click on that. Am going to select red and click apply. 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"Now, new slide. Slide three, from AutoLayout slide, choose "Text & Clip Art" type 
title, mathematics. Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". Select the description "Balance Truthful Scales". Crop or trim the top 
portion ofthe picture on this slide. If necessary, use Help Topics Find tab option." 

OBSERVER: 
"Which part of the picture you want to crop or trim?" 

SUBJECT 11: 
"The top portion of the picture." 

OBSERVER: 
"Okay." 

SUBJECT : 
"I am going to try this without using help menu. I am clicking on tools and going down 
to crop picture. The crop button comes up. I put that on the top left resize button of the 
picture and move it down to cut off the top portion." 

OBSERVER: 
"Okay, great. What is it you are going to do next?" 

SUBJECT 11 : 
Add a new slide. Slide four, from AutoLayout slide, choose "Text & Clip Art". Type 
title, electrical engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) 
courses. Use font, Times New Roman. Type size thirty two. Okay. Insert Clipart, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb." 
Move the picture on this slide below the double "EE" in "Engineering". If necessary, use 
Help Topics Find tab option. 

OBSERVER: 
"Do you know how to do that?" 



209 
SUBJECT 11: 
"No. So, am going to the help topic." 

OBSERVER: 
"Okay. Please select two words from the cue word list." 

SUBJECT 11: 
"Move and objects." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"I see: Adding and deleting toolbar, adding text aligning objects, aligning objects on 
grid, attached text, change tabs proportionally and changing the layout of a slide. Here, I 
found moving objects or set of objects." 

OBSERVER: 
"What are you looking at now?" 

SUBJECT 11: 
"Click on moving objects. One, select the object, the multiple selection, or the group you 
want to move. How? Two, drag the object to its new location. Note: A placeholder, 
like any other object, can also be moved in this way." 

OBSERVER: 
"Okay." 

SUBJECT 11: 
"One, select the object, the multiple selection, or the group you want to move. How? 
Two, drag the object to its new location. Note: A placeholder, like any other object, can 
also be moved in this way." 

OBSERVER: 
"Where are you going to move the picture? 

SUBJECT 11: 
"Below the "EE" in engineering. Am clicking on the light bulb and moving it below the 
double "EE." It is now below the double "EE." 

OBSERVER: 
"Okay. Your time is up. Please save your presentation using your last name. I am going 
to ask you six questions. I will read the questions to you and I want you to answer them 
out aloud. Number one, did you read the same help topic more than once?" 
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SUBJECT 11: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization ofthe infonnation in the help topics?" 

SUBJECT 11: 
"Yes." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT II: 
"Yes." 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT II: 
"Yes." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 11: 
''No.'' 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT II: 
"Yes. " 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 12 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the infonnation you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 
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Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
I) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as your sample word. These are your 

comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 
5) Look read the topics and select to read the one that has two or more ofthe word from 

the words ;you selected. 
6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 12: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the fust slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. " Use Font Time New Roman. Type size forty. 
Add the too Ibar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
"What is it you have to do?" 

SUBJECT 12: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you know to do that?" 

SUBJECT 12: 
"Not particUlarly. Ifnecessary, use Help Topics Find tab option." 
OBSERVER: 
"Looking at your cue word list, what are the two words you are going to choose?" 

SUBJECT 12: 
"Toolbar and buttons. Ifnecessary, use Help Topics Find tab option." 

OBSERVER: 
"Which word would you type?" 
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SUBJECT 12: 
"Toolbar." 

OBSERVER: 
"What are the topic options?" 

SUBJECT 12: 
Add freeform, add a line, add a rectangle, add a AutoShape, add an ellipse, add are delete 
a toolbar button. So, I want to go where it say add a toolbar button. Add or delete a 
toolbar button. One, display the toolbar you want to change, and then click Customize on 
the Tools menu. Two, to add a button, click the name of the category in the Categories 
box, and then drag the button from the Buttons area to a toolbar. To delete a button, drag 
it off the toolbar. Tip. When you delete a built-in toolbar button from a toolbar, the 
button is still available in the Customize dialog box. However, when you delete a custom 
toolbar button, it is permanently deleted. To delete a custom toolbar button from a toolbar 
but save it for later use, create a toolbar for storing unused buttons, move the button to 
this storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 12: , 
"We are trying to add a toolbar button that searches the active presentation for specified 
text." 

OBSERVER: 
"Do you want to try it?" 

SUBJECT 12: 
''I'll go ahead and try it. Display toolbar." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 12: 
"Am thinking that am a little confused." 

OBSERVER: 
"What are you reading?" 

SUBJECT 12: 
"Display the toolbar you want to change then click Customize on the tool menu." 

OBSERVER: 
"What are you looking for?" 
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SUBJECT 12: 
"Toolbar. Wait, Tools. Now, am going down to customize and am letting go. Then, to 
add a button, click the name of the category in the categories box." 

OBSERVER: 
"Can you see behind this window?" 

SUBJECT 12: 
"No." 

OBSERVER: 
"Do you want to close this window?" 

SUBJECT 12: 
"Yes. " 

OBSERVER: 
"Okay, do you see Customize toolbar." 

SUBJECT 12: 
"Yes." 

OBSERVER: 
"What are you trying to do?" 

SUBJECT 12: 
" Am trying to add a toolbar button that searches the active presentation for specified 
text." 

OBSEVER: 
"What are these?" 

SUBJECT 12: 
"These are buttons." 

OBSERVER: 
"What are we looking for?" 

SUBJECT 12: 
"The one that searches the active presentation for specified text." 

OBSERVER: 
"Okay, do you know what this description say?" 

SUBJECT 12: 
"It's a paper." 
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OBSERVER: 
"Would you like to read the description?" 

SUBJECT 12: 
"Okay. Create a new presentation based on a blank presentation template." 

OBSERVER: 
"Is that the one you want?" 

SUBJECT 12: 
No. So, I want to go to the next one. It says open an existing presentation which I don' t 
want to do. Next one, save the active presentation. That is not what I want. Am going to 
the next one which says print the active presentation using current settings. I don ' t want 
that so am going down to this one which sends the active presentation through electronic 
mail. The last one which says add or changes the electronic mail routing slip for the 
active presentation. Am going to the categories box and pressing Edit. I want to go 
through them and see what they say. The first one says copy the selection to the 
clipboard and remove the selection. Am going to the next one, insert the clipboard 
contents. Am going to the next one. It says copy the formatting selection to another 
project object. Am going to this one, Reverse the last change. Am going to the last one 
after that reverses the last undo. Next one, repeats last change. Next one, create a copy 
of the selections and the last one searches the active for specified test. This is the one I 
want. I want to add this toolbar button. So. 

OBSERVER: 
"Tell me what you are thinking?" 

SUBJECT 12: 
"Am thinking how do I add this button?" 

OBSERVER: 
"Okay, what are you going to do?" 

SUBJECT 12: 
"Ask for help." 

OBSERVER: 
"Okay." 

SUBJECT 12: 
"So, I go to the help button. It is not allowing me to." 

OBSERVER: 
"You are not finished with this window?" 
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"Okay. It says select a category and clip the button to see it description. Drag the 
button to any toolbar." 

OBSERVER: 
"Did you find the button?" 

SUBJECT 12: 
'Yes," 

OBSERVER: 
"What are you going to do with it?" 

SUBJECT 12: 
"Drag it to any toolbar." 

OBSERVER: 
"Okay." 

SUBJECT 12: 
"I guess am putting it on the top one." 

OBSERVER: 
"Did it work." 

SUBJECT 12: 
"Yes." 

OBSERVER: 
"What are you going to do?" 

SUBJECT 12: 
"Choose the close button." 

OBSERVER: 
"Okay. What is the next instruction on the layout sheet?" 

SUBJECT 12: 
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"Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. 1fnecessary, use Help Topics Find tab option. So, to change background 
color, am going to press help. Am going to the cue word list and choose two words. Am 
selecting change and background." 
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OBSERVER: 
"Which one are you typing?" 

SUBJECT 12: 
Change. Am going to select change a slide background color. 
When you change a slide's background color, you can use one of the eight coordinated 
color-scheme colors or you can use a color that isn't part of the current color scheme. If 
you use a color-scheme color and then later change your presentation's color scheme, the 
background color changes to coordinate with the new color scheme. If you choose a color 
that's not part of the current color scheme, the color stays the same even if you change the 
color scheme. If you've already changed a slide's background color, you can also return it 
to the color scheme's default background color. When you change the background, you 
can apply it to the current slide by clicking Apply, or to all the slides and the slide master 
by clicking Apply To All. What do you want to do? Change the slide background to a 
color scheme color. Change the slide background to a color other than a color scheme 
color. Change to the default slide background. Am going to select change a the slide 
background to a color-scheme color. One, in slide view, on the Format menu, click 
Custom Background. Two, under Background Fill, click the down arrow, and then click 
the color you want. Now I have to find custom background. 

OBSERVER: 
"Where would you find that?" 

SUBJECT 12: 
"Under the format menu." 

OBSERVER: 
"Okay." 

SUBJECT 12: 
"Am going to click custom background then am clicking the down-arrow. Am then 
going to pick a color." 

OBSERVER: 
"Can you see the presentation screen." 

SUBJECT 12: 
"No." 

OBSERVER: 
"Do you want to close the help window?" 

SUBJECT 12: 
"Yes. Now, I can see, but the color did not change." 
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OBSERVER: 
"You have four options on this window. What are the options?" 

SUBJECT 12: 
"Apply to all, apply, cancel, and preview. Am choosing apply." 

OBSERVER: 
"What is the next instruction on the layout sheet?" 

SUBJECT 12: 
Slide three. Am selecting a new slide. Slide three, from AutoLayout slide, choose "Text 
& Clip Art" type title, mathematics. Use font Algerian. Type size eighty. Type subtitle, 
three (3) courses. Use font Times New Roman. Type size thirty. Insert Clipart, under 
"Categories", choose "Signs". Select the description "Balance Truthful Scales". Crop or 
trim the top portion of the picture on this slide. Ifnecessary, use Help Topics Find tab 
option. Am going to press help and am going to look at the cue word list for search 
words. 

OBSERVER: 
"What two words are you selecting?" 

SUBJECT 12: 
"Crop and trim." 

OBSERVER: 
"Which one are you typing?" 

SUBJECT: 
"Crop. Am going down to where it says crop or trim off portion of a picture. To trim or 
restore portions of a picture, click Crop Picture, position the cropping tool over a resize 
handle, and then drag to crop the picture. Am closing this help topic and go under tools. 
Am pressing crop picture. There goes the cropping tool. Am going to put the tool over 
the resize box." 

OBSERVER: 
"Did it work?" 

SUBJECT 12: 
''No.'' 

OBSERVER: 
"Does it look like this one on the display board after you've cropped the picture?" 

SUBJECT 12: 
"Yes." 
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OBSERVER: 
"Okay. Follow the next instruction on the layout sheet." 

SUBJECT 12: 
Am selecting a new slide. Slide four, from AutoLayout slide, choose "Text & Clip Art". 
Type title, electrical engineering. Use font, Algerian. Type size sixty. Type subtitle, 
Four (4) courses. Use font, Times New Roman. Type size thirty two. Okay. Insert 
Clipart, under "Categories", choose "Energy." Select the description "Idea Brainstorm 
Light Bulb." Move the picture on this slide below the double "EE" in "Engineering". If 
necessary, use Help Topics Find tab option. Am going to press help and ago to my cue 
word list. Am looking for cue words. Am selecting move and drag. 

OBSERVER: 
"Which one are you typing?" 

SUBJECT 12: 
"Move," 

OBSERVER: 
"Could you read the topic options?" 

SUBJECT 12: 
Add or delete toolbar button, add text, align object, align objects on a grid, attach text, 
change tab proportionally, change layout on a slide, change order of paragraph in an 
outline, convert an embedded object into a PowerPoint object, create a routing slip, drag 
and drop information between applications, edit the routing slip of a router presentation, 
erase annotations during a slide show for arrow pointer, grid, guides, hide the slide show 
pen or pointer, have layout help me design the slides, I can't move a text object, insert a 
movie on the slide, move the toolbar, move an object in a horizontal or vertical line, 
move an object or set of objects, move or copy a slide from one presentation to another, 
move or copy a text by dragging, moving from slide to slide during a slide show, 
organizing my outline and context view, position text within an object, PowerPoint can 
not update a link. 

OBSERVER: 
"Okay, have you found a topic?" 

SUBJECT 12: 
"Yes, I did." 

OBSERVER: 
"Do you want to select it?' 
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SUBJECT 12: 
"It is move or copy a toolbar button. No, no, it is move or copy text by dragging. So, I 
am selecting it. One, select the text you want to move or copy. Two, to move the text, 
drag it to its new location. To copy the text, hold down CTRL and drag the copy to its 
new location." 

OBSERVER: 
"What are you trying to do?" 

SUBJECT 12: 
"Move the light bulb under the double "EE" in engineering." 

OBSERVER: 
"Using this help topic instruction, can you move the picture?" 

SUBJECT 12: 
"Yes," 

OBSERVER: 
"Do you want to give it a try?" 

SUBJECT 12: 
"Am selecting the picture. Am going to close the help topic. Am pressing the picture 
and moving it." 

OBSERVER: 
"Did it move?" 

SUBJECT 12: 
"No." 

OBSERVER: 
"Do you want to try again?" 

SUBJECT 12: 
"Yes." 

OBSERVER: 
"Where are you clicking?" 

SUBJECT 12: 
"On top of the picture." 

OBSERVER: 
"Did it work." 



SUBJECT 12: 
"Yes," 

OBSERVER: 
What is the next instruction on the layout sheet?" 

SUBJECT 12: 
"Am selecting a new slide. Slide five From AutoLayout slide, choose "Bulleted List." 
Type Title, STATISTICS. 

OBSERVER: 
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"Okay. Your time is up. Please save your presentation using your last name. I am going 
to ask you six questions. I will read the questions to you and I want you to answer them 
out aloud. Number one, did you read the same help topic more than once?" 

SUBJEVT 12: 
"Yes. " 

OBSERVER: 
"Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 12: 
"Kind of." 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 12: 
"Yes. 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 12: 
"All the time." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 12: 
"No." 

OBSERVER: 
''Number six, did you ask yourself questions to help you understand the instructions?" 
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SUBJECT 12: 
"Yes." 

OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 13 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
I) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as yhour sample word. These are 

your comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 
S) Look read the topics and select to read the one that has two or more of the word from 

the words ;you selected. 
6) Begin reading the selection line by line. 
7) Perform the instructions. 

SUBJECT 13: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin . Type size forty four. 
Type subtitle "General Requirements. Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
Ifnecessary, use Help Topics Find tab option. 

OBSERVER: 
"What are you thinking?" 
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SUBJECT 13: 
"What word should I pick from the cue word list." 

OBSERVER: 
"Did you find two words?" 

SUBJECT 13: 
"Toolbar and buttons." 

OBSERVER: 
"What is it you are typing to do?" 

SUBJECT 13: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Do you know how to do that?" 

SUBJECT 13: 
''No. So, am going to help." 

OBSERVER: 
"What word are you typing?" 

SUBJECT 13: 
"Toolbar." 

OBSERVER: 
"Okay, what are the topic options?" 

SUBJECT 13: 
"Add a freeform, add a line, add a rectangle add an arc, add an AutoShape, add an ellipse, 
add or delete a toolbar button, create custom toolbar. 

OBSERVER: 
"What are you selecting?" 

SUBJECT 13: 
Create a custom toolbar. One, on the View menu, click Toolbars. Two, click New. 
Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the Make 
Toolbar Available To box, click the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new toolbar. Seven, under Buttons, drag the button or 
other item to the new toolbar. I need to read this again. 
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OBSERVER: 
"Okay." 

SUBJECT l3: 
One, on the View menu, click Toolbars. Two, click New. Three, in the Toolbar Name 
box, type a name for the new toolbar. Four, in the Make Toolbar Available To box, click 
the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new toolbar. Seven, under Buttons, drag the button or 
other item to the new toolbar. I need to read this again. 

OBSERVER: 
"What are you thinking?" 

SUBJECT l3: 
"Am thinking it is a lot of steps." 

OBSERVER: 
"What are you going to do?" 

SUBJECT l3: 
"Find the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Okay." 

SUBJECT l3 : 
"Am going under Tools and select. I don't know what am suppose to select." 

OBSERVER: 
"What are you going to do?" 

SUBJECT l3: 
"Go back to the help topics." 

OBSERVER: 
"Okay." 

OBSERVER: 
"What word are you typing?" 

SUBJECT l3: 
"Toolbar." 

OBSERVER: 
"What are you selecting?" 
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SUBJECT 13: 
Create a custom toolbar. One, on the View menu, click Toolbars. Two, click New. 
Three, in the Toolbar Name box, type a name for the new toolbar. Four, in the Make 
Toolbar Available To box, click the template where you want to store the toolbar. Five, 
click OK. Six, in the Categories box, click the category that contains the command or 
other item you want to add to the new toolbar. Seven, under Buttons, drag the button or 
other item to the new toolbar. 

OBSERVER: 
"What are you going to do?" 

SUBJECT 13: 
"Find the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"Okay." 

SUBJECT 13: 
"Am selecting Tools from the toolbar and am choosing customize." 

OBSERVER: 
"What are you reading?" 

SUBJECT 13: 
"The descriptions." 

OBSERVER: 
"Read out aloud." 

SUBJECT 13: 
Category, "File." Creates a new presentation base on the blank presentation template. 
Open an existing presentation. Saves the active presentation using current settings. 
Sends the active presentation through electronic mail. Adds or changes the electronic 
mail routing slip of the active presentation. Next category," Edit". Copies the selection 
to the clipboard and removes the selection. Copies the selection to the clipboard. Inserts 
the clipboard contents. Copies the formatting of the selection to another object. Reverse 
the last change. Reverse the last undo. Repeats the last change. Creates a copy of the 
selection. Searches the active presentation for specified text. This is it. 

OBSERVER: 
"You are going to following the instructions in the help topic." 

SUBJECT 13: 
"Okay, drag it on a toolbar." 
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OBSERVER: 
"Okay." 

SUBJECT 13: 
" Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer 
science. Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, 
Times New Roman. Type size thirty two. Change background color to any color for this 
slide only. Ifnecessary, use Help Topics Find tab option." Am going to help and choose 
accent color." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 13: 
"Change background color to any color on this slide only." 

OBSERVER: 
"What word have you selected from the cue word list?" 

SUBJECT 13: 
"Background and color." 

OBSERVER: 
"What word are you typing? 

SUBJECT 13: 
"Background." 

OBSERVER: 
"Okay." 

SUBJECT 13: 
"Add or change a fill, add or change a patterned slide background, add or change a 
shaded slide background, add or change a slide background picture, add or change a 
textured slide background, background color. Am going to choose." 

OBSERVER: 
"What are you trying to do? " 

SUBJECT 13: 
"Change background color. Am going to choose accent. Colors that are applied to 
secondary features on a slide. Accent colors are available on all of the color menus along 
with the main colors from your scheme. These colors are also used in charts." 

OBSERVER: 
"What are you going to do?" 
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SUBJECT 13: 
"Change background color." 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 13: 
No. I need to use another search word like this one "background color." Change a slide 
background color. When you change a slide's background color, you can use one ofthe 
eight coordinated color-scheme colors or you can use a color that isn't part of the current 
color scheme. If you use a color-scheme color and then later change your presentation's 
color scheme, the background color changes to coordinate with the new color scheme. If 
you choose a color that's not part of the current color scheme, the color stays the same 
even if you change the color scheme. If you've already changed a slide's background 
color, you can also return it to the color scheme's default background color. When you 
change the background, you can apply it to the current slide by clicking Apply, or to all 
the slides and the slide master by clicking Apply To All. What do you want to do? 
Change the slide background to a color scheme color. Change the slide background to a 
color other than a color scheme color. Change to the default slide background. Am going 
to choose change the slide background color to a color-scheme color. One, in slide view, 
on the Format menu, click Custom Background. Two, under Background Fill, click the 
down arrow, and then click other color. Then click the color you want. Okay, I am going 
to try this. Format menu. Custom background. Fill, Down-arrow and click the color I 
want. Am selecting apply. 

OBSERVER: 
"Do you know what to do?" 

SUBJECT 13: 
"Yes. One, in slide view, on the Format menu, click Custom Background. Two, under 
Background Fill, click the down arrow, and then click other color. Then click the color 
you want. Okay, I am going to try this. Format menu. Custom background. Fill, Down­
arrow and click the color I want. Am going to choose apply. Okay. Am clicking on 
Format. Customize. Down-arrow. Choose a color. Okay." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 13: 
"I don't now." 

OBSERVER: 
"Do you want to read the next instruction on the layout sheet?" 



227 
SUBJECT 13: 
''No.'' 
OBSERVER: 
"Do you want to stop?" 

SUBJECT 13: 
"Yes, I don't want to read anymore." 

OBSERVER: 
"Okay, please save your presentation. I am going to ask you six questions. I will read 
the questions to you and I want you to answer them out aloud. Number one, did you read 
the same help topic more than once?" 

SUBJECT 13: 
"Yes." 

OBSERVER: 
''Number two, did you understand the organization of the information in the help topics?" 

SUBJECT 13: 
"No," 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 13: 
"Yes." 

OBSERVER: 
''Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 13: 
"No," 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 13: 
"No." 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 13: 
"No." 
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OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 

Subject 14 
OBSERVER: 
Testing begins at new presentation screen. I am going to give you this investigator-made 
layout sheet. It has all the information you need to prepare slides for a university 
curriculum. On the display board are the slides. You may refer to the display board as 
needed. Also, use the help Find template whenever you don 't know what to do. Please 
read everything out aloud and think out aloud. 

Also, I am going to give you this cue word list. Each slide has its own list of words. I 
want you to type in search words for help topics on tasks you are completing. You are 
going to do the following: 
1) Select a word from the investigator-made word list that relates to what it is you are 

trying to do at this point. This is your sample word. 
2) Choose two words that are in the same category as your sample word. These are your 

comparison words. 
3) Select one word. 
4) Use it in the Find tab option under "Microsoft PowerPoint Help Topics" to find "How 

to do" topics. 
5) Look read the topics and select to read the one that has two or more of the word from 

the words ;you selected. 
6) Begin reading the selection line by line. 
7) Perform the instructions. 

You have fifty minutes. 

SUBJECT 14: 
To begin create a new presentation. Please choose "Blank Presentation 
Slide one, from AutoLayout slide, choose the first slide "Title Slide" 
Type title university curriculum. Use font Wide Latin. Type size forty four. 
Type subtitle "General Requirements. " Use Font Time New Roman. Type size forty. 
Add the toolbar button that searches the active presentation for specified text. 
If necessary, use Help Topics Find tab option. 

OBSERVER: 
"What are you going to do?" 

SUBJECT 14: 
"Add the toolbar button that searches the active presentation for specified text." 



OBSERVER: 
"Do you know what to doT' 

SUBJECT 14: 
"No." 

OBSERVER: 
"What are you going to doT' 

SUBJECT 14: 
"Go to help." 

OBSERVER: 
"What two words are you going to select from the cue word list?" 

SUBJECT 14: 
"Toolbar and button." 

OBSERVER: 
"Which one are you typing?" 

SUBJECT 14: 
"Am typing in toolbar." 

OBSERVER: 
"What are the topic options?" 

SUBJECT 14: 
"Add a free form, add a line, add a rectangle, add an are, add an ellipse, and 
add or delete a toolbar button." 

OBSERVER: 
"What is it you want to doT' 

SUBJECT 14: 
"Add the toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What option are you selecting?" 

SUBJECT 14: 
"Add or delete a toolbar button." 

OBSERVER: 
"Okay." 
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SUBJECT 14: 
One, display the toolbar you want to change, and then click Customize on the Tools 
menu. Two, to add a button, click the name of the category in the Categories box, and 
then drag the button from the Buttons area to a toolbar. To delete a button, drag it off the 
toolbar. Tip, when you delete a built-in toolbar button from a toolbar, the button is still 
available in the Customize dialog box. However, when you delete a custom toolbar 
button, it is permanently deleted. To delete a custom toolbar button from a toolbar but 
save it for later use, create a toolbar for storing unused buttons, move the button to this 
storage toolbar, and then hide the storage toolbar. 

OBSERVER: 
"What are you thinking?" 

SUBJECT 14: 
"Am going to toolbar and select tools. Then, am going to select customize." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 14: 
"Add a toolbar button that searches the active presentation for specified text." 

OBSERVER: 
"What are you looking at right now?" 

SUBJECT 14: 
"Am looking at categories and buttons." 

OBSERVER: 
"Did you click on the buttons?" 

SUBJECT 14: 
"Yes. " 

OBSERVER: 
"Okay." 

SUBJECT 14: 
"It says create a new presentation based on a blank presentation template." 

OBSERVER: 
"Is that what you want to do?" 

SUBJECT 14: 
''No.'' 
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OBSERVER: 
"Okay." 

SUBJECT 14: 
"These buttons say open, save, print, send mail, routing slip. Am going to the Edit 
category. These buttons say cut, copy, paste, format painter, undo, redo, repeat, duplicate 
and find." 

OBSERVER: 
"Do you see the descriptions for these buttons?" 

SUBJECT 14: 
"No," 

OBSERVER: 
"What are you going to do?" 

SUBJECT 14: 
"Am going to click on the buttons to see." 

OBSERVER: 
"Okay." 

SUBJECT 14: 
"It says repeat the last change. I click on the binocular button and it says it searches the 
active presentation for a specified text. That is the toolbar button I want to add." 

OBSERVER: 
"What are you going to do now?" 

SUBJECT 14: 
Am going to add it to the toolbar on top." 

OBSERVER: 
"Have you added it?" 

SUBJECT 14: 
"Yes." 

OBSERVER: 
"What are you doing now?" 

SUBJECT 14: 
Slide two, from AutoLayout slide, choose "Bulleted List." Type title, computer science. 
Use font, Algerian. Type size fifty four. Type subtitle, Five courses. Use font, Times 
New Roman. Type size thirty two. Change background color to any color for this slide 



only. If necessary, use Help Topics Find tab option. Am going to be using help topics 
for this. Am selecting change and background from the cue word list. Am typing in 
change background. 
OBSERVER: 
"What are the topics?" 

SUBJECT 14: 
"Add or change a fill. Background color. Change a slide background color." Am 
selecting this one." 

OBSERVER: 
"What is it you want to do?" 

SUBJECT 14: 
"Change the background color to any color for this slide only." 

OBSERVER: 
"Okay." 

SUBJECT 14: 
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When you change a slide's background color, you can use one ofthe eight coordinated 
color-scheme colors or you can use a color that isn't part of the current color scheme. If 
you use a color-scheme color and then later change your presentation's color scheme, the 
background color changes to coordinate with the new color scheme. If you choose a color 
that's not part of the current color scheme, the color stays the same even if you change the 
color scheme. If you've already changed a slide's background color, you can also return it 
to the color scheme's default background color. When you change the background, you 
can apply it to the current slide by clicking "Apply", or to all the slides and the slide 
master by clicking "Apply To All." What do you want to do? Change the slide 
background to a color scheme color. Change the slide background to a color other than a 
color scheme color Change to the default slide background. Am going to select Change 
the slide background to a color scheme color. Change the slide background to a color 
scheme color. One, in slide view, on the Format menu, click Custom Background. Two, 
under Background Fill, click the down arrow, and then click the color you want. Okay, 
close this out. Lets see, format, custom background and down-arrow. Now am going to 
select any color and click apply. 

OBSERVER: 
"Okay." 

SUBJECT 14: 
''New slide. Slide three, from AutoLayout slide, choose "Text & Clip Art" type title, 
mathematics. Use font Algerian. Type size eighty. Type subtitle, three (3) courses 
Use font Times New Roman. Type size thirty. Insert Clipart, under "Categories", 
choose "Signs". SeJect the description "BaJance Truthful Scales". Crop or trim the top 
portion of the picture on this slide. If necessary, use Help Topics Find tab option." 
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OBSERVER: 
"Okay, Do you Imow how to do that?" 

SUBJECT : 
"Am going to tools, click on it and go down to crop picture. The crop button comes up. 
Am going to put that on the top left resize button of the picture and move it down to cut 
offthe top portion. Am done." 

OBSERVER: 
"Okay, what is it you are going to do next?" 

SUBJECT 14: 
New slide. Slide four, from AutoLayout slide, choose "Text & Clip Art". Type title, 
electrical engineering. Use font, Algerian. Type size sixty. Type subtitle, Four (4) 
courses. Use font, Times New Roman. Type size thirty two. Okay. Insert Clipart, under 
"Categories", choose "Energy." Select the description "Idea Brainstorm Light Bulb." 
Move the picture on this slide below the double "EE" in "Engineering". If necessary, use 
Help Topics Find tab option. 

OBSERVER: 
"Do you Imow how to do that?" 

SUBJECT 14: 
"No. I'll go for help." 

OBSERVER: 
"What words are you selecting from the cue word list?" 

SUBJECT 14: 
"Am selecting move and align from the cue word list. Am going to type move." 

OBSERVER: 
"Okay, what are the topic options." 

SUBJECT 14: 
"The topic options are: Adding and deleting toolbar, adding text aligning objects, 
aligning objects on grid, attached text, change tabs proportionally and changing the 
layout of a slide. Am going to scroll down further. I found moving objects or set of 
objects." 

OBSERVER: 
"Okay." 
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SUBJECT 14: 
"Am clicking on moving objects or set of objects to see if that will give me some 
information on how to move it. One, select the object, the multiple selection, or the group 
you want to move. How? Two, drag the object to its new location. Note: A 
placeholder, like any other object, can also be moved in this way." 

OBSERVER: 
"Okay." 

SUBJECT 14: 
"One, select the object, the multiple selection, or the group you want to move. How? 
Two, drag the object to its new location. Note: A placeholder, like any other object, can 
also be moved in this way." 

OBSERVER: 
"Where are you going to move the picture? 

SUBJECT 14: 
"Right here. Am clicking on the light bulb and moving it below the double "EE." It 
there now." 

OBSERVER: 
"Okay. What are you going to do now?" 

SUBJECT 14: 
''Now, am going to click on new slide in order to start slide number five. "Slide five, 
from AutoLayout slide, choose "Bulleted List". Type title, statistics. Use font, Algerian. 
Type size eighty eight. Type subtitle, five (5) courses. Use font, Times New Roman. 
Type size thirty two. Change title color to any color for this slide only. Ifnecessary, use 
Help Topics Find tab option." 

OBSERVER: 
"Okay." 

SUBJECT 14: 
"Am going to my cue word list and choose coloring and title." 

OBSERVER: 
"Which word are you typing in fust?" 

SUBJECT 14: 
"Coloring." 

OBSERVER: 
"Okay." 
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SUBJECT 14: 
"The topics are accent colors, add a custom color-scheme as a standard schemes, add an 
embossed effect to a PowerPoint object, add or change a fill, add or change a patterned 
fill, add or change a shaded fill, and add or change a textured fill. What am going to 
down the list, but I don't see a topic that say title only." 

OBSERVER: 
"Is the title a picture or text?" 

SUBJECT 14: 
"It's a text." 

OBSERVER: 
"Okay." 

SUBJECT 14: 
Oh, I see here it says change text color. When you change text color, you can use one of 
the eight coordinated color-scheme colors, or you can use a color that isn't part of the 
color scheme. If you use a color-scheme color and then later change your presentation's 
color scheme, the text color changes to coordinate with the new color scheme. If you 
choose a color that's not part ofthe current color scheme, the text color stays the same 
even if you change color schemes. If you change text color, you can also return text 
color to the color scheme's default text color. What do you want to do? Change text to a 
color scheme color. Change text to a color other than a color scheme color. Change text 
to the default text color. Am selecting change text to a color scheme color. One, in 
slide or notes view, select the text you want to change. Two, on the Format menu, click 
Font. Three, on the Color drop-down list, click your choice in the color palette. Right 
now, am going to close help topics and go to format menu. Okay, fonts, color palettes 
then okay. It didn't change. 

OBSERVER: 
"What are you going to do?" 

SUBJECT 14: 
"Try it again. Now, fonts, color palettes then okay. It didn't change." 

OBSERVER: 
"Did it change?" 

SUBJECT 14: 
''No,'' 

OBSERVER: 
"Did you highlight the text you want to change?" 



SUBJECT 14: 
"No, I'll do that now." 

OBSERVER: 
"Did it work?" 

SUBJECT14: 
"Yes." 

OBSERVER: 
"Okay, what is the next instruction on the layout sheet?" 

SUBJECT 14: 
Can you solve the problem of having the logo appear in the upper left comer on all 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
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Insert clipart, select description, Professor Leadership Informat and filename "Popular" 
as your logo. If necessary, use Help Topics Find tab option. When you are finished, 
please save your presentation using your last name. Am going to help and the cue word 
list. Am selecting logo and adding from the cue word list. Am typing in logo. It's 
easy to add your logo to a presentation using scanned or digital art. Or you can create 
what you need using clip art, WordArt, and the PowerPoint tools. To have a logo appear 
on every slide in your presentation, insert it on the slide master. Before you import a 
digital file or a scanned version of your logo, you may want to adjust the colors and 
contrast in an application that lets you edit bitmaps. You can use clip art images to create 
a logo in your presentation and then use PowerPoint commands to change an image's fill 
and line color, take it apart, even combine it with other clip-art images, drawings, and 
text. If you didn't install the ClipArt Gallery with PowerPoint, just run PowerPoint Setup 
again. You can draw a logo, or add drawn art as a frame for your logo, for example, 
using the PowerPoint tools. To create composite shapes, use the AutoShapes tools and 
the Freeform drawing tool. Or you might try using WordArt to add special text effects to 
your logo or to your company name by slanting, rotating or curving text. 

OBSERVER: 
"What are you going to doT' 

SUBJECT 14: 
"Can you solve the problem of having the logo appear in the upper left comer on all 
slides? Please insert a logo and have it appear in the upper left comer on all slides. 
Insert clipart, select description, Professor Leadership Informat and filename "Popular" 
as your logo. If necessary, use Help Topics Find tab option. When you are finished, 
please save your presentation using your last name." 

OBSERVER: 
"Please read out aloud?" 
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SUBJECT 14: 
Okay, it is easy to add your logo to a presentation using scanned or digital art. Or you can 
create what you need using clip art, WordArt, and the PowerPoint tools. To have a logo 
appear on every slide in your presentation, insert it on the slide master. Before you 
import a digital file or a scanned version of your logo, you may want to adjust the colors 
and contrast in an application that lets you edit bitmaps. You can use clip art images to 
create a logo in your presentation and then use PowerPoint commands to change an 
image's fill and line color, take it apart, even combine it with other clip-art images, 
drawings, and text. If you didn't install the ClipArt Gallery with PowerPoint, just run 
PowerPoint Setup again. You can draw a logo, or add drawn art as a frame for your logo, 
for example, using the PowerPoint tools. To create composite shapes, use the AutoShapes 
tools and the Freeform drawing tool. Or you might try using WordArt to add special text 
effects to your logo or to your company name by slanting, rotating or curving text. 

OBSERVER: 
"What is the slide master?" 

SUBJECT 14: 
"Let me click on it to see. It says the slide that hold the formatted placeholders for the 
titles and main text as well as any background items that you want to appear on all slides 
in a presentation. If you make a change to the slide master, the change affects all slides 
in your presentation that follow the master." 

OBSERVER: 
"What are you thinking?" 

SUBJECT 14: 
"Am thinking how do I add a logo?" 

OBSERVER: 
"What are you doing now?" 

SUBJECT 14: 
"Looking for the slide master. Here it is. Am clicking on the up-arrow, Professor 
Leadership Informat and filename "Popular clip art then insert." 

OBSERVER: 
"What happened?" 

SUBJECT 14: 
"It didn't insert it on the slide master and the picture is covering everything on the slide 
master." 

OBSERVER: 
"What are you going to do?" 
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SUBJECT 14: 
"Make it look smaller. Am clicking on the resize handle and here it goes." 

OBSERVER: 
"Okay, please save your presentation using your last name." 

SUBJECT 14: 
"Okay." 

OBSERVER: 
"I am going to ask you six questions. 1 will read the questions to you and 1 want you to 
answer them out aloud. Number one, did you read the same help topic more than once? 

SUBJECT 14: 
"Yes." 

OBSERVER: 
"Number two, did you understand the organization ofthe information in the help topics?" 

SUBJECT 14: 
"Sometimes. " 

OBSERVER: 
"Number three, did you use prior knowledge of any computer skills to help you?" 

SUBJECT 14: 
"Yes. 

OBSERVER: 
"Number four, did you ask yourself questions about what you were doing?" 

SUBJECT 14: 
"Sometimes." 

OBSERVER: 
"Number five, did you make notes or summarize the text before starting?" 

SUBJECT 14: 
"No," 

OBSERVER: 
"Number six, did you ask yourself questions to help you understand the instructions?" 

SUBJECT 14: 
"Yes." 



239 
OBSERVER: 
"The responses you have made in this research report will remain anonymous and there 
will be no mention of your name." 
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